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Notice 

After purchasing the APP-601 Recorder, APP Engineering, Inc. licenses the APP Recorder Software and 

APP ClearView Software to the purchasing party upon the condition that you accept all of the terms 

contained in the license agreement. 

License and Warranty 

The software which accompanies this license (the “Software”) is the property of APP Engineering, Inc. or 

its licensors and is protected by copyright law. While APP Engineering, Inc. continues to own the 

Software, you will have certain rights to use the Software after your acceptance of this license. Except as 

may be modified by a license addendum which accompanies this license, your rights and obligations with 

respect to the use of this Software are as follows: 

Limited Warranty 

APP Engineering, Inc. warrants that the media on which the Software is distributed will be free from 

defects for a period of sixty (60) days from the date of delivery of the Software to you. Your sole remedy in 

the event of a breach of this warranty will be that APP Engineering, Inc. will, at its option, replace any 

defective media returned to APP Engineering, Inc. within the warranty period. APP Engineering, Inc. does 

not warrant that the Software will meet your requirements or that operation of the Software will be 

uninterrupted or that the Software will be error-free. 

You May: 

Use one copy of the Software on a single computer; if the media which you receive contains more than one 

language version of the Software and/or multiple Software titles, you are only licensed for one language 

version per Software title contained on the media and you may not transfer such other versions to another 

person or allow another person to use such other versions; make one copy of the Software for archival 

purposes, or copy the software onto the hard disk of your computer and retain the original for archival 

purposes; use the Software on a network, provided that you have a licensed copy of the Software for each 

computer that can access the software over that network, or you have purchased a network license; after 

written notice to APP Engineering, Inc. and written approval from APP Engineering, Inc. transfer the 

Software on a permanent basis to another person or entity, provided that you retain no copies of the 

Software and the transferee agrees to the terms of this agreement; and if a single person uses the computer 

on which the Software is installed at least 80% of the time, then that person may also use the Software on a 

single home computer. 

You May Not: 

Copy the documentation which accompanies the Software; sublicense, rent or lease any portion of the 

Software; decompile, disassemble, modify, translate, make any attempt to discover the source code of the 

Software, or create derivative works from the software; or use a previous version or copy of the Software 

after you have received a disk replacement set or an upgraded version as a replacement of the prior version, 

upon upgrading the Software, all copies of the prior version must be destroyed. 
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The above warranty is exclusive and in lieu of all other warranties, whether expressed or implied, including 

the implied warranties of merchantability, fitness for a particular purpose and non-infringement. This 

warranty gives you specific legal rights. You may have other rights, which vary from state to state. 

Disclaimer of Damages 

Regardless of whether any remedy set forth herein fails of its essential purpose, in no event will APP 

Engineering, Inc. be liable to the purchaser for any special, consequential, indirect or similar damages, 

including any lost profits or lost data arising out of the use or inability to use the software even if APP 

Engineering, Inc. has been advised of the possibility of such damages. Some states do not allow the 

limitation of exclusion of liability for incidental or consequential damages so the above limitation or 

exclusion may not apply to you. In no case will APP Engineering, Inc.’s liability exceed the purchase price 

of the software. The disclaimer and limitations set forth above will apply regardless of whether you accept 

the software. 

U.S. Government Restricted Rights 

Restricted Rights Legend, use, duplication, or disclosure by the Government is subject to restrictions as set 

forth in subparagraph © (l) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 

252.227-7013 or subparagraphs © (1) and (2) of the Commercial Computer Software-Restricted Rights 

clause at 48 CFR 52.227-19, as applicable, APP Engineering, Inc. 5234 Elmwood Avenue, Indianapolis, 

Indiana 46203. 

General 

This Agreement will be governed by the laws of the State of Indiana. This Agreement may only be 

modified by a license addendum which accompanies this license or by a written document which has been 

signed by both the purchaser and an officer of APP Engineering, Inc. Should you have any questions 

concerning this Agreement, or if you desire to contact APP Engineering, Inc. for any reason, please write: 

APP Engineering, Inc. 5234 Elmwood Avenue, Indianapolis, Indiana 46203.  
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Safety Notices 

Do not install substitute parts or perform any unauthorized modification to the product. Return the product 

to APP Engineering, Inc. for service and repair to ensure that safety features are maintained.  

*WARNING* 
 

A WARNING notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like, that if not correctly performed or 
adhered to, could result in personal injury or death. Do not proceed 
beyond a WARNING notice until you fully understand and are 
prepared to address the indicated conditions. 

*CAUTION* A CAUTION notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like that, if not correctly performed or 
adhered to, could result in damage to the product or loss of important 
data. Do not proceed beyond a CAUTION notice until you fully 
understand and are prepared to address the indicated conditions. 

*WARNING* 
 
 

(Personnel) 
Only qualified, service-trained personnel who are aware of the 
hazards involved should install, open any doors, remove any covers, 
or disconnect the instrument (APP-601 Recorder). Disconnect power 
before attempting any service or maintenance.  

*WARNING* 
 

(Fuse) 
For continued protection against fire, replace the line fuse only with a 
fuse of the specified type and rating. 

*WARNING* 
 

 

(Live Circuits) 
Replacement of chassis, components, fuses and internal adjustments 
must be performed by qualified personnel. The system main power 
must always be disconnected before servicing. If the system utilizes 
voltage and/or current test switches make sure they are open and 
understand that the back of these switches are still live! If the system 
utilizes sliding link terminal blocks for the digital channels and alarm 
outputs, ensure that the sliding links are open and understand that 
one side of the sliding link terminal block is still live!  

*WARNING*  (Operating Environment) 
This instrument should not be used in an explosive environment. It 
should not used in the presence of flammable gases or liquids. This 
instrument should not be used in a damp or wet environment or an 
environment that is subject to condensation. 

*WARNING*  (Grounding) 
All chassis, cabinets, panels, and rack mount equipment must be 
connected to an electrical earth ground. Grounding must be done to 
prevent shock hazard to people. Instruments provided with a power 
terminal block are provided with an appropriate means for connecting 
an electrical safety earth ground. Only qualified and trained personnel 
should connect power to this instrument. If the instrument includes a 
three prong AC power cord, ensure that your power receptacle is 
properly earth grounded. 
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*WARNING*  (Two Person Rule) 
Do not service or adjust equipment alone. Ensure that another person 
is present that knows emergency procedures and is capable of giving 
first aid. 

 

Additional Document Notes 

Throughout this manual, the APP-601 Recorder™ may be referred to as the “Recorder” or the APP-601 

Multifunction Recorder. 

Throughout this manual an event channel or event input may be referred to as a digital channel or digital 

input. 
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1.1 Overview 

The APP-601 multifunction recording instrument (DME) was designed to meet the monitoring and 

reporting needs in the power transmission, power distribution, and power generating areas. Recording 

functions include DFR, SER, DDR, PMU, PQ, TW, TIR, based on PRC-002, PRC-028 Draft, IEEE 2800 

Measurements. The APP-601 lends itself useful to other industrial applications because of its wide voltage 

input range, current input range, digital input range, GOOSE message, Sampled Values, status output 

capability and various recording speeds. When coupled with APP ClearView™, a master station software 

package and COMTRADE viewer, it provides a powerful platform for data acquisition, analysis, and 

reporting. 

1.2 History 

The APP-601 recorder is derived from its predecessor the APP-501 Recorder. The APP-501 Level 1 & 

Level 2 Data Chassis have been removed from our standard offering but are available if needed.  The APP-

501 Computer Chassis continues to be manufactured and is offered as a computer control chassis choice for 

the APP-601 recorder system.  The APP-601 recorder can be purchased with either of the following chassis 

configurations: 

APP-601 Computer Chassis and APP-601 Data Chassis, and APP 618 Controller 

APP-501 Computer Chassis and APP-601 Data Chassis 

1.3 Features 

Major features of the APP-601 recorder include the following: 

Windows based software (Linux OS is available as an option) 

Distributed or centralized architecture 

Easy and intuitive setup 

Simultaneous recording functions 

Optional Computer Unit Redundant (CUR) 

DC coupling 

Data alignment within 1msec 

Auto diagnostics 

Remote power toggle 

Independent data acquisition channels 

Analog channels configurable as voltage or current 

IEC-61850 GOOSE Message Capture 

IEC-61850 Sampled Values  

Multiple triggers per channel  

Automatic creation of COMTRADE files 

Auto calling, polling, emailing 

Network, DNP-3, FTP communications 

Digital channels configurable as DFR, SER, or both 

Integrated monitor and keyboard (APP-501 Computer Chassis) 

Superior analysis software (APP ClearView) 
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AC or DC input power 

Designed and manufactured by APP Engineering Inc. 

1.4 Functions 

Major recording functions of the APP-601 recorder include the following: 

 Transient Oscillography 

 Extended Oscillography 

 Extended RMS (Root Mean Square) 

 Continuous Oscillography 

 Continuous RMS 

 Continuous Frequency 

 Continuous Phasor 

 Trending RMS & Frequency 

 Sequence of Events (SOE) 

 PMU (Phasor Measurement Unit) 

 Real Time Local Monitoring or remote monitoring via RDP (Remote Desktop Protocol) 
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2.1 Analog Inputs 

2.1.1 Voltage 

Max channels per chassis 30 

Max input voltage 440VAC rms 

True DC Coupling Yes 

Rin 100kΩ Min, Range Dependent 

Burden 0.045VA@67V, 0.144VA@120V 

Accuracy (un-calibrated) Typical 0.15% of Reading, Max 0.5% 

2.1.2 Current 

Internal shunt 2mΩ 

Burden 0.05VA@5A, 0.45VA@15A 

Max Continuous current 15A 

Max amp-seconds (not to exceed) 140A RMS for 2 seconds, 250A RMS for 0.5 

seconds 

Max current (not to exceed) 250A 

Accuracy (un-calibrated) Typical 0.61% of Reading, Max 1.0% 

2.1.3 General 

Ch to Ch phase angle error  ≤ 0.004 degrees 

Cut-off frequency (-3db) 10kHz 

Common mode rejection 80dB Min 

Temperature Error ≤75ppm/ºC 

Channel to channel isolation ≥ 3500VDC 

Channel to ground isolation ≥ 3500VDC 

Channels per card 3 

Channel type Each channel can be set up as voltage or current 

Data alignment With 1PPS rising edge 

Data accuracy 1 µsec with unmodulated IRIG-B input 

Connector type #6 screw terminal double barrier 

Max wire size 12AWG 

 

mailto:0.045VA@67V
mailto:0.05VA@5A
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2.2 Event Inputs 

Max channels per chassis 80 

Channels per card 8 

Channel type DFR, SER or Both 

Standard input voltage range 45-250VDC 

Optional input voltage 24VDC or internally wet 

Contact configuration Programmable normally open/normally closed 

Configuration Isolated or common return 

Channel to channel isolation ≥ 3500VDC 

Channel to ground isolation ≥ 3500VDC 

Connector type Pluggable, 16 poles 

Max wire size 14AWG 

2.3 Traveling Wave Inputs 

Max channels per chassis 10 

Channels per card 1 

Channel type Traveling Wave 

Standard input voltage range 30A at CT, 10 VDC at the BNC 

Connector type 2 x BNC (TW CT, IRIG-B) 

1 Ethernet 
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2.4 APP-618 Controller 

Operating system Linux Ubuntu 

Processor Atom E3845 Quad Core 

RAM  8GB DDR3L-1600 

BIOS American Megatrends Inc. BIOS 

Chipset System-on-Chip integrated, Intel HD Graphics, 

Shared System memory 

Power Input 86-125Vac (50Hz/60Hz) or 86-350Vdc 

Computer auto power AC/DC power 

Power Requirements 25W (using 3 X 2.5” Hard Drives) 

Internal Drives 3 X 1TB SSD Western Digital Red 

RAID RAID 1 + Hot Spare (2 – 1TB SSDs in RAID 1 

configuration with 1TB as hot spare automatic 

substitute failed SSD 

Ports 

 

2x RS232 (Com1 & 2) 

3x Ethernet 10/100/1000 MB 

3x USB2, 1x USB 3 

3x SATA 300 

1 HDMI, 1 VGA 

1x line-out, 1x Mic-in 

Temperature -20°C ~ 70°C  (-4°F ~ 158°F) 

Relative Humidity 10% ~ 95% relative humidity, non-condensing 

 

LED Indicators FRONT: 5 LEDs - 12V + 5V Power, Computer + 

RAID 1 power, RAID Error 

REAR: 6 LEDs - 1 activity + 1 error indicator for 

each hard drive 

2.5 Power Supply 

AC Range 88-264Vac (50/60Hz) 

DC Range 86VDC to 373VDC (48VDC Option) 

Power draw @ 125VDC 90W, 54 analog channels & 96 event channels 

Input to ground isolation ≥ 3500VDC 
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2.6 Status Relays 

Cards per system 1 standard (more optional) 

Outputs per card 8 

Contact ratings 12A Cont., Break is 0.5A @ 125VDC 

12A Cont., Break is 0.35A @ 250VDC 

Dielectric coil to contacts 5kVac 

Contact Configuration Board jumper normally open/normally closed 

Physical Alarm outputs 8  

Alarms, (Mappable to any physical alarm output). 

An alarm can be assigned to multiple physical 

outputs. A physical output can have 1 or more 

alarms assigned to it. It is recommended not to 

map multiple alarms to Power, Online, Continuous 

Record, and Cross Trigger. 

Power 

Online  

Offline 

Clock sync loss 

Disk Full 

Master Communication error 

Chassis Communication error 

Transient Record  

Disturbance Record 

SOE Record 

DSP Board Temperature 

Continuous Record 

PC Health 

Analog Channel Fail 

Cross Trigger 

TW Fail 

Connector type Pluggable, 16 poles 

Max wire size 14AWG 

2.7 Time Synchronization 

Modulated IRIG-B Input Yes 

Unmodulated IRIB-B Input Yes 

Precision Time Protocol (PTP) Yes (DSP 6.4 or after) 

Selection method Board jumper & Software 

Connector type BNC, Ethernet 

Chassis to chassis signal 1PPS – BNC connector, 100ns chassis to chassis 

latency if signal is daisy chained. 1PPS signal can 

be paralleled with a “T” connector. 

For more information, see Time Quality on page 11-2. 
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2.8 Communications 

Recorder to master station Ethernet 10/100Mbit, TCP/IP (Fiber optional) 

Modem 56K 

Chassis to chassis Ethernet 100Mbit, UDP (Fiber optional) 

DNP-3 Ethernet 10/100Mbit, TCP/IP (Fiber optional) 

RS232 (9-Pin Connector) 

PMU Ethernet 10/100Mbit, UDP or RS232 (9-Pin Conn) 

2.9 System Computer 
2.9.1 Choice #1 APP-601 Computer Chassis 

Operating system Windows 10, Linux Ubuntu 

Processor Atom E3845 Quad Core 

RAM  8GB DDR3L-1600 

BIOS American Megatrends Inc. BIOS 

Chipset System-on-Chip integrated, Intel HD Graphics, 

Shared System memory 

Power Input 86-125Vac (50Hz/60Hz) or 86-350Vdc 

Computer auto power AC/DC power 

Power Requirements 25W (using 3 X 2.5” Hard Drives) 

Internal Drives 3 X 1TB SSD Western Digital Red 

RAID RAID 1 + Hot Spare (2 – 1TB SSDs in RAID 1 

configuration with 1TB as hot spare automatic 

substitute failed SSD) 

External HDD, CDRW, DVDRW Option 

Ports 

 

2x RS232 (Com1 & 2) 

3x Ethernet 10/100/1000 MB 

3x USB2, 1x USB 3 

3x SATA 300 

1 HDMI, 1 VGA 

1x line-out, 1x Mic-in 

Display Option, APP-904 Mon./Keyboard Chassis 

Keyboard Option, APP-904 Mon./Keyboard Chassis 

Touchpad Option, APP-904 Mon./Keyboard Chassis 

Temperature -20°C ~ 70°C (-4°F ~ 158°F) 

Relative Humidity 10% ~ 95% relative humidity, non-condensing 

LED Indicators FRONT: 5 LEDs - 12V + 5V Power, Computer + 

RAID 1 power, RAID Error 

REAR: 6 LEDs - 1 activity + 1 error indicator for 

each hard drive 
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2.9.2 Choice #2 APP-501 Computer Chassis 

Operating system Windows 10, Linux Ubuntu 

Processor Intel Duo Core Minimum 

RAM 4GB DDR Minimum 

Internal HDD 500GB IDE Min.  

External HDD (option) 250GB IDE Minimum 

Ports 

 

1-RS232 

1-Ethernet (1 for DSP) 

1-External Ethernet to USB for LAN 

4-USB  

Display Integrated Flip Up 

Keyboard Integrated 

Touchpad Integrated 

Temperature 5 to 55° C 

Modem Yes, External 56K  

Solid State Drive Optional (SLC Recommended) 

2.10 Ethernet Switch  

Data rate 10Base-T/100Base-TX 

Ports 5 (8, 16, 24 port optional, fiber optional) 

Power 10-36Vdc or 8-24Vac 

Input frequency 47-63 Hz 

Port connectors RJ-45 

LED indicators Activity, Link, Data Rate, Power 

2.11 Enclosures 

APP-601 Computer Chassis 19” W x 5.25” H x 9.8” D (Rack Mount) 

APP-501 Computer Chassis 19” W x 5.25” H x 16” D (Rack Mount) 

APP-601 Data Chassis 19” W x 5.25” H x 9.8” D (Rack Mount) 

APP-618 Controller 19” W x 5.25” H x 9.8” D (Rack Mount) 

Ethernet Switch 1” W x 4.75” H x 3” D (Din Rail Mount) 
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Environment 

Operating temperature 5 to 55º C Standard 

 -25 to 70° with 601 Computer Chassis and 

Extended Range HDD or SSD 

Storage temperature -40 to 70º C 

Operating relative humidity 0 to 95% non-condensing 

Storage relative humidity 0 to 95% non-condensing 

Operating altitude  10,000 ft maximum 

2.12 Approvals 

Standard ANSI/IEEE  C37.90.1-2002 

Standard ANSI/IEEE  C37.90.2-2004 

Standard ANSI/IEEE C37.90.3-2001 (Electrostatic Disch) 

Standard IEC 60255-22-1:2005 Cat III (Osc) 

Standard IEC 60255-22-2 Electrostatic Discharge Contact & 

air 6KV (APP 601 Data Chassis) 

Standard IEC 60255-22-3 Radiated Electromagnetic Field 

Disturbance (APP 601 Data Chassis) 

Standard IEC 60255-22-4 cat IV (EFT) 

Standard IEC 60255-22-5 :2000 Cat IV (Isolation) 

Standard IEC 60255-22-6 Surge Immunity 

Option w/Extended Range HDD IEC 60068-2-1 (Cold) 

Option w/Extended Range HDD  IEC 60068-2-2 (Hot) 

Option w/Extended Range HDD IEC 60068-2-30 (Damp Heat) 

Standard IEC 61000-4-2;2008 (Electrostatic Disch, Class A) 

Standard IEC 61000-4-3;2006 (Immunity Radiated RF) 

Standard IEC 61000-4-6;2008 (Immunity Conducted RF) 

Standard ANSI/IEEE C37.111 (COMTRADE) 

Standard   ANSI/IEEE C37.232-2007 (Com Names) 

Standard ANSI/IEEE 1613-2009 (100mm Free Fall) (APP 

601 Computer Chassis) 

Standard  IEC 60255-21-1:1988 (Vibration) 

Standard IEC 60255-21-2:1988 (Shock Response & 

Withstand) (APP 601 Data Chassis) 

Standard IEC 60255-21-3:1993 (Earthquake Test)  

(APP 601 Data Chassis) 

Special Manufacturer Defined Overload Test on Power Supply, Current 

Channels, and Voltage Channels 
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Kepco Overload Test on Power Supply, Current 

Channels, and Voltage Channels 

Standard IEC 60255-26-2013 Voltage Dips, Interruptions, 

and variations Test 

Standard IEC 61000-4-5-2005 Surge Test  

Standard IEC 61000-4-5-2009 Power Frequency Magnetic 

Field Immunity Test 

Standard IEC 61000-4-10-2016 Damped Oscillatory 

Magnetic Field Immunity Test 

Standard  IEC 61000-4-17-1999/2001/2008 Ripple on DC 

Input Power Port Test 
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3. Installation Overview 
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3.1 Installation Types 

Three types of installations are possible: 

Centralized  

Distributed  

Turn-key  

Centralized Installation 

A centralized installation is used when the recorder chassis are installed in the same panel/cabinet or near 

each other. Proximity would be within 40’ (even longer with special discussions with the factory). A 

centralized installation will generally consist of a computer control chassis and one or more data chassis. In 

this type of installation, there is typically only one satellite clock IRIG-B input. 1PPS signals are daisy 

chained from chassis to chassis. 

Distributed Installation 

A distributed installation is used when the recorder chassis is installed in panels/cabinets that are greater 

than 40’ apart or even in separate buildings. A distributed installation will generally consist of a computer 

control chassis and several data chassis. All chassis must connect back to the system Ethernet switch. The 

chassis should not be greater than 100 meters from the Ethernet switch if straight Ethernet is used. Longer 

distance can be achieved with Ethernet boosters or by using fiber optic interfaces or using the company 

network. One or more IRIG-B or PTP signals can be used. 

Turn-Key Installation 

The most common installation type is a turn-key installation. APP Engineering, Inc. mounts and wires the 

chassis, and other associated components, in a customer specified panel/cabinet. All work is completed at 

the APP factory and a complete turn-key cabinet is delivered to the customer.   

*WARNING*  Only qualified, service-trained personnel who are aware of the 
hazards involved should install, open any doors, remove any covers, 
or disconnect the instrument (APP-601 Recorder). Disconnect power 
before attempting any installation, service or maintenance.  

See Safety Notices on page v for more very important, must read, 
safety information.  

Please call APP Engineering, Inc. at 317-536-5300 with any installation 
or service questions. Installation service is available by APP 
Engineering, Inc. Please call the number above for additional 
information. 
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3.2 Completing a Centralized Installation 

When a chassis only (loose gear) system is purchased, the minimum number of chassis in the system will 

be two (Computer Control Chassis & Data Chassis). Chassis front views are provided for reference. 

 

Figure 1: APP-601 Computer Control Chassis Front View (Fanless) 

 

Figure 2: APP-501 Computer Control Chassis Front View 

 

 

Figure 3: APP-601 Data Chassis Front View 

 

 

Figure 4 APP-618 Controller Front View 

Chassis can be located in the same panel or distributed in 2 or more panels. The installation steps discussed 

below do not include software setup steps. Most of the time, the factory will have obtained a point 

assignment list, satellite clock information, event input information, and other information that allowed 

them to configure the software and set up the hardware jumpers. Software settings and windows are 

discussed in later sections of this manual. 
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➢ To Complete a Centralized Installation  

1. Inspect the shipping cartons to see if any obvious shipping damage has occurred. If the items have 

been damaged, contact the carrier immediately and file a damage claim. Take pictures of the 

damaged cartons.  

2. Unpack the instruments and keep the cartons. If you file a claim with the freight company, their 

inspector may want to see the boxes. Inspect the instruments and associated peripherals. If 

damaged, take pictures and file a claim with the freight company if you feel they are at fault. 

Contact APP Engineering, Inc. if any kind of damage has occurred. 

3. Carefully review the print set that was provided with the recorder. 

4. Remove any power from the panels that you will be installing equipment into or working in.  

5. Install the rack mount Computer Control chassis and Data chassis into your desired panel. Each 

chassis should be installed with (4) fasteners. Since panels utilize various size screws for rack 

mount instruments, fasteners have not been provided (unless special arrangements have been 

made).  

6. Install the din rail mount Ethernet switch. It is preferred that the Ethernet switch be mounted in the 

same panel as the Computer Control chassis and Data chassis. A small piece of din rail has been 

provided. At the request of the customer, APP Engineering can mount the Ethernet switch to the 

back of a 3U rack mount panel. 

7. In a centralized installation, data chassis are usually installed in the same panel as the computer 

chassis. However, some data chassis can be mounted in other panels. A shielded straight Ethernet 

cable and 1PPS co-axial cable will need to be pulled from the Ethernet switch and last data chassis 

in the centralized panel, respectively, to the data chassis.  

8. If you are using an APP-618 Controller for Sampled Values, connect the DSP Port to the DSP 

LAN switch. Connect the ENET LAN port of the APP-618 to the process bus network. If the 

APP-601 Data Chassis is using an IRIG-B clock, the 618 will need to get PTP clock source from 

the process bus. 

9. Ensure that all circuit board cards are seated properly, and the holding screws are tight. Open the 

front panel doors on each chassis and ensure that internal power supplies, connectors, and 

computer are in proper position and secured in place. Ensure that no foreign objects are lying in 

the chassis. 

10. Ground all chassis to your panel grounding bars. The distance from any chassis to a panel 

grounding bar(s) should not exceed 16 ft. Grounding braid has been provided. Ensure that your 

panel ground bars are properly earth grounded.  

*WARNING*  Proper grounding procedures must be followed to prevent serious 
injury or death to people who may come in contact with this recording 
equipment. 

11. Review the Point Assignment Record that your company provided to APP Engineering, Inc. APP 

strives to get these records prior to shipment so the instrument internal settings are complete. Prior 

to connecting signals to the analog channels, the user must know if a particular channel has been 

designated as a voltage channel or current channel. Each analog channel has two jumpers that 

configure it for a voltage or current input. If the Point Assignment Record was received prior to 

shipment, the factory has already made the correct jumper settings. 

12. Wire the recorder analog channels. The analog channels will accept a maximum wire size of 

12AWG. The terminal block screws are #6. The maximum input to a voltage channel is 440VAC. 

The maximum continuous current through a current channel is 15Amps. 
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13. Wire the recorder event (digital) channels. The event channels utilize a pluggable 16 position 

connector. The maximum wire size for this connector is 14AWG. The standard input voltage 

range is 45-250Vdc. Event Boards setup for 24Vdc are available as an option. Reference the print 

set for any notes designating event channels that require 24Vdc or event boards that are Internally 

Wetted as opposed to our typical board that needs external wetting. If the events have a common 

return and the customer provided this information to the factory, they will have jumpers between 

the (-) event terminals.  

*CAUTION*  APP Engineering manufactures an event circuit board that is 
internally wetted and is set up for dry contact connection only. Do not 
connect an external voltage to this internally wetted event circuit 
board!  

The board will have labeling indicating that it is for Dry Input. Again, 
reference the print set for electrical drawings and important notes. 

14. Wire the recorder alarm outputs. The alarm outputs utilize a pluggable 16 position connector. The 

maximum wire size for this connector is 14AWG. The alarm output contact is dry. The contacts 

can break 0.5Amps @ 125VDC or 0.35A @ 250VDC. 

15. Connect your IRIG-B signal to the back of the DSP/IRIG circuit board. The IRIG-B connector is 

labeled and is a standard BNC type connector. This board can accept a modulated or un-modulated 

IRIG-B signal. However, a board jumper must be set to reflect the input type and software setting 

in the Point Assignment Record must be made. Unless a satellite controlled clock was purchased 

with the system, an IRIG-B coax cable is not provided. 

16. Connect the 1PPS signal from chassis to chassis. Connect the 1PPS out signal from the 1st Data 

chassis to the 1PPS input of the 2nd Data chassis. Keep daisy chaining until the remaining data 

chassis are connected. The 1PPS connector is a standard BNC connector. 1PPS interconnecting 

cables have been provided with the system. The 1PPS signal can also be paralleled by using a 

BNC “T” to reduce 1PPS latency. 

17. Ethernet cables have been provided with the system. Each chassis has one Ethernet RJ45 

connector. On the Data chassis this connector is located on the DSP/IRIG circuit board. On the 

Computer Control chassis it is simply located on the back panel and labeled DSP Enet. A cable 

should be connected to each chassis and routed back to the system Ethernet switch. If a system 

only consists of a Computer Control chassis and a single Data chassis, a switch is not required and 

may not have been provided. Simply make a peer-to-peer connection between the two chassis. 

18. Connect power cables to the Ethernet switch. A power cable has been provided. It should be 

connected from the Data Chassis power supply circuit board (terminals 3&4) to the input terminal 

block of the Ethernet switch. The voltage is 12Vdc.  

*CAUTION*  It is possible that a specially requested Ethernet switch was used and 
it may connect directly to 125VDC.  

Reference the print set for electrical drawings and important notes. 

19. Main input power to the system connects to the 1st Data chassis. Input voltage can be 88-264Vac 

or 86-373 Vdc or 125Vdc. Other voltage input options are available. All chassis have power 

connected to terminals 1 & 2 of the power circuit board. It is likely that wires have been provided 

for paralleling power from Data chassis to Main Data Chassis (usually the 1st Data Chassis). 

Power to the Computer Control chassis should come from the Data chassis. Terminals 5 & 6 on 

the Data chassis power supply circuit board should be used to power the Computer Control 

chassis. It is likely wires have been provided for connecting output power from the Main Data 

chassis to the power input of the Computer Control chassis. 
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*WARNING*  All #6 ring terminals connecting to the power circuit board should be 

insulated ring terminals. 

20. Ensure that all chassis power switches are in the OFF position. 

 

*WARNING*  Ensure that your power source wires are not live (turned off or 
disconnected). Follow OSHA power safety lock out procedures. 
Ensure that your source can provide sufficient current to the 
recording system. Ensure that your power source is fused and 
properly earth grounded. 

21. Connect power from your source to the main or 1st Data chassis power supply board (terminals 

1&2). Use insulated #6 ring terminals. 

*WARNING*  Reference the drawings provided with the system. 

22. If using an APP-501 Computer Control chassis, open the hinged front door, pull out the computer, 

and flip up the monitor. If you purchased the optional APP-904 Monitor and Keyboard chassis 

(for the APP-601 Computer Control Chassis), open the hinged front panel door and pull out the 

monitor and keyboard.  

23. Carefully and with great prior inspection and thought, turn on your power source.  

24. Carefully turn on the power switches located at the rear of the Data chassis. 

25. If a proper turn on occurs, you should see the following: 

▪ Computer startup 

▪ APP Recorder program begins 

▪ All Data chassis front panel POWER LED illuminate green, the ONLINE LED illuminate 

green, the 1PPS LED illuminate green, and only if the continuous recording is enabled the 

CONT RECORD LED illuminate amber (yellow). 

26. If the system has not powered up correctly, please recheck your wiring and review the wiring 

prints that shipped with the recorder.  

27. Please call the factory for any required assistance (317) 536-5300. 
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3.3 Completing a Distributed Installation 

➢ To Complete a Distributed Installation Steps  

1. Inspect the cartons to see if any obvious shipping damage has occurred. If the items have been 

damaged, contact the carrier immediately and file a damage claim. Take pictures of the damaged 

cartons.  

2. Unpack the instruments and keep the cartons. If you filed a claim with the freight company, their 

inspector may want to see the boxes. Inspect the instruments and associated peripherals. If 

damaged, take pictures and file a claim with the freight company if you feel they are at fault. 

Contact APP Engineering, Inc. if any kind of damage has occurred. 

3. Carefully review the print set that was provided with the recorder. 

4. Remove any power from the panels that you will be installing equipment into or working in.  

5. Install the rack mount Computer Control chassis and Data chassis into your desired panels. Each 

chassis should be installed with (4) fasteners. Since panels utilize various size screws for rack 

mount instruments, fasteners have not been provided (unless special arrangements have been 

made).  

6. Install the din rail mount Ethernet switch. It is preferred that the switch be mounted in the same 

panel as the Computer Control chassis. A small piece of din rail has been provided. At the request 

of the customer, APP Engineering can mount the Ethernet switch to the back of a 3U rack mount 

panel. 

Note:  Unless fiber optic converters or Ethernet extenders were purchased with the 
instruments, all Data chassis should be installed within 100 meters (328 feet) of 
the Ethernet switch. 

7. Ensure that all circuit board cards are seated properly, and the holding screws are tight. Open the 

front panel doors on each chassis and ensure that internal power supplies, connectors, and 

computer are in proper position and secured in place. Ensure that no foreign objects are lying in 

the chassis. 

8. Ground all chassis to your panel grounding bars. The distance from any chassis to a panel 

grounding bar(s) should not exceed 16”. Grounding braid has been provided. Ensure that your 

panel ground bars are properly earth grounded.  

*WARNING*  Proper grounding procedures must be followed to prevent serious 
injury or death to people who may come in contact with this recording 
equipment. 

9. If you are using an APP-618 Controller for Sampled Values, connect the DSP Port to the DSP 

LAN switch. Connect the ENET LAN port of the APP-618 to the process bus network. If the 

APP-601 Data Chassis is using an IRIG-B clock, the 618 will need to get PTP clock source from 

the process bus. 

10. Review the Point Assignment Record that your company provided to APP Engineering, Inc. APP 

strives to get these records prior to shipment so the instrument internal settings are complete. Prior 

to connecting signals to the analog channels, the user must know if a particular channel has been 

designated as a voltage channel or current channel. Each analog channel has two jumpers that 

configure it for a voltage or current input. If the Point Assignment Record was received prior to 

shipment, the factory has already made the correct jumper settings. 



Installation Overview 3-8 

11. Wire the recorder analog channels. The analog channels will accept a maximum wire size of 

12AWG. The terminal block screws are #6. The maximum input to a voltage channel is 440VAC. 

The maximum continuous current through a current channel is 15Amps. 

12. Wire the recorder event (digital) channels. The event channels utilize a pluggable 16 position 

connector. The maximum wire size for this connector is 14AWG. The standard input voltage 

range is 45-250Vdc. Event Boards set up for 24Vdc are available as an option. Reference the print 

set for any notes designating event channels that require 24Vdc or event boards that are Internally 

Wetted as opposed to our typical board that needs external wetting. If the events have a common 

return and the customer provided this information to the factory, they will have jumpers between 

the (-) event terminals. 

*CAUTION*  APP Engineering manufactures an event circuit board that is 
internally wetted and is setup for dry contact connection only. Do not 
connect an external voltage to this internally wetted event circuit 
board!  

The board will have labeling indicating that it is for dry input. Again, 
reference the print set for electrical drawings and important notes. 

13. Wire the recorder alarm outputs. The alarm outputs utilize a pluggable 16 position connector. The 

maximum wire size for this connector is 14AWG. The alarm output contact is dry. The contacts 

can break 0.5Amps @ 125VDC or 0.35A @ 250VDC. 

14. Connect IRIG-B or 1PPS signal to the back of each DSP/IRIG circuit board (one board per 

chassis) according to Point Assignment Record. The IRIG-B or 1PPS-IN/OUT connectors are 

labeled and are standard BNC type connectors. This board can accept a modulated or un-

modulated IRIG-B signal, or 1PPS-IN signal. It also can output 1PPS signal. However, a board 

jumper and software setting in the Point Assignment Record must be set to reflect the input type. 

Unless a satellite-controlled clock is purchased with the system, an IRIG-B coax cable is not 

provided.  

The Chassis to chassis 1PPS signal can also be paralleled by using a BNC “T” to reduce latency. 

SNTP can be used for the clock input via LAN Enet port to an internet SNTP clock source or 

through an external SNTP clock. 

15. Each chassis has one Ethernet RJ45 connector. On the Data Chassis, this connector is located on 

the DSP/IRIG circuit boards. On the Computer Control chassis, it is simply located on the back 

panel and labeled DSP Enet. A shielded straight cable should be connected to each chassis and 

routed back to the system Ethernet switch. If a system only consists of a Computer Control chassis 

and a single Data chassis, an Ethernet switch may not have been provided. Simply make a peer-to-

peer connection between the two chassis. Typically, Ethernet cables are not provided with 

distributed system. 

16. Connect power cables to the Ethernet switch. A power cable has been provided. It should be 

connected from Data chassis power supply circuit board (terminals 3&4) to the input terminal 

block of the switch. The voltage is 12Vdc.  

*CAUTION*  It is possible that a specially requested Ethernet switch is used, and it 
may connect directly to 125VDC.  

Reference the print set for electrical drawings and important notes. 

17. In a distributed architecture, each Data chassis receives its own power input from your power 

source (station battery or AC Input). Input voltage can be 86-373 Vdc or 88-264 Vac. Other 

voltage input options are available. Power to the Computer Chassis should come from the main 
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data chassis. Terminals 5 & 6 on the data chassis power supply circuit board should be used to 

power the computer control chassis. 

*WARNING*  All #6 ring terminals connecting to the power circuit board should be 

insulated ring terminals. 

18. Ensure that the power switches, located on the back of each chassis, are in the OFF position.  

*WARNING*  Ensure that your power source wires are not live (turned off or 
disconnected). Follow OSHA power safety lock out procedures. 
Ensure that your source can provide sufficient current to each Data 
chassis. Ensure that your power source is fused and properly earth 
grounded. 

19. Connect power from your source to all the Data chassis power supply boards (terminals 1&2). 

Connect power to the computer chassis per the drawings. Use installed #6 ring terminals. 

20. Open the hinged front door of the Computer Control chassis, pull out the computer, and flip up the 

monitor. 

21. If the factory does not know the chassis arrangement prior to shipping, the Ethernet and IP 

addresses of each Data chassis must be set before powering up the system as a whole.  

 

If this is the case, complete the following  

 

Unplug all Ethernet cables from the Data chassis. Connect the provided programming cable from a 

DSP circuit board to the computer chassis RS232 connector or to your laptop running APP 

ClearView. With caution, power up the Data Chassis and Computer chassis. The APP Recorder 

program should automatically start. Via the Tools menu click “DSP Board Ethernet Settings” to 

display the settings window. The preferred Ethernet address is 2-35-69-86-203-X where X is 1, 2, 

3 etc. according to the chassis number. The preferred IP address is 192.168.203.X where X is 1, 2, 

3 etc. according to the chassis number. The preferred default gateway is 192.168.203.220. After 

setting the Ethernet address and IP Address in each Data chassis, power down all chassis and plug 

in all the Ethernet cables. 

 

If you are using an APP-618 Controller, address those chassis IP addresses by using the process 

described below in section 4.9 Networking. 

22. Carefully and with great prior inspection and thought, turn on power to all chassis. 

23. If a proper turn on occurs, you should see the following: 

▪ Computer startup 

▪ APP Recorder service program begins. 

▪ On each Data chassis, the front panel POWER LED illuminate green, the ONLINE LED 

illuminate green, the 1PPS LED illuminate green, and only if the continuous recording is 

enabled the CONT RECORD LED illuminate amber (yellow).  

24. If the system has not powered up correctly, please recheck your wiring and reference the wiring 

prints that came with the recorder.  

25. Please call the factory for any required assistance (317) 536-5300. 
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3.4 Completing a Turn-Key Installation 

➢ To Complete a Turn-Key Installation 

1. Inspect the cabinet to see if any obvious shipping damage has occurred. If the cabinet or any 

smaller auxiliary boxes have been damaged contact the carrier immediately and file a damage 

claim. Take pictures of the damaged cabinet or boxes. Keep damaged boxes to show the freight 

company inspector. 

2. Unpack any auxiliary boxes. Inspect the contents and if damaged, take pictures and file a claim 

with the freight company. Contact APP Engineering, Inc. if any kind of damage has occurred. 

3. Carefully review the print set that was provided with the recorder. 

4. Ensure that all circuit board cards are seated properly, and the holding screws are tight. Open the 

front panel doors on each chassis and ensure that internal power supplies, connectors, and 

computer are in proper position and secured in place. Ensure that no foreign objects are lying in 

the chassis. 

5. Earth ground the cabinet.  

*WARNING*  Proper grounding procedures must be followed to prevent serious 
injury or death to people who may come in contact with this recorder 
equipment. 

6. Review the Point Assignment Record that your company provided to APP Engineering, Inc. APP 

strives to get these records prior to shipment so the recorder internal settings are complete. Prior to 

connecting signals to the field side of the analog terminal blocks, the user should know if a 

particular channel has been designated as a voltage channel or current channel. Each analog 

channel contains two jumpers per channel that configures it for voltage or current input. If the 

Point Assignment Record was received prior to shipment, the factory has already made the correct 

jumper settings. 

7. Wire the analog channel terminal blocks (field side). The maximum input to a voltage channel is 

440VAC. The maximum continuous current through a current channel is 15Amps. 

8. Wire the recorder event (digital) channels. The event channels utilize a pluggable 16 position 

connector. The maximum wire size for this connector is 14AWG. The standard input voltage 

range is 45-250Vdc. Event Boards set up for 24Vdc are available as an option. Reference the print 

set for any notes designating event channels that require 24Vdc or event boards that are Internally 

Wetted as opposed to our typical board that needs external wetting. If the events have a common 

return and the customer provided this information to the factory, they will have jumpers between 

the (-) event terminals. Again, reference the print set for electrical drawings. 

*WARNING*  All #6 ring terminals connecting to the power circuit board should be 

insulated ring terminals. 

9. Wire the recorder alarm output terminal block(s) (field side). The alarm output contact is dry. The 

contacts can break 0.5Amps @ 125VDC or 0.35A @ 250VDC. 

10. Connect your IRIG-B signal to the back of the DSP/IRIG circuit board. The IRIG-B connector is 

labeled and is a standard BNC type connector. This board can accept a modulated or un-modulated 

IRIG-B signal. However, a board jumper must be set to reflect the input type. This information 

should have been provided to the factory and the jumper should already be set in the appropriate 

position. If a satellite-controlled clock is installed in the system, the antenna must be installed on 

the building roof and the antenna connected to the back of the satellite controlled clock. 
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11. If you are using an APP-618 Controller for Sampled Values, connect the DSP Port to the DSP 

LAN switch. Connect the ENET LAN port of the APP-618 to the process bus network. If the 

APP-601 Data Chassis is using an IRIG-B clock, the 618 will need to get PTP clock source from 

the process bus. 

12. Ensure that the power switch, located on the back of the Data chassis, is in the OFF position.  

*WARNING*  Ensure that your power source wires are not live (turned off or 
disconnected). Follow OSHA power safety lock out procedures. 
Ensure that your source can provide sufficient current to the 
recording system. Ensure that your power source is fused and 
properly earth grounded. 

13. Connect power from your source to the cabinet power terminal block(s) (field side). You must 

reference the print set for additional details. 

14. If using an APP-501 Computer Control chassis, open the hinged front door, pull out the computer, 

and flip up the monitor. If you purchased the optional APP-904 Monitor and Keyboard chassis 

(for the APP-601 Computer Control Chassis) open the hinged front panel door and pull out the 

monitor and keyboard.  

15. Carefully and with great prior inspection and thought, turn on your power source(s). 

16. Turn on the power switch located at the rear of the Data chassis. 

17. If a proper turn on occurs, you should see the following: 

▪ Computer startup 

▪ APP Recorder service program begin. 

▪ On the Data chassis front panels, the POWER LED illuminate green, the ONLINE LED 

illuminate green, the 1PPS LED illuminate green, and only if the continuous recording is 

enabled the CONT RECORD LED illuminate amber.  

18. If the system has not powered up correctly, please recheck your wiring and reference the wiring 

prints that came with the recorder.  

19. Please call the factory for any required assistance (317) 536-5300. 
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3.5 Basic Connection Diagram 

*IMPORTANT*  The following diagrams are to give you a general picture of chassis 
interconnections. They are NOT for wiring and installation purposes. 
You must use the detailed print set provided with each system for 
wiring and installation. 

 

Figure 5: Chassis Interconnection Diagram (Reference) (with APP-501 Computer Control Chassis) 
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Figure 6: Chassis Interconnection Diagram (Reference) (with APP-601 Computer Control Chassis) 
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Figure 7 Chassis Interconnection diagram with APP-618 Controllers 
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4.Hardware 
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4.1 Available Computer Control Chassis 

The APP-601 recorder can be purchased with either of the following Computer Control chassis: 

1) APP-601 Computer Control Chassis (fanless) 

2) APP-501 Computer Control Chassis (with fan & human interface) 

4.2 Major Duties of the Computer Control Chassis 

The major duties of the Computer Control chassis are: 

Communicate with each DSP circuit board, 618 Controllers, and Intelligent Electrical Devices (IEDs), 

carrying out functions such as collecting data, downloading settings, and downloading new software.  

Receive, organize, and store raw data. 

Convert raw data into COMTRADE C37.111-2013 format. 

Calculate continuous frequency, RMS, and phase data. 

Communicate with the APP ClearView master station software via modem, network, or directory.  

Output data in DNP-3 format via RS232 or Ethernet to a remote terminal unit or similar. 

Output PMU data.  

Provide a means for a local user to look at settings, change settings, view real-time oscillograms, look at 

stored records, communicate with someone at a master station, or even call another recorder and download 

records for review and analysis. 

4.3 APP-601 Computer Control Chassis 

The APP-601 Computer Chassis Nano Series is constructed in a 3U, 19” rack mount chassis. The chassis 

depth is approximately 9.8.” Housed inside the chassis are an industrial and fanless computer board, RAID 

controller board, Gigabit Ethernet adapter board, 3 hard drive bays (2.5” or 3.5”), 12V 100W power supply, 

5V 100W power supply, and rear slide in power supply circuit board. 

The computer chassis can be powered from an 86-373Vdc or 88-264Vac source. Ideally it should be 

powered from a data chassis via its power supply terminal block (terminals 5 & 6). In this manner, the data 

chassis can control power to the computer chassis. This gives a remote user, local user, or the system 

watchdog a means of rebooting the computer chassis. 

The 12V power supply and 5V power supply are mounted to the chassis front panel. This allows for 

maintenance access and heat sinking. 

*WARNING*  Always turn OFF chassis power before opening the chassis front 
panel. The input sides of the power supplies have 125V or 250V wired 
to them. This voltage can be deadly! Only trained experienced 
electrical personnel should open the chassis front panel and only with 
the power OFF. 

The rear slide in power supply circuit board contains a 2A fuse, components for surge protection, a power 

switch, and a 6-position terminal block. Power is connected to terminals 1 & 2 and passes through the 

board via connector X3 to the 12V power supplies discussed above. 
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*WARNING*  Only trained experienced electrical personnel should service this 
power supply circuit board and only after the unit has been turned off 
and power has been carefully removed from terminals 1 and 2. Ensure 
power has been removed from terminals 1 & 2 by measuring the 
voltage across terminals 1 & 2 (it should read zero volts). 

The computer board is powered from the 12V, 100W power supply. The computer is designed to support 

applications where high reliability and long-term availability are required. The computer features the Intel 

Atom E3845 fanless processor, which offers fast performance. This highly integrated processor along with 

its companion chip provides the majority of the board I/O, including USB support, serial ports, audio, and 

video. 

The computer has two Ethernet ports for connecting to the data chassis and to connect to Process Bus for 

IEC 61850 GOOSE Capture. This computer chassis also has a Gigabit Ethernet adapter for locally 

remoting into the system (if a monitor and keyboard are not included) or for any other auxiliary purposes. 

This Port could also be used to connect to the Station LAN if the ENET LAN port is used for connecting 

the Process Bus. 

The Basic Input/Output System (BIOS) is a program that provides a basic level of communication between 

the processor and peripherals. In addition, the BIOS also contains codes and various advanced features 

applied to the serial controller. The BIOS setup program includes menus for configuring settings and 

enabling computer board features. To enter the BIOS press the “delete” key a few seconds after powering 

up the computer chassis. Changing the BIOS settings is not recommended and may lead to incorrect 

controller behavior and possible inability to reboot. 

In our standard configuration, the computer chassis is setup with RAID 1 + hot spare. Two 1TB drives are 

in RAID 1 configuration with the 3rd 1TB drive acting as a hot spare. The RAID hard drives will contain 

both the operating system and the Setup and Data folders for the Recorder program.  

Typically, the Setup folder contains the Point Assignment Record, Line Group Record, Calibration File, 

and Trace Files. The Data folder contains the triggered transient records, triggered extended records, and 

various continuous recording folders such as continuous RMS, continuous frequency, continuous phase, 

and continuous oscillography. 

The standard 1TB SSD has a maximum temperature rating of 70° C. APP offers an optional extended 

temperature range to 85° C, allowing the Computer Control Chassis to operate in a 70° C environment. 
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4.3.1 APP-601 Computer Control Chassis Specifications  

APP-601 Computer Control chassis specifications are listed in the following table. 

Table 1: APP-601 Computer Control Chassis Specifications 

Item Description 

Operating system Windows 10, Linux Ubuntu 

Processor Atom E3845 Quad Core 

RAM  8GB DDR3-1600 

BIOS American Megatrends Inc. BIOS 

Chipset System-on-Chip integrated, Intel HD Graphics, 

Shared System memory 

Power Input 86-125Vac (50Hz/60Hz) or 86-350Vdc 

Computer auto power AC/DC power 

Power Requirements 25W (using 3 X 2.5” Hard Drives) 

Internal HDD 3 X 1TB Western Digital Red, SSD 

RAID RAID 1 + Hot Spare (2 – 1TB SSDs in RAID 1 

configuration with 1TB as hot spare automatic 

substitute failed SSD 

External HDD, CDRW, DVDRW Option 

Ports 

Notes: 

1) Use the ENET marked “DSP ENET” to connect 

the computer chassis to the Ethernet switch 

provided with the system. 

2) If not connecting the computer to the Process 

Bus, use the ENET “LAN ENET” to connect your 

substation LAN. Otherwise connect LAN ENET to 

the Process Bus network 

3) If ENET LAN Port is connected to the Process 

Bus, Connect “ENET” port to the Station LAN. 

2x RS232 (Com1 & 2) 

3x Ethernet 10/100/1000 MB 

3x USB2, 1x USB 3 

3x SATA 300 

1 HDMI, 1 VGA 

1x line-out, 1x Mic-in 

Display Option, APP-904 Mon./Keyboard Chassis 

Keyboard Option, APP-904 Mon./Keyboard Chassis 

Touchpad Option, APP-904 Mon./Keyboard Chassis 

Temperature -20°C ~ 70°C (-4°F ~ 158°F) 

Relative Humidity 10% ~ 95% relative humidity, non-condensing 

LED Indicators FRONT: 5 LEDs: 12V + 5V Power, Computer + 

RAID 1 power, RAID Error 

REAR: 6 LEDs: 1 activity + 1 error indicator for 

each hard drive 
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Figure 8: APP-601 Computer Control Chassis Front View 

 

 

Figure 9: APP-601 Computer Control Chassis Rear View 

4.4 APP-904 Rack Mount Monitor and Keyboard Console 

The APP-904 monitor and Keyboard is an optional rack mount console for use with the APP-601 Computer 

Chassis. 

APP-904 Industrial Rack Mount Monitor & Keyboard Console consist of: 1RU, 19” Rack Mount, 13” 

deep. Three Mounting Depths for Rack Mount Ears allows the console to be mounted flush, or 2” or 3.5”, 

out from the front of the rack or panel for greater monitor tilt angle. 

Table 2: APP-904 Monitor and Keyboard Specifications 

Item Description 

Power Input 86-370Vdc, or 88-264Vac, 17W @ 125VDC 

Power Input Frequency Range 47Hz to 63Hz 

Ports 

 

USB Type A 

1 - DVI-D 

1 - VGA 

1 – Three Pos Power Terminal Block 

Display Pull out drawer with 12.1” flip up Industrial TFT, 

High Brightness, cont’d XGA Monitor, 1024 x 768 

Res 

Keyboard 

Touchpad 

Waterproof, Washable Membrane, 104 Key US 

Layout, cont’d with Touchpad 

Temperature 25C to 70C 

Relative Humidity 0 to 85% non-Condensing 
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4.5 APP-501 Computer Control Chassis 

The major difference between the APP-601 Computer Control Chassis and APP-501 Computer Control 

Chassis is the incorporation of a slide out laptop computer. This approach was used in the APP-501 

recorder with great success and satisfaction. Benefits include a computer solution that is economical, 

familiar, has a local built-in human interface (window & keyboard), and provides a high degree of 

processing power.  

An Intel Core 2 Duo 2GHz or Core I5 2.6 GHz processor is used in the APP-501 chassis laptop. In 

applications using more than 200 analog channels the APP-501 Computer Control Chassis is 

recommended. The APP-501 computer chassis contains fans for processor and chassis cooling. 

The APP-501 Computer Control chassis is constructed in a 3U 19” rack mount chassis. The chassis depth is 

approximately 15.5”. Housed inside the chassis are an electrically isolated laptop computer, laptop internal 

modem, laptop internal 2.5” Hard Drive, USB to Ethernet converter, and 24V 100 Watt power supply.   

The laptop computer is mounted on a slide out shelf. The shelf and computer can be slid out of the 

enclosure by loosening the front panel thumb screws, opening the hinged panel, and carefully pulling the 

shelf forward. 

The computer chassis can be powered from a 86-373Vdc or 88-264Vac source. Power is connected to the 

rear panel terminal block terminals 1 & 2. Ideally power should come from an APP-601 Data chassis via its 

power supply terminal block (terminals 5 & 6). In this manner, the Data chassis can control power to the 

Computer Control chassis. This gives a remote user, local user, or the system watchdog a means of 

rebooting the computer chassis.  

The laptop computer battery is removed to allow for automatic power toggle during the automatic reboot 

processes. Also, the D-series laptops have their power buttons shorted and the E-series laptops have the 

BIOS configured to allow the computer to automatically startup with no human intervention. 

The chassis power supply is used to take a universal incoming voltage (typical 125VDC, 250VDC, 

120VAC, or 240VAC) and convert it to 24VDC. Manually, the 24VDC is reduced to approximately 

21VDC via an easy access power supply pot. The 21VDC signal is used to power the laptop computer.  

 Figure 10: APP-904 Optional Monitor and Keyboard Figure 10 APP-904 Optional Monitor and Keyboard 
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*WARNING*  When the chassis rear panel is open high voltage is exposed. This 
voltage can be deadly. Only trained experienced electrical personnel 
should service this power supply circuit and only after the unit has 
been turned off and power has been carefully removed from terminals 
1 and 2. Ensure power has been removed from terminals 1 & 2 by 
measuring the voltage across terminals 1 & 2 (it should read zero 
volts). 

Since the laptop computer only has one Ethernet port, a second port is created by using a Trendnet USB to 

Ethernet converter. The laptop Ethernet port is used for the DSP network and the Ethernet connection from 

the Trendnet converter is used for customer LAN connection. 

In our standard configuration, the 2.5” computer hard drive is set up as the “C-Drive” and holds the 

Windows operating system and the APP Recorder program.  The APP ClearView program is also installed 

on the hard drive so a local person can view and analyze fault records or test runs. 

The “C-Drive” also holds the Setup folder and Data folders. Typically, the Setup folder contains the all 

important Point Assignment Record, trace files, and calibration file. The Data folder contains the triggered 

transient records, triggered extended records, and various continuous recording folders such as continuous 

RMS, continuous frequency, continuous phase, continuous oscillography, and Power Quality (PQ).  

 

4.5.1 APP-501 Computer Control Chassis Specifications 

APP-501 Computer Control chassis specifications are listed in the following table. 

Table 3: 501 Computer Control Chassis Specifications 

Item Description 

Operating system Windows 10, Linux Ubuntu 

Processor Intel Core i5 2.6GHz 

RAM 2GB DDR Minimum 

SSD Option 

Internal HDD 500GB Min. 

External HDD Option 

DVDRW  Yes 

Ports 1-RS232 

Ports 2-Ethernet 10/100 (1 for DSP, 1 for LAN) 

Ports 2-USB 

Display Yes, 14.1” LCD 

Keyboard Yes 

Touchpad  Yes 

Temperature 5 to 55° C with battery removed 

Modem Yes, External 
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Figure 11: APP-501 Computer Control Chassis 3D View 
 

 

Figure 12: APP-501 Computer Control Chassis Front View 

 

 

Figure 13: APP-501 Computer Control Chassis Rear view 
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4.6 APP-601 Data Chassis 

The Data chassis is housed in a 19” rack mount enclosure with a hinged front panel. Circuitry contained in 

the Data chassis includes: 

Power Supply Circuit Board with Fuse & Switch 

5V 100 Watt Power Supply 

12V 100 Watt Power Supply 

Alarm Circuit Board 

Event Circuit Boards 

DSP/IRIG Circuit Board 

Analog Circuit Boards 

Traveling Wave Circuit Board 

Front Panel with LED Indicators 

A Data chassis has 13 card slots. Three slots are always reserved: (1) for the power supply board, (1) for 

the alarm board, and (1) for the DSP/IRIG board. The other 10 slots can be populated with analog or event 

circuits. Therefore, the maximum number of analog circuit boards in a Data chassis is ten (no event circuit 

boards). Or, the maximum number of event circuit boards is ten (no analog circuit boards). A mix of analog 

and event boards can be inserted in the chassis, so long as the total does not exceed ten. 

Functions and features of the Data Chassis circuit boards are discussed below: 

4.6.1 Power Supply Circuit Board 

Fuses the input power (2Amp/250V, 3AG, Slo-Blo, Glass Cartridge) 

Uses a six position black barrier terminal block for input & output power connections (#6 screws) 

Accepts input voltages of 86-373Vdc (48vdc Option) or 88-264Vac (50/60Hz) 

Input voltage is connected to terminals 1 & 2 

Terminals 3 & 4 are used for a 12VDC output to power the system Ethernet switch 

Terminals 5 & 6 are used for powering the Computer Control Chassis. The voltage that appears across 

terminals 5 & 6 will be the same as the input voltage.  

This board contains a relay that drops power to the system, if it receives an appropriate command from a 

local user or the master station computer. After a momentary power interruption, used as a last resort to 

reboot the computer and reset the entire system, the relay automatically closes to restore system power.  

*WARNING*  All #6 ring terminals connecting to the power circuit board should be 

insulated ring terminals. 
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4.6.2 5VDC Power Supply Module 

This module allows the system to have a wide range of input voltages of 86-373Vdc (48vdc Option) or 88-

264Vac (50/60Hz) 

The output of this module is 5VDC, 100W 

The module includes over load, over voltage, and over temperature protection. 

This unit is mounted on the back of the chassis front panel.  

*WARNING*  Always turn OFF chassis power before opening the chassis front 
panel. The input sides of the power supplies have 125V or 250V wired 
to them. This voltage can be deadly! Only trained experienced 
electrical personnel should open the chassis front panel and only with 
the power OFF. 

5V provided by this power supply is connected to the mid plane circuit board via a 2 position green plug 

and receptacle, XP20 and X20 respectively. The 5V signal is routed to the power supply circuit board 

where it passes thru a normally closed relay contact, back to the mid plane circuit board, and on to various 

boards that plug into the mid plane.  

4.6.3 12VDC Power Supply Module 

The output of this module is 12VDC, 100W 

The module includes overload, over voltage, and over temperature protection. 

This unit is mounted on the back of the chassis front panel.  

*WARNING*  Always turn OFF chassis power before opening the chassis front 
panel. The input sides of the power supplies have 125V or 250V wired 
to them. This voltage can be deadly! Only trained experienced 
electrical personnel should open the chassis front panel and only with 
the power OFF. 

12V provided by this power supply is connected to the mid plane circuit board via a 3 position green plug 

and receptacle, XP18 and X18 respectively. The 12V signal is routed to the power supply circuit board 

where it passes thru a normally closed relay contact and lands on power supply circuit board 6 position 

terminal block (terminals 3 & 4). 

*CAUTION*  The 12V output should ONLY be used to power the system EISK 
series Ethernet switch (manufactured by Contemporary Controls), the 
N-Tron (by Red Lion) Ethernet Switch, or low power TTL to fiber media 
converter. Reference the system drawings for detail. 
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4.6.4 Alarm Circuit Board 

The alarm board contains (8) relay outputs. A selection of alarms can be mapped to the relay outputs. More 

than one alarm can be mapped to a relay, note exceptions below. Alarm mapping is done via software in the 

Point Assignment Record. 

The relays are indirectly energized via a 5V signal coming from the DSP circuit board. See 

“Specifications” for relay contact ratings. 

Each relay uses an on-board jumper that will allow the contact to be either normally open or normally 

closed. The board is labeled for easy jumper placement. 

The relay board utilizes a 16 position pluggable connector. The plug will accept a maximum wire size of 

14AWG.  

Alarm selections include:   

▪ Power 

Relay is energized when system power is applied. Most users will put contact in the normally 

closed position. We recommend Power be mapped to its own output, no other alarm should be 

mapped to those outputs. 

▪ Online 

Relay is energized when the system program starts and the system is ready to record or is 

recording. Most users will put this contact in the normally closed position. We recommend 

Online be mapped to its own output, no other alarm should be mapped to those outputs. 

▪ Offline 

Relay is energized when the system program, APP Recorder, is stopped. Most users will set 

this contact to the normally open position.  

▪ Clock Sync Loss 

Relay is energized when the DSP/IRIG board has completely lost its IRIG-B input, such as 

disconnecting the cable, or the satellite clock sends a signal (4 bits per the IEEE standard) that 

an error greater than 1ms has occurred. The relay will stay energized until a synchronized 

condition is reestablished. Most users will set this contact as normally open.  

▪ Chassis to Chassis Communication Error 

Relay will energize if any data acquisition chassis stops communicating with the computer 

control chassis for a period of 5 minutes or more. The relay will stay energized until the 

problem chassis begins proper communication. Most users will set this contact in the 

normally open position.  

▪ Chassis to Master Station Communication Error 

Relay will energize if the recorder modem or network card stops communicating with the 

APP recorder software. The relay will remain energized until the problem is fixed. Most users 

will set this contact in a normally open position.  

▪ Disk Full 

Relay will energize when the computer hard drive memory falls below a user programmable 

limit. The relay will remain energized until the hard drive free space goes above the user 

programmable limit. However, if the history overwrite feature is enabled, the alarm relay will 

not energize. Most users set this contact in the normally open position.  

▪ Trigger 

Relay will energize when the recorder trips, records a transient record. The relay will remain 

energized for the duration set in Alarm Duration field. The default is 10 seconds. Most users 

will set this contact in the normally open position.  

▪ Disturbance Record 

If a trigger has been defined as a Disturbance trigger using YES in the Point Assignment 

Record, the relay will energize when the recorder trips. The relay will remain energized for 

the duration set in Alarm Duration field. The default is 10 seconds. Most users will set this 

contact in a normally open position. If the Disturbance trigger is set using NONE, the alarm 

will not energize. 
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▪ SOE Record 

If a digital point has been set up as sequence of event point, in the Point Assignment Record, 

the relay will energize when any SOE/SER point goes abnormal. The relay will remain 

energized for the duration set in Alarm Duration field. 10 seconds is default. Most users will 

set this contact in a normally open position.  

If a digital point has been set up as a Perpetual point in the Point Assignment Record, the 

relay will energize when any SOE/SER point goes abnormal. The relay will remain energized 

until the channel returns to Normal status. 

▪ DSP Temperature 

If the DSP temperature sensor measures a temperature that exceeds the setting in the Point 

Assignment Record, the relay will energize and remain energized until the temperature drops 

below the user setting. The user selectable range is 65 to 85° C. The default setting is 70°C.  

▪ Continuous Record 

If the continuous recording feature has been enabled in the Point Assignment Record, the 

relay will energize when the continuous recording begins. Most users will set this contact to 

the normally open position. We recommend Continuous Record be mapped to its own output, 

no other alarm should be mapped to those outputs. 

▪ PC Health 

This alarm monitors the hard drive(s) and temperature and CPU Temperature. This relay will 

energize if the temperature of the hard drive exceeds 70° C. A program called HDSentinel 

must be installed on the recorder computer for this alarm to be functional. 

APP Recorder monitors HDSentinel for active drives, if there are fewer active drives in 

HDSentinel than the number entered in the “# of HD/SSD field, in the PAR General Settings 

Tab, this relay will energize. We recommend PC Health be mapped to its own output, no 

other alarm should be mapped to those outputs. 

 

CPU temperature is monitored by Speedfan and must be installed on the computer 

▪ Analog Fail 

This alarm monitors each analog channel. The relay will energize if the measured value of the 

analog channel goes to maximum negative, indicating a failed channel. 

Note: Even though this alarm is not mapped to an alarm output, if a failed channel is 
detected it will be logged to the trace file and diagnostic report (Status File). 

▪ Cross Trigger 

This Alarm output is to trigger another DFR when a fault is encountered. This starts the 

recording in the second DFR, at nearly the same time as the first DFR to create a parallel fault 

record for the components monitored in the second DFR. The DFRs need to be connected to a 

network via the Ethernet switch and the IP address of the DFR Computers need to be entered 

into the Point Assignment Record/Event Channel assigned to receive the cross triggers see  

Figure 14 below. OR the DFRs need to be wired from the alarm output associated with the 

cross trigger in the first DFR to a digital event input, configured for Cross Trigger in the 

PAR) in the second DFR to receive the Cross Trigger see Figure 15 below. 

Note: This Cross Trigger approach is not recommended, as it can be less accurate than the 
standard APP 601 configuration. The standard APP 601 DFR configuration has one 
Computer Unit with multiple Data Chassis in a centralized or distributed configuration. 
Cross triggering between the Data Chassis is automatic and time alignment is 
accurate (within 1 µs or better). 

*CAUTION*:  All DFRs should have the same Transient Sampling Rate set up in the Point 
Assignments Records. 
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➢ Configuring and wiring for Cross Trigger using an IP Network 

Follow these instructions to set up Cross Triggering between separate DFRs using an IP Network. 

1. In the Point Assignment Record of the DFRs, map the Cross Trigger Alarm to an 

output contact of your choice (see Configuring Point Assignment 

Record/Configuring General Settings section in the Clearview Operating Manual). 

2. In the Point Assignment Record of the DFRs, map an event channel of your choice to 

be a cross trigger input (see Configuring Point Assignment Record/Configuring 

Event Channels section in the Clearview Operating Manual). 

Note: The assigned Event Channel for receiving a Cross Trigger over the IP network must 
NOT be wired, (i.e. must be left open.) 

3. To connect the DFRs that will cross trigger, run an Ethernet cable between the 

switches connecting the DSP boards of each DFR, see  Figure 14 below. 

4. Typically, each DFR is assigned IP addresses as described in the section 4.9 

Networking. If you have more than one DFR in a station, you could have the same IP 

addresses assigned to each. This is acceptable unless they are networked as in the 

Cross Trigger arrangement using an IP network. Assign unique IP addresses to the 

Computers and Data Chassis. An example involving three DFR computer IP 

addresses: 192.168.203.220, 192.168.203.221, 192.168.203.222. See below, sample 

unique addressing scheme. 

*CAUTION*  If you are adding Cross Trigger to existing DFRs, you may have to re-
address the Computer Unit and DSP IP addresses to eliminate any 
duplicates when connecting the Ethernet switches. 

 Figure 14: Cross Trigger over IP Network 

➢ Configuring and wiring to Cross Trigger between multiple DFRs 

Follow these instructions to set up Cross Triggering between separate DFRs using the Data Chassis 

Alarm output and Event Input physical connections. 

1.  In the Point Assignment Record of the DFRs, map the Cross Trigger Alarm to an 

output contact of your choice (see Configuring Point Assignment 

Record/Configuring General Settings section in the Clearview Operating Manual). 

Ethernet connection 

for cross trigger 
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2. In the Point Assignment Record of the DFRs, map an Event Channel input of your 

choice to be a Cross Trigger input (see Configuring Point Assignment 

Record/Configuring Event Channels section in the Clearview Operating Manual). 

3. Wire the output cross trigger contact of DFR#2 to an event channel input on DFR #1, 

DFR #3, to DFR #n 

4. Repeat wiring for as many DFRs as you want.  (See Figure 15: Cross Trigger Wiring, 

3 DFR Example). 

5. We recommend setting the prefault timer on all DFRs at least 750ms. 

Figure 15: Cross Trigger Wiring, 3 DFR Example 

 

▪ TW Fail 

The TW Fail alarm monitors communications with Traveling Wave boards. If you have 

Traveling Wave boards installed and configured in the Point Assignment Record, TW Fail 

Alarm will energize if the TW board(s) are not communicating with the Recorder Driver. 

4.6.5 Event Circuit Board 

▪ An event board contains 8 event inputs. The maximum number of event channels in a Data 

chassis is 80 (10 boards x 8 channels per board). 

▪ The standard voltage range for an event input is 45-250VDC. Other input voltage ranges are 

available as an option.  

▪ An event board utilizes a 16 position pluggable connector. The plug will accept a maximum 

wire size of 14AWG. 

▪ Inputs are user programmable as either normally open or normally closed. See the Point 

Assignment Record. 

▪ On our standard event circuit board, inputs need to be externally wetted. APP offers an 

internally wetted event circuit board upon request (see wiring diagrams Figures 14 and 15 

below). 

▪ For common return simply daisy chain the (-) negative terminals together and connect to 

station battery return (DC return). 

▪ Event channels are scanned at the same rate as the analog channels. The scan rate is user 

programmable and includes choices of 1200Hz, 2400Hz, 4800Hz, 9600Hz, and 11,520Hz, 

and 15,360Hz, 16,800Hz, 19,200Hz, or 24,000Hz. 

▪ Event channels can be user programmed as DFR, SER, or BOTH. If a channel is set up as 

DFR, all channels on the recorder begin recording and a COMTRADE record is created when 

it goes abnormal. If a channel is set up as SER, it alone is recorded in the Sequence of Event 

Report when it goes abnormal. If a channel is set up as BOTH, then both DFR and SER 

recordings occur simultaneously. 
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▪ If an event channel is set up as a DFR channel, it can also be user programmed to trigger on a 

rising edge, falling edge, or both. 

▪ To prevent nuisance event triggers, user programmable settings are available to automatically 

shut down and then restart event triggers. 

▪ Event channels can be user programmed to include a de-bounce time. De-bounce time of 0.40 

ms is typical. 

 

 

 

Figure 16: Externally Wetted Event Board 

Figure 17: Internally Wetted Event Board 
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4.6.6 DSP/IRIG Circuit Board  

The DSP/IRIG board is the heart of a Data chassis. The DSP IC contains the recorder driver program and is 

responsible for collecting data from the analog and event inputs. The DSP IC performs mathematical 

calculations on the data received from each analog and event channel and decides if a trigger condition 

exists. Prefault data is stored in a circular buffer. If a trigger condition does not exist, the oldest prefault 

data is overwritten by new incoming prefault data (FIFO). If a trigger condition is measured, the prefault 

data plus incoming data is routed to the Computer Control chassis via the Ethernet connection. If 

continuous recording is enabled, the above triggering process is carried out and incoming data from the 

analog channels are continuously routed to the Computer Control chassis (all with data sample time 

stamping.) 

The DSP/IRIG board can accept a modulated or un-modulated IRIG-B input signal from a satellite-

controlled clock. The top BNC connector, J6, is the IRIG-B input. Each data sample is time stamped to the 

microsecond. Data is aligned with the 1PPS rising edge and the accuracy of the time stamp is no better than 

the accuracy of the 1PPS signal coming from the satellite controlled clock.  

Precision Time Protocol (PTP) input Option, PTP input is being developed as an option and requires 

DSP Card version 6.4 or higher and firmware versions beginning with P support PTP, and only firmware 

versions P325 and newer support peer-to-peer PTP. 

Table 4: SyncMethod and Corresponding Hardware 3-PIN Jumper Position 

SyncMethod JP2 3-PIN Jumper (DSP/IRIG Circuit Board) 

Un-modulated IRIG-B Short middle pin & pin close to panel 

Modulated IRIG-B Short middle pin & pin away from panel 

SNTP (External Clock) N/A (LAN ENET interface) 

PTP (E2E) Option N/A (LAN ENET interface) 

PTP (P2P) Option N/A (LAN ENET interface) 

Note: There are “un-mod” and “mod” labels on back of DSP board under the JP2. 

If the DSP/IRIG board loses the 1PPS signal from the satellite-controlled clock, the DSP IC no longer 

receives a 1PPS interrupt signal. In this case, the DSP will rely on its own 1PPS signal that is generated 

from an onboard 25MHz crystal. The crystal has an accuracy of 100ppm which translates to an error of 

0.1msec/1sec (8.6sec/day). 

The system computer, located in the Computer Control chassis, is time synchronized with the satellite-

controlled clock. If the recorder is powered up and there is no satellite controlled clock present, the 

beginning time of day is obtained from the computer. 

*CAUTION*  We recommend turning on the satellite controlled clocks extended 
IEEE C37.118 IRIGB format. If the clock does not have this feature, we 
recommend not turning off the computer’s Daylight Saving Time. 

If the recorder contains multiple Data chassis, the 1PPS signal is routed from the first Data chassis down to 

the next Data chassis via the 1PPS out/in connectors.  

The DSP/IRIG circuit board is always located in the 7th board slot, from the left side of the chassis. There is 

one DSP/IRIG circuit board per Data chassis. 
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Major hardware/firmware items on this board include the following: 

DSP7 or Later: 

▪ High Performance Digital Signal Processing IC (400MHz, 32bit, 5MB On Chip Dual-Ported 

SRAM, Integrated I/O Processor with Multiprocessing Support and Multiple Internal Buses to 

Prevent I/O Bottlenecks, 176LQFP style package) 

▪ 512MB High Speed SDRAM IC 

DSP 6 and lower: 

▪ High Performance Digital Signal Processing IC (100MHz, 32bit, 1MB On Chip Dual-Ported 

SRAM, Integrated I/O Processor with Multiprocessing Support and Multiple Internal Buses to 

Prevent I/O Bottlenecks, 15x15 BGA style package) 

▪ 256MB High Speed SDRAM IC 

 All DSP boards: 

▪ Microcontroller with Ethernet Media Access Controller 10/100 

▪ 2MB Serial Flash Memory IC 

▪ IRIG Isolation IC & Isolation Transformer 

▪ IRIG-B Demodulating Circuit 

▪ BNC Connectors for IRIG-B Input, 1PPS Output & 1PPS Input 

▪ RJ45 Connector (Ethernet Connection) 

▪ Mini Din Connector (Used by the factory for initial IP address and board setup) 

Jumper Settings 

▪ JP1 – Jumper On =Normal Operating State 

      Jumper Off =Factory Debug Position  

▪ JP2 – Jumper Pins 1 to 2 =Modulated IRIG-B Input 

      Jumper Pins 2 to 3 =Un-Modulated IRIG-B Input 

▪ JP3  

JP3 has a new pin layout on DSP board 6.4 and higher. JP3 changed from a 3 PIN to a 6 PIN 

jumper. The following describes JP3 settings for V6.3 and below, then V6.4 and higher. 

 

JP3 Pin layout 

DSP V6.4 

       

3 2 1 

6 5 4 

 

o JP3 – DSP V6.3 and lower (3 PIN) 

▪ JP3 – Jumper Pins 1 to 2 = External 1PPS 

Jumper Pins 2 to 3 = Internal 1PPS 

PTP not available with DSP 6.3 or below 

o JP3 – DSP V6.4 and higher (6 PIN) 

▪ JP3 – Jumper Pins 5 to 6 = External 1PPS 

Jumper Pins 4 to 5 = Internal 1PPS 

Jumper Pins 2 to 5 = PTP 
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Note: Internal 1PPS indicates that an IRIG-B signal has been connected to the DSP circuit board 
(the 1PPS signal is part of the IRIG-B signal). 

External 1PPS indicates the DSP circuit board is receiving a 1PPS signal from another 
DSP circuit board or possibly from a clock 1PPS output. 

▪ J1 is used to connect an emulator. Under normal operating conditions. J1 must have four 

jumpers in the following positions: 

           5 to 6      

       

           7 to 8      

  

           9 to 10      

      

          11 to 12       

▪ J2 is used by the factory to download a program to the microprocessor/Ethernet IC. During 

normal operation J2 has no jumpers. 

▪ If the 1PPS signal is daisy chained from chassis to chassis via the input and output BNCs the 

latency is 100ns per jump. Latency can be nearly eliminated by using a BNC “T” connector 

and paralleling the 1PPS signal from input to input. 

4.6.7 Analog Circuit Board 

An analog board contains 3 channels. The maximum number of analog channels in a Data chassis is 30 (10 

boards x 3 channels per board). 

A channel can be set up as a voltage channel or current channel. To make this selection, software settings 

must be made and two hardware jumpers per channel must be set. Software settings are made in the Point 

Assignment Record and are discussed in a later section. The hardware setting is made via two jumpers on 

each channel (JP1 & JP2 on the 1st board channel, JP3 & JP4 on the 2nd board channel, and JP5 & JP6 on 

the 3rd board channel). These are 3 pin headers. 

To set up a channel for voltage input, place the shorting jumper on the middle pin and the pin towards the 

middle of the circuit board. 

To set up a channel for current input, place the shorting jumper on the middle pin and the pin towards 

the 9 position black analog terminal block and blue rear panel. 

*CAUTION*  Ensure that the voltage/current jumper is set properly before wiring to 
the circuit board terminal block. 

For a voltage channel, the input should be wired between V & C (voltage and common). 

Pin layout 

       

13 11   9 7 5 3 1 

14 12 10 8 6 4 2 
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The following diagrams show wiring for 3-phase Voltage channels using WYE and Delta 

connections. 

Figure 18: 3-Phase Delta Connection (Voltage) 

Figure 19: 3-Phase WYE Connection (Voltage) 

For a current channel, the input should be wired between I & C (current and common). 
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The following diagrams show wiring for 3-Phase Current connections using Analog Channels. 

Figure 20: 3-Phase Current connection - Internal Shunt 
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Figure 21: 3-Phase current connection - Clamp on CT 

 

 

 

*WARNING*  The maximum input voltage for a voltage channel is 440VAC.  

The maximum continuous current for a current channel is 15Amps. 

The maximum current into a current channel for 0.5 seconds is 
250Amps RMS or 140 Amps RMS for 2 Seconds 

The maximum wire size for an analog terminal block is 12AWG 
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4.6.8 Traveling Wave Circuit Board 

A Traveling Wave board contains one channel.  

 

Figure 22: Diagram of Traveling Wave circuit board 

The block diagram above represents the hardware of the traveling wave (TW) board and included high 

bandwidth current transformer (CT) that must be installed on the APP-601 data chassis to record traveling 

wave data for the TWFL feature to function. 

The input signal is a secondary current signal which passes through the CT with a 500:1 ratio. The 

bandwidth of the CT has been tested to operate in the range of 60Hz to 1MHz. The CT outputs a voltage 

signal. 

The CT connects to the TW board via BNC connector. The input signal will generally be a 60Hz nominal 

signal. The signal then passes through a high-pass filter (HP FILTER) with a corner frequency of 14kHz 

which refines the presence of the fault. 

The filtered signal is then split between an analog-digital converter (ADC) and voltage-threshold trigger 

(V-th TRIG). Both are receiving GPS time signals and assign time-marks according to the GPS time. 

The ADC has a sampling frequency of 1.2MHz and outputs data points to form a graph in a fault record. 

The V-th TRIG has a trigger frequency of 120MHz and records the time-mark of the fault at a nanosecond 

precision and records it in an INF file of the fault record. This information can be found in the fault 

summary of the fault record. The over-under voltage of the V-th TRIG is the trigger ratio 𝑅𝑇 multiplied by 

the peak noise 𝐼𝑁𝑃𝑘 , which can be positive or negative. The peak noise is generally around 1A at the 

secondary. 

|𝑉𝑡ℎ| = 𝑅𝑇𝐼𝑁𝑃𝑘  

The absolute peak range of the V-th TRIG is 120A. 

4.6.9 Front Panel LED’s 

The Data Chassis uses front panel LED’s to give a quick indication of system status.  

Green LED’s will illuminate when the recorder is operating properly. Red LED’s will illuminate if a 

recorder problem exists. Yellow LED’s will illuminate when the system is recording data. An explanation 

of each LED is listed in the following table. 
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Table 5: Description of LEDs 

LED Color Description 

POWER Green Illuminates when the system power is switched 

on and is normal. 

ONLINE Green Illuminates after the APP Recorder 

Program/Service is running and normal system 

operation has started. 

1PPS Green Illuminates if the 1PPS signal is present from an 

external satellite controlled clock.  If no satellite 

controlled clock is connected, this LED will 

illuminate if the internally generated 1PPS signal 

is present and normal. 

OFFLINE Red Illuminates if the system is not ready to record. 

CLK SYNCLOSS Red Illuminates if an IRIG-B signal is not connected 

to the recorder or the satellite controlled clock 

has sent a lost Syncsignal. The LED will remain 

illuminated until synchronization occurs. Error 

information will appear in the Trace file. 

DISK FULL Red Illuminates if the hard drive free space has 

reached a user programmed minimum free space 

amount. This LED will remain illuminated until 

the hard drive free space exceeds the minimum 

limit. 

MASTER COMM 

ERROR 

Red Illuminates if the recorder software is not able to 

communicate with the system modem or 

network card. The LED will remain illuminated 

until the problem has been fixed. 

CHASSIS – CHASSIS 

COMM ERROR 

Red Illuminates if any data acquisition chassis stops 

communicating with the computer control 

chassis for a period of 5 minutes or more. The 

LED will remain illuminated until the problem 

chassis begins proper communication. Error 

information will appear in the Trace file. 

TRANS RECORD Yellow This LED will illuminate after the recorder trips 

and creates a transient fault record. The LED 

will remain illuminated for the time set in the 

PAR, Fault/SER LED Alarm Duration. 10 

seconds is the default. 

CONT RECORD Yellow This LED will illuminate if the system is 

currently performing any continuous recording 

function. 
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Figure 23: APP-601 Data Chassis 3D View 

 

 

Figure 24: APP-601 Data Chassis Front View 

Figure 25: APP-601 Data Chassis Rear View 

  
(Blank Panels Shown in Slots 5 & 6, Analog or Event Board can be inserted) 

4.7 APP-618 Controller 

The APP-618 Controller is used to capture IEC-61850 Sampled Values data from Analog Channels from 

Intelligent Electrical Devices (IED) and Merging Units (MU) via the Process Bus. Event data is captured 

by IEEC-61850 GOOSE Capture. GOOSE data is captured by the APP Recorder Computer running APP 

GOOSE Capture software and is discussed in a separate section. 
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The APP-618 Controller Chassis is constructed in a 3U, 19” rack mount chassis. The chassis depth is 

approximately 9.8.” Housed inside the chassis are an industrial and fanless computer board, RAID 

controller board, Gigabit Ethernet adapter board, 3 drive bays (2.5” or 3.5”), 12V 100W power supply, 5V 

100W power supply, and rear slide in power supply circuit board. 

The controller chassis can be powered from an 86-373Vdc or 88-264Vac source. Ideally it should be 

powered from a data chassis via its power supply terminal block (terminals 5 & 6). In this manner, the data 

chassis can control power to the computer chassis. This gives a remote user, local user, or the system 

watchdog a means of rebooting the controller chassis. 

The 12V power supply and 5V power supply are mounted to the chassis front panel. This allows for 

maintenance access and heat sinking. 

*WARNING*  Always turn OFF chassis power before opening the chassis front 
panel. The input sides of the power supplies have 125V or 250V wired 
to them. This voltage can be deadly! Only trained experienced 
electrical personnel should open the chassis front panel and only with 
the power OFF. 

The rear slide-in power supply circuit board contains a 2A fuse, components for surge protection, a power 

switch, and a 6-position terminal block. Power is connected to terminals 1 & 2 and passes through the 

board via connector X3 to the 12V power supplies discussed above. 

*WARNING*  Only trained experienced electrical personnel should service this 
power supply circuit board and only after the unit has been turned off 
and power has been carefully removed from terminals 1 and 2. Ensure 
power has been removed from terminals 1 & 2 by measuring the 
voltage across terminals 1 & 2 (it should read zero volts). 

The computer board is powered from the 12V, 100W power supply. The computer is designed to support 

applications where high reliability and long-term availability are required. The controller features the Intel 

Atom E3845 fanless processor, which offers fast performance. This highly integrated processor along with 

its companion chip provide the majority of the board I/O, including USB support, serial ports, audio, and 

video. 

The controller has two Ethernet ports, 1 for connecting to the DSP Network and 2nd to connect to the 

Process Bus to receive Sampled Values stream from IEDs or Merging Units (MUs) as well as a PTP clock 

source.  

The Basic Input/Output System (BIOS) is a program that provides a basic level of communication between 

the processor and peripherals. In addition, the BIOS also contains codes and various advanced features 

applied to the serial controller. The BIOS setup program includes menus for configuring settings and 

enabling computer board features. To enter the BIOS press the “delete” key a few seconds after powering 

up the computer chassis. Changing the BIOS settings is not recommended and may lead to incorrect 

controller behavior and possible inability to reboot. 

In our standard configuration, the computer chassis is set up with RAID 1 + hot spare. Two 1TB SSDs are 

in RAID 1 configuration with the 3rd 1TB SSD acting as a hot spare  

The standard 1TB SSD has a maximum temperature rating of 70° C. APP offers an optional extended 

temperature range to 85° C, allowing the Computer Control Chassis to operate in a 70° C environment. 
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APP-618 Controller chassis specifications are listed in the following table. 

Table 6: APP-618 Controller Chassis Specifications 

Item Description 

Operating system Linux Ubuntu 

Processor Atom E3845 Quad Core 

RAM  8GB DDR3-1600 

BIOS American Megatrends Inc. BIOS 

Chipset System-on-Chip integrated, Intel HD Graphics, 

Shared System memory 

Power Input 86-125Vac (50Hz/60Hz) or 86-350Vdc 

Computer auto power AC/DC power 

Power Requirements 25W (using 3 X 2.5” Hard Drives) 

Internal HDD 3 X 1TB SSD Western Digital Red 

RAID RAID 1 + Hot Spare (2 – 1TB SSDs in RAID 1 

configuration with 1TB as hot spare automatic 

substitute failed SSD 

External HDD, CDRW, DVDRW Option 

Ports 

Notes: 

1) Use the ENET marked “DSP ENET” to connect 

the controller chassis to the Ethernet switch 

provided with the system. 

2) Use the ENET marked “LAN ENET” to 

connect your Process Bus LAN. 

3) Use ENET labeled port to connect to your 

substation LAN 

2x RS232 (Com1 & 2) 

3x Ethernet 10/100/1000 MB 

3x USB2, 1x USB 3 

3x SATA 300 

1 HDMI, 1 VGA 

1x line-out, 1x Mic-in 

Display Option, APP-904 Mon./Keyboard Chassis 

Keyboard Option, APP-904 Mon./Keyboard Chassis 

Touchpad Option, APP-904 Mon./Keyboard Chassis 

Temperature -20°C ~ 70°C (-4°F ~ 158°F) 

Relative Humidity 10% ~ 95% relative humidity, non-condensing 

LED Indicators FRONT: 5 LEDs: 12V + 5V Power, Computer + 

RAID 1 power, RAID Error 

REAR: 6 LEDs: 1 activity + 1 error indicator for 

each hard drive 
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Figure 26 APP-618 Controller Chassis front view 

 

 

Figure 27 APP-618 Controller rear view 

 

4.8 Ethernet Switch 

The Ethernet switch allows the flow of information between the Computer Control chassis, the Data 

chassis, and 618 Controller chassis. The standard Ethernet switch, included with the recorder, is a five or 

eight port EISK series or N-Tron unmanaged plug and play switch. The EISK and N-Tron switches are 

intended for commercial and industrial applications. They have a wide temperature and operating range and 

comply with electromagnetic compatibility and EFT/Surge standards. 

The auto-negotiate protocol allows it to link with any compatible 10BASE-T or 100BASE-TX device. It 

will allow function with any application layer that works with Ethernet, including Modbus/TCP or 

Ethernet/IP. The switch has built-in broadcast storm control to prevent excess broadcasts from degrading 

network performance. 

To aid in troubleshooting, each port LED is lit solid if a valid link exists to an attached device, flashes to 

show activity, and indicates data rate by color: green for 100Mbps and yellow for 10Mbps. A separate 

green LED indicates the device is powered. 

In most cases, power for the switch comes from a Data chassis or Computer Control chassis. Both Chassis 

output 12VDC via the power supply circuit board terminal block. The 12VDC output is located on 

terminals 3 & 4.  

  



Hardware 4-28 

The following table lists the switch specifications. 

Table 7: Switch Specifications 

Specification Details 

Input voltage 10-36VDC or 8-24VAC 

Power 5 Watts 

AC Input Frequency 47-63Hz 

Operating Temperature 0 to 60º C 

Relative Humidity 0 to 95% non-condensing 

Data Rate 10/100 Mbps 

Protection IP30 

Signaling 10Base-T/100Base-TX 

Port Connectors Shielded RJ-45 

 

Table 8: Pin Out 

RJ-45 Usage 

1 TD+ 

2 TD- 

3 RD+ 

4 Not Used 

5 Not Used 

6 RD- 

7 Not Used 

8 Not Used 

(Ports normally assume the internal crossover function but will automatically adapt to connected devices. 

Straight instead of crossover cable is preferred. When daisy chaining switches, straight cable is a must.) 

*CAUTION*  The Ethernet Switch is used for the DSP network only. The users 
company LAN/WAN connects to a RJ45 connector labeled “LAN Enet” 
on the computer chassis rear panel. 

*CAUTION* From time-to-time the user specifies an Ethernet Switch other than 
our standard Contemporary Controls EISK series or N-Tron. In this 
case, it is likely that the switch powers from substation 125VDC, not 
the 12V output from the recorder. Also, the DSP circuit board may 
need to be reprogrammed from Auto Negotiate to 100Mbit and Full 
Duplex 
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4.9 Networking 

The Computer Control Chassis uses two or three separate network setups. One is for recorder functionality 

(chassis-to-chassis communication & data transfer) and the second or third is for communication between 

the recorder (APP Recorder Software) and the master station (APP ClearView Software). The third 

connection is used in the case where the ENET LAN (2nd) port is connected to the Process Bus Network for 

IEC-6185 GOOSE Capture. If not, the third or ENET is typically used when connecting a laptop for remote 

access. 

The first network connection will be called “Local Area Connection (To DSP)” or similar. If a complete 

system was purchased, the TCP/IP settings will have already been set up at the factory.  

The following table lists the standard Ethernet and IP addresses for the DSP network. 

Table 9: Ethernet and IP Addresses for the DSP Network 

Chassis Address Value 

Computer 

Control Chassis 

(Typical) 

IP Address 192.168.203.220 

Subnet Mask 255.255.255.0 

1st Data Chassis 

(Typical) 

Ethernet Address 2-35-69-86-203-1    

IP Address 192.168.203.1 

Subnet Mask 255.255.255.0 

Default Gateway Leave Blank 

2nd Data Chassis 

(Typical) 

Ethernet Address 2-35-69-86-203-2  

IP Address 192.168.203.2 

Subnet Mask 255.255.255.0 

Default Gateway Leave Blank 

3rd 618 

Controller 

(Typical) 

Ethernet Address N/A 

IP Address 192.168.203.3 

Subnet Mask  255.255.255.0 

Default Gateway Leave Blank 

Note:  The pattern continues for additional Data or 618 chassis. 

Note: The IP addresses and Ethernet addresses can be different depending on customer 
requirements 

The second connection using LAN ENET port will be called “Local Area Connection (To LAN)” or 

similar. Under TCP/IP properties the user can enter their static IP Address, Subnet Mask, and Default 

Gateway to enable the recorder to communicate with the master station program over the corporate 

LAN/WAN. If the LAN ENET is being used for connection to the Process Bus, the ENET port can be 

addressed and used for the LAN connection for communicating with the Master. 
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APP-618 Controller Network Addressing 

Connect the DSP ENET port of the 618 chassis to the DSP network of the rack or 

cabinet.  Connect the LAN ENET port to the SV/PTP source (note that both signals must 

be on the same line).  This will likely be a switch specifically configured for this purpose. 

Connect a monitor and keyboard to the 618 chassis.  Right click on the desktop and select 

‘Open Desktop in Files’.  Select ‘Home’ in the sidebar, then enter the ‘APP-GPU’ folder 

and open up the file named ‘default.cfg’.  In the file, change the RECORDER_IP field to 

match the IP address of the 601 computer and change the UDP_PORT field to the port 

number the chassis should use.  Save and close the file. 

To set the Chassis IP for the DSP Port, right click on the desktop again and select ‘Settings’.  Select 

‘Network’ in the sidebar, then click the gear icon for the adapter named ‘enp1s0’. 

  

Figure 28 APP-618 Edit default.cfg 

Figure 29 APP-618 Network Settings 
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Go to the ‘IPv4’ tab Click Manual for IPv4 Method and change the IP address to the address the chassis is 

to use.  Click apply,  

Figure 30 APP-618 Edit IPv4 TAB config 

Repeat the Settings and IPv4 TAB steps for Enp2s0 which will be the LAN ENET Port connecting to the 

Process Bus. 

Close all windows, then reboot the chassis. 

Note: If PTP is being sent over UDP, the IP of enp2s0 must be on the same subnet as the PTP 
source. 

Repeat this process for each APP-618 chassis in the system. 
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5. Installing the Recorder Software  
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5.1 Introduction 

APP Recorder program must be running for the recorder to be functional. When APP Recorder starts 

properly, and correct recorder settings have been entered the system will go online. 

In most cases, APP Engineering, Inc. will have obtained information from the customer that allowed the 

factory to make the necessary hardware and software settings to your APP-601 Recorder prior to shipment. 

However, in some cases, the information is not available before the system ships, or only partial 

information was available, and it will be necessary for the user to enter information or enter certain settings. 

This chapter will cover program installation and quick start settings and then a detailed description of all 

the menu choices. If your system was ordered with Linux see the Linux Manual for instructions. 

5.2 Program Installation and Quick Start Settings 

Note:  Installation of the APP Recorder Program should not be necessary. It will be installed and 
setup at the factory. The following installation steps are provided in the event a future 
software load is required. 

To Install the Program 

1. Insert the Thumb Drive into a USB Port. 

2. Browse to the APP Recorder.exe file and double click it to start the installation process. 

3. After agreeing to the terms and conditions of the software license allow the wizard to install the 

program in C:\APP Recorder. 

4. Create a folder in the APP Recorder Folder called “Data”, C:\APP Recorder\Data. 

5. Create a folder in the APP Recorder folder called “Setup”, C:\APP Recorder\Setup. 

6. Start the APP Recorder Program by double clicking on the “APPRecorder.exe” file. 

7. After the program starts, click Edit and then Configuration. The window shown in Figure 31 will 

be displayed.  

Figure 31: Recorder Configuration Window 
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8. Enter the system “Recorder ID” and the “Company Name.” Each recorder has a unique Recorder 

ID. This allows the master station program (APP ClearView) to identify which recorder it is 

communicating with.  

*CAUTION*  Do not duplicate Recorder IDs. 

9. Enter the “Data Path” by clicking the browse button and browsing to the Data Folder created in 

step 4. C:\APP Recorder\Data. 

10. Enter the “Setup Path” in the same manner  C:\APP Recorder\Setup 

11. If you want the Data (data means transient records, extended records, and SER information) 

written to a backup folder then place a check mark next to “Backup” and enter the path. 

12. Towards the bottom of the window, you can enter the number of fault record IDs to appear in the 

“FSum” file (fault summary file). The fault summary file is retrieved by the master station 

program, APP ClearView, and displayed in its Fault Summary Table. Settings under the 

“Automatic Tasks” or “Allowed IPs” tab are not required for recorder startup and will be 

discussed in a later section. 

13. Click Save in the upper left-hand corner of the window. The basic configuration is set. 

14. In the APP Recorder window, from the Edit menu, point to Point Assignment Record (PAR), 

and then click Edit Record. If the Edit Point Assignment Record screen does not appear (Figure 

32), and a message that the record does not exist appears, a PAR will need to be established.   If 

the Point Assignment Record was not created by the factory, it may have been created by someone 

in your company. If this is the case, the point assignment file can be copied into the “Setup” folder 

(C:\APP Recorder\Setup). PA Records are established in APP Clearview, if none exists in APP 

Recorder, please see APP Clearview Manual - Managing Point Assignment (PA) Records for 

instructions to create PAR. 

15. Next, the Point Assignment Record must be verified/updated. As mentioned above, the factory 

usually obtains point assignment information from the customer and creates a Point Assignment 

Record/file in advance. 
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16. At the bottom of the Point Assignment window, click the Chassis Config. tab. At the top of the 

page, enter the name of the station or location of the recorder. Next to “#chassis”, enter the total of 

Data chassis. Include aggregate number of 601 Data Chassis and 618 Controllers. 

Figure 32: Point Assignment Window’s Chassis Configuration 

17. For each chassis, enter the type of circuit board inserted into slots 1, 2, 3, 4, 5, 6, 8, 9, 10, and 11. 

For example, if slot-1 contains an analog board then click Place Analog Board then click in the 

Chassis 1/Slot-1 box. An A will appear in the box. An A can also be placed in the box by simply 

selecting the box and typing the letter A. 

 

If slot-1 contains an event board, then click on Place Event Board then click in the Chassis 

1/Slot-1 box. An E will appear in the box. An E can also be placed in the box by simply selecting 

the box  and typing the letter E. 

Note:  Slot-7 is always reserved for the DSP circuit board or GPU for a 618 Controller 
when capturing Sampled Values. Slot-12 is always reserved for the alarm output 
circuit board and slot-13 is always reserved for the chassis power supply board. 

18. Each DSP circuit board and 618 Controller (GPU), one per chassis, is assigned an IP address. The 

IP address must be entered in the “IP Address” column for each chassis/DSP board. The default IP 

address is 192.168.203.X where X is the chassis number such as 1, 2, 3 etc. 

19. If you have 618 Controller chassis for Sampled Values, you will need to follow the PAR setup 

process Configuring IEEE-61850 Sampled Values described in the Clearview Instruction 

Manual Section 6  

20. Towards the upper right-hand portion of the page is a “Chassis #1 Port#.” A port number is 

automatically selected for each chassis. This number can be changed if any conflict arises. 
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21. After the chassis and slot information are entered, the number of Analog Boards, Event Boards, 

Analog Channels, Event Channels, TW channels, SV Streams and SV channels will appear on the 

far right-hand side of the page. 

Click on the tab at the bottom of the page labeled General Settings. The window shown below should 

appear. 

 

Figure 33: Point Assignment Window: General Settings Tab 

22. Default values of 60Hz and a sampling rate of 4800Hz should be shown. 

Note: If you are using APP-618 controllers for Sampled Values, the Transient sampling rate 
must be 4800, otherwise this cause the Timemark not to synch. 

23. With these default settings the system is ready to create transient records only. 

24. From the menu bar, click Save.  

You should see the “APP Recorder Driver” pop-up momentarily and then the system should go 

On-Line. When the system goes online you should hear the On-Line output relay click. If the 

system is not synchronized with a satellite-controlled clock you will hear the “CLK SYNC LOSS” 

relay click after approximately 1½ minutes. 

 

The system is now operational and the complete Point Assignment Record can be downloaded 

from the master station or completed at your convenience. 

5.3 Startup and Running the APP Monitor 

APP Recorder can be set up to automatically start when the computer restarts and using APP Monitor to 

automatically start if APP Recorder is shutdown. When Monitor is running, APP Recorder will restart 

within 60 seconds of being closed. This is important to ensure no manual intervention is required to 

maintain APP Recorder operation.  
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➢ Configuring APP Recorder and APP Monitor 

In the APP Recorder window, from the Tools menu, click Windows Logon & Startup 

the following window appears. 

Figure 34: Windows Logon & Setup Window  

1. In the User box, type the username for the Windows logon of the APP Recorder. 

2. In the Password box and the Confirm Password box, type the password for the Windows logon 

of the APP Recorder.  If no Windows password is set, leave this password blank. 

Note: The username and password must match the Windows account settings. 

3. Do you want the APP Recorder to automatically logon to windows when the computer starts? 

If yes, then select the Auto Logon check box. 

If no, then skip to the next step. 

4. Do you want the APP Monitor to automatically start when you run the APP Recorder? 

If yes, then select the APP Monitor check box. 

If no, then skip to the next step. 

Note: If APP Monitor is shut down using Task Manager for example, when APP 
Recorder is started, APP Monitor will NOT automatically start. The best way to 
ensure APP monitor is re-initiated properly is to restart the computer (Windows 
Restart). This will cause APP Monitor to start if the APP Monitor option was 
selected. 

5. Do you want the SpeedFan to automatically start when you run the APP Recorder as an 

application? 

Note: Speedfan is required for the PC Health Alarm to function due to CPU 
Temperature and is required for monitoring. 

If yes, then select the Speedfan check box. 

If no, then skip to the next step. 
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6. Do you want the HDSentinel to automatically start when you run the APP Recorder as an 

application? 

Note: HDSentinal is required for the PC Health Alarm to function due to Hard Drive 
Temperature and is required for monitoring Drives with a RAID drive 
configuration. 

If yes, then select the HDSentinel check box. 

If no, then skip to the next step. 

7. Click OK. 

8. Shutdown and restart Windows 

9. Ensure APP Recorder automatically starts when Windows comes back up
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6. IEC 61850 GOOSE Capture 
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6.1 Overview 

APP Engineering has enabled APP Recorder to capture messages from Intelligent Electrical Devices (IED) 

in a substation via the Process Bus using Generic Object Oriented Substation Event (GOOSE) Protocol as 

defined in IEC 61850. This enables APP Recorder to aggregate status data from devices not connected to 

an APP Recorder with data from devices connected to an APP Recorder. 

APP 601 Recorder captures relevant messages from configured IEDs and can write them to the Sequence 

of Event Report (SER) file. Change in State conditions can also.be used to trigger the DFR to record. 

There are two programs required to configure and run GOOSE Capture. The first is WinPCap 4.3.1 which 

is the driver enabling GOOSECap to retrieve messages from the Process Bus. GOOSECap is the 

application that allows the user to subscribe to GOOSE messages in the substation. 

Status (GOOSE) messages are sent from IEDs regularly regardless of the State of a device. GOOSE 

Capture captures messages that indicate a change of state from IEDs that match GOOSE Points configured 

in GOOSECap. The configuration of GOOSE Devices and GOOSE Point are stored in the GOOSE Point 

Assignment Record or Rxx.gpar file. 

Note: The messages received in the SER are low resolution and will not arrive at the same rate 
as Event Channel records.  

The following instructions will guide you through installation and setup of the software needed to run 

GOOSE Capture as part of APP Recorder. This section provides basic information to complete setup and 

assumes the APP Recorder has been delivered with all the APP Recorder software loaded and file structure 

established.  

Note: This manual assumes the user is familiar with GOOSE capture architecture and 
capabilities and knows the identifiers required from connected IEDs from which 
messages will be collected. 

What will typically need to be done at this point is to download WinPcap_4_3_1 application software to the 

APP Recorder directory on the APP Recorder Computer. 

6.2 Downloading WinPCap applications 

A company will receive WinPCap application files directly from APP Engineering. You can then download 

these files to the APP Recorder computer in the APP Recorder master directory. With APP software 

version 3.3.6 or after, you will have the WinPcap installer included and ready for installation. 

C:\APP Recorder 

6.3 Install WinPcap 

You will need to install WinPcap to receive packets from the Process Bus. 

WinPCap 4.1.3 provided by Riverbed Technology is the API that allows Windows applications to capture 

and transmit packets on a network.  

1. To install WinPcap double click on WinPcap_4_1_3 executable file. 

2. When asked, click OK to allow WinPcap to make changes to the computer 

3. Click Agree when asked if you agree to the License Terms 
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4. Be sure the Automatically start the WinPcap driver at boot time check box is clicked 

5. Then click Install 

6. Reboot the computer 

6.4 Activating GOOSE Capture in APP Recorder 

To run GOOSE Capture you check the GOOSE Capture checkbox in the APP Recorder Point Assignment 

record General Settings TAB/Recorder Setup TAB. 

In APP Recorder main screen  

1. Click Edit, hover over Point Assignment Record then click Edit 

2. Click the General Settings TAB at the bottom of the window 

3. The Recorder Setup window should appear 

Figure 36 Edit PA Record - GOOSE Capture check box 

4. Click GOOSE Capture check box 

5. Click Save 

Figure 35 WinPCap Setup - Restart at Boot 
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6. The Recorder will reinitialize, and GOOSE Capture software will begin to run. 

Once it is activated the GOOSE program will run automatically. 

To stop/disable GOOSECap from running permanently, you will need to uncheck GOOSE Capture check 

box in the PA record. 

See APP Clearview User Manual for more information on Editing the PA Record.  

Note: GOOSE Capture will not start capturing messages until it is configured, and capture 
started. See the following sections for configuration and startup instructions. 

6.5 Configuring GOOSECap 

The user must set up GOOSE Capture to identify the GOOSE Devices from which messages are to be 

captured and received by the APP Recorder. The following steps describe how to add and edit GOOSE 

Devices and GOOSE Points and define the type of messages to be captured and saved. 

You can also create, and/or update GOOSE Devices and GOOSE Points using the APP Translator and 

then edit GOOSE Points to complete the settings. This section only discusses the manual configuration 

process. The Translator is discussed in Section 7.9 APP Translator. 

From the main screen, select the APP Recorder Ethernet port being used, usually LAN ENET. This Port 

should be connected to the LAN network where the GOOSE Messages can be monitored.  

 

 

6.5.1 Edit GOOSE Points 

GOOSE Points define the components from which you want GOOSE Messages to be captured and saved. 

This is similar in concept to defining the Point Assignment Record in APP Recorder. 

Figure 37 GOOSECap setup - Select Network Port 
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Click the Edit menu and select Edit GOOSE Points. 

The Device Screen will appear. If no devices have been defined, the screen will be blank. 

Begin filling in the form by entering information about the device. The fields must match the identifiers of 

the connected device from which messages will be captured. The Identifiers are case sensitive. 

Enter: 

• Device Name 

• Control Block Reference 

• GOOSE ID 

• Data Set Reference 

• Number of Data Set Entries 

Note: The identifiers are case sensitive and must match the field entries. 

  

Figure 38 GOOSECap Setup - Edit GOOSE Points 
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Enter a number or use the up and down arrows to set the Number of Data Set Entries associated with this 

device. This will create blank fields below where you describe the GOOSE Entries and Status type to be 

captured.  

Start by selecting the Data Attribute to the right of the GOOSE entry line 

Data Attribute Type - select from the options: 

• Status Value 

• Quality 

• Timestamp 

As of this writing, only Status Value is being captured and must be selected before the other parameters 

can be entered. 

G# or GOOSE number will be filled in automatically when the device information has been entered. This 

represents the point being captured. 

Normal State – Select the Normal State (Closed or Open) Closed is the default value. 

DFR Start and SER Run – Logging to SER and Triggering the Recorder  

You can set up a GOOSE Point to log to the Sequence of Events Report (SER) by setting SER Run and 

you can trigger the DFR by setting the DFR Start options, like setting up the Event Channels in the APP 

Recorder Point Assignment Record. 

Note: As of this writing, only Status Value Data Attribute is being monitored. GOOSE TAG 
does not apply to any other Data Attribute, and therefore TAGs won’t be selectable. 

Figure 39 GOOSECap setup - GOOSE Point Form 
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DFR Start – Click the down arrow to show the start options to control if or when the DFR starts recording 

based on a State Change. Select the desired option using Table 10 GOOSECap DFR Start Options on 

Page 6-9 describing each option as a reference.  

Ser Run – Click the down arrow to show the SER Run options to control logging to the SER report and 

whether to Alarm or not. Select the desired option using Table 11 GOOSECap SER Run Options on 

Page 6-9 describing each option as a reference.   

TAG – You do not enter this field. This field will display the TAG letters based on your DFR and SER 

selections. See Table 12 GOOSECap TAG Reference on Page 6-10. 

GOOSE Entry Description - Enter the GOOSE Description. This field is free form for the user to identify 

the component. 

Figure 40 GOOSE Points – DFR Start TAG Entries 

Figure 41 SER Run TAG Entry 
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Editing Multiple GOOSE Points 

To make editing more efficient, you can edit multiple GOOSE Points at the same time. To select multiple 

GOOSE Points, first click on the starting GOOSE point, then click on the ending GOOSE point while 

holding the “Shift” key. You can also add/remove single points into/from the selection by clicking on the 

GOOSE points while holding the “Ctrl” key. Use the editing menu right above the GOOSE Point table to 

edit the selected points.  

GOOSE Points right click menu 

You can also edit each point or multiple points at once using a menu of the parameters to enter as well as 

an Undo and Redo option to make editing more efficient.  After selecting the row or multiple rows at once, 

right click on the edit GOOSE Points screen and the parameters list will appear. You can click on 

parameters to see a selection drop down of the options for the parameter. Or as described above, you can 

use the edit fields above the GOOSE Points list.  

Figure 42 Edit GOOSE Points right click menu 

Additional functions include: 

Show/Hide Entry Number – This provides a sequence number appearing to the left of each point as a 

reference. 

Edit Row(s) - allows you to insert and delete entry rows. 

*Caution*: The GOOSE Points of a GOOSE Device must exactly match those in the 
received GOOSE Message. 
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Figure 43 GOOSE Points Right Click Menu Edit – Edit Row(s) 

When GOOSE TAGs are created, the GOOSE Tag will be added to the beginning of a GOOSE 
Description as a 4-character string starts with '<', ends with '>', and includes 2 characters inside. 
Such as "<cc>" 
The first Character is for "DFR Start" to trigger the DFR to Record on a change of state. 
Normal, and Abnormal State are decoded by GOOSECap from the GOOSE messages. 
Note: When the DFR is triggered and a Fault record is created, the files are in COMTRADE 

Format.  
Note: When describing the TAG behavior below “In COMTRADE”, this means the channel will be 

included in any fault record that occurs regardless of what triggered the DFR. 

Table 10 GOOSECap DFR Start Options 

Tag Normal State DFR Start Goose Point Behavior 
x Open NA (default) Not in COMTRADE and no trigger. (lower case 'x')  
a Open up In COMTRADE, trigger DFR when voltage up/abnormal.  
n Open down In COMTRADE, trigger DFR when voltage down/normal.  
b Open both In COMTRADE, trigger DFR when voltage up/abnormal 

or down/normal.  
i Open inhibited In COMTRADE but won’t trigger DFR.  
X Close NA Not in COMTRADE and no trigger. (upper case 'X')  
N Close up In COMTRADE, trigger DFR when voltage up/normal.  
A Close down In COMTRADE, trigger DFR when voltage 

down/abnormal.  
B Close both In COMTRADE, trigger DFR when voltage up/normal or 

down/abnormal.  
I Close inhibited In COMTRADE but won’t trigger DFR.  

The Second Character is for "SER Run" to log to the Sequence of Events Report or not and 
controls whether to Alarm or not:  
Table 11 GOOSECap SER Run Options 

Tag SER Run GOOSE Point Behavior 

x NA (default) Not in SER report and no alarm 

R Run In SER report and no alarm 

A Alarm In SER report and turn on alarm 

P Perpetual 
In SER report and alarm until alarm condition is resolved instead of the 
standard 10 Second alarm duration. 
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Note:  
1. <xx> translate to NA, NA, which is replaced with no tag. 
2. 'x' is lower case. 

GOOSE Tag Dictionary: 

Table 12 GOOSECap TAG Reference 

Tag Normal State DFR Start SER Run 
<xX>  Open NA NA 
<xR>  Open NA Run 
<xA>  Open NA Alarm 
<xP>  Open NA Perpetual 
<aX>  Open up NA 
<aR>  Open up Run 
<aA>  Open up Alarm 
<aP>  Open up Perpetual 
<nX>  Open down NA 
<nR>  Open down Run 
<nA>  Open down Alarm 
<nP>  Open down Perpetual 
<bX>  Open both NA 
<bR>  Open both Run 
<bA>  Open both Alarm 
<bP>  Open both Perpetual 
<iX>  Open inhibited NA 
<iR>  Open inhibited Run 
<iA>  Open inhibited Alarm 
<iP>  Open inhibited Perpetual 
No tag  Close NA NA 
<XR>  Close NA Run 
<XA>  Close NA Alarm 
<XP>  Close NA Perpetual 
<AX>  Close down NA 
<AR>  Close down Run 
<AA>  Close down Alarm 
<AP>  Close down Perpetual 
<NX>  Close up NA 
<NR>  Close up Run 
<NA>  Close up Alarm 
<NP>  Close up Perpetual 
<BX>  Close both NA 
<BR>  Close both Run 
<BA>  Close both Alarm 
<BP>  Close both Perpetual 
<IX>  Close inhibited NA 
<IR>  Close inhibited Run 
<IA>  Close inhibited Alarm 
<IP>  Close inhibited Perpetual 
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Once you have entered all the components associated with the device you can save the GOOSE Point 

record by clicking Save at the top of the window. You can add more devices or edit devices by selecting 

another existing device in the Device Selection list. 

6.5.2 Adding Additional Devices 

To add devices, click the Device menu and select Add Device. A blank entry screen will appear, and a new 

Device TAB will appear at the bottom of the window. 

Duplicate Device - to simplify and reduce entries use Duplicate Device. Click Device and select 

Duplicate Device then modify entry as needed.  

Figure 44 GOOSECap Setup - Adding and Duplicating Devices 

Then follow the Edit GOOSE Points process described above.  

6.5.3 Remove a Device 

To Remove a Device, click the Device Menu and select Remove Device. This will remove the current 

selected device TAB shown at the bottom of the GOOSE Point window. 

Note: If you mistakenly remove a Device, you can retain the old information by Canceling all updates 

since the last Save. See the next section below. 

6.5.4 Saving GOOSE Point Record or Cancel 

Once you have defined or updated GOOSE Point devices, you need to save the record. Click Save.  

To retain the record before changes, click Cancel. 

When you save the GOOSE Point Record, it is saved in the recorder setup folder using the recorder 

ID in this format: 

C://APP Recorder/setup/Rxx.gpar where xx is the recorder ID. 

A backup file is also automatically saved: 

C://APP Recorder/setup/Rxx.gpar.bak where xx is the recorder ID. 
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The backup file is updated when the .gpar file is saved and holds the most recent previous version of 

the .gpar. 

6.6 Clear Status Log 

If you would like to clear the upper GOOSE Status message window of all status messages, you can by: 

Clicking the Edit menu and select Clear Status Log. 

6.7 Clear Capture Log 

If you would like to clear the lower GOOSE Capture Log message window of all capture messages, you 

can by: 

Clicking the Edit menu and select Clear Capture Log. 
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6.7.1 Options Menu 

Record Initial Frame is a debugging tool which will cause GOOSE Capture to record the initial status 

message from the EIDs being monitored at startup of GOOSE Capture. Under normal circumstances 

GOOSE Capture will capture a change in state only. When trouble shooting it may be helpful to include the 

initial status.  

 Figure 45 GOOSECap Record Initial Status option 

To Record Initial Frame, click on the options menu then click Record Initial Frame. A check mark will 

appear next to the item to show it is active. 

To stop recording the Initial Frame, click the option menu then click the Record Initial Frame to turn off 

the check mark. 

Log Frame Info when selected, shows a log of the GOOSE messages showing a change of state in the 

lower window of the GOSE main screen when the Capture Log TAB is selected. To turn off Log Frame 

Info, click the Options menu and uncheck the Log Frame Info option. The default is unchecked. 

Set Checking Interval sets how often to check GOOSE Device status in seconds. This only affects the 

refresh rate of device status and does not affect GOOSE message capture. 

When you click Set Checking Interval, a window appears allowing input of the number of seconds 1-60. 

When done click Save. 
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6.7.2 File Menu 

The File menu provides two selections. 

Reinitialize – is used to restart GOOSECap to capture changes in configuration or general restart if needed. 

Close – is to close the GOOSECap program. GOOSECap will restart automatically. See Section 6.9.3 

Closing GOOSE Capture program. 

 

Figure 46 GOOSECap File Menu 

For further assistance please call APP Engineering at (317) 536-5300 

6.8 Running GOOSE Capture 

This section provides instructions for running the GOOSECap software in conjunction with APP Recorder. 

Once the GOOSE Point Record has been created and saved, GOOSECap is ready to begin monitoring and 

capturing GOOSE messages. GOOSECap can be controlled with the Start and Stop button. The following 

describes how to Start and Stop GOOSECap and how to observe the log and messages. 

Note: If a network device is selected, whenever APP Recorder and GOOSE Capture starts, 
GOOSE will be running automatically when it begins. 
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6.9 Operating GOOSE Capture 

6.9.1 Running GOOSE 

Click the GOOSE icon in the Task Bar at the bottom of the screen to return to the main GOOSE 

Capture screen, you will see a window like the figure below. If the Network device is not selected, click the 

down arrow, and select the network port connected to the network where the devices to monitor are 

connected. Usually LAN ENET port.  

Figure 47 Select Network Device 

When the network device is selected, then click the Start button. The “Running” indicator will appear at 

the bottom of the window. See figure below. 

If you do not click Start, the network device selected will not be saved. Once you click Start the network 

device selected is saved and whenever GOOSE Capture restarts it will automatically start running with the 

network device last selected even if you previously had stopped GOOSECap by clicking the Stop button.  

If you do not want GOOSE Capture to automatically start, select the “Select a Device” option effectively 

unselecting a device. 
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6.9.2 Stopping GOOSE Capture 

While GOOSE Capture is running, click the Stop. 

Click Yes when the warning appears indicating recording will be stopped. 

If you want to ensure GOOSECap does not start running if there is a restart of GOOSECap, be sure to 

unselect the Network Device by using the network device drop down and select “Select a device” option. 

Figure 49 Unselect GOOSE Network Device 

6.9.3 Closing GOOSE Capture program 

GOOSECap will automatically restart if closed. 

To disable and stop the GOOSECap program from running, you must update the Point Assignment Record 

and uncheck the GOOSE Capture check box, see Section 6.4 Activating GOOSE Capture in APP 

Recorder. 

6.9.4 Viewing GOOSE Capture status and messages 

This section describes where to view the GOOSECap software log, captured and saved messages, and 

GOOSE Capture Status. The next three sections are a breakdown of the GOOSE Capture main window. 

6.9.5 GOOSE Capture operating Log 

The upper window provides a log readout for GOOSE Capture showing step-by-step activity of the 

software itself. 

Figure 50 GOOSECap software Log 

Figure 48 Confirm Stop GOOSE Capture 
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6.9.6 GOOSE Message Capture log 

The second section in the window shows the status messages captured under the Capture TAB. These are 

written to the .GSER file and then APP Recorder writes them to the APP Recorder SER file.  

6.9.7 GOOSE Device Status 

In the second section under the Device Status TAB shows the status of the devices (Running or Stopped).  

Figure 52 GOOSE Device Status 

6.9.8 GOOSE Capture Status Line 

The Status line appears at the bottom of the GOOSE Capture window.  

The indicators are: 

Running/Stopped – Indicates if GOOSE Capture is monitoring the Process Bus or is Stopped 

Also when running, an asterisk will flash next to the Running indicator to indicate it is still running 

Figure 53 GOOSE Capture - Status Line 

Figure 51 GOOSE Message Capture Log 
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6.9.9 Viewing GOOSE Messages in APP Recorder 

As described earlier, The GOOSE Messages are captured and can be written by APP Recorder the SER file 

if configured to in the gpar file. You can then view the SER report in the APP Recorder and APP 

Clearview. 

The Sequence of Event Report includes the following information: 

Date and time of the event 

GOOSE ID = Gx where x is the id 

State - is not used 

Normal - is defined as (A = Abnormal= Closed, N = Normal= Open) 

Sync - is not used  

User-defined GOOSE Entry Description as entered in the GOOSE Points Record.  

6.9.10 APP Recorder SER view 

From the main APP Recorder screen, select the SER Report Tab.  

Figure 54 View events via GOOSE Capture in APP Recorder 

6.9.11 GOOSE Trace file 

You can view a GOOSE Trace file for troubleshooting by using File Explorer to navigate to the c:\\APP 

Recorder\Setup folder and look for the GTrace01.wri file. 

.
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7.Using the APP Recorder 
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7.1 Introduction 

The APP Recorder Program must be running for the APP Recorder hardware to operate. The APP Recorder 

Program contains information and settings that contribute to the Recorder’s versatile, user-friendly, state-

of-the-art functionality. 

7.2 APP Recorder Program Functions 

The APP Recorder Program carries out the following major functions: 

Receives transient and extended data from the DSP circuit boards and 618 Controllers and stores the data in 

path location C:\APP Recorder\Data. Before storing the transient and extended data in this directory, the 

program automatically converts the files to the COMTRADE C37.111 – 2013 format. If the extended 

recording feature is enabled in the Point Assignment Record (General Settings tab: Sampling tab), the 

APP Recorder program creates the following three records each time the recorder trips: 

▪ Transient oscillography 

▪ Extended oscillography 

▪ Extended RMS 

Note: The APP Recorder program automatically names the transient and extended 
records as per the IEEE C37.232-2007 COMNAMES requirement. 

Receives continuous streaming data from the DSP circuit boards and writes that data in path location of 

C:\APP Recorder\Data\OsclgrData. This data is used when the analysis software is requesting a time 

slice of continuous oscillography information. 

From the continuous streaming data, the APP Recorder Program calculates the following quantities and 

writes that information to the path indicated: 

     Continuous RMS Data …………..… C:\APP Recorder\Data\RMSData 

     Continuous Frequency Data………... C:\APP Recorder\Data\FreqData 

       Continuous Phase Data………………C:\APP recorder\Data\PhaseData 

Receives Sequence of Event Records from the DSP circuit boards and writes that information in the path 

location C:\APP Recorder\Data\SerData. 

Displays near real-time analog RMS values, frequency, phase, event status, trigger status, and sequence of 

event log on its main window. 

Displays real time analog channel oscillograms via its OScope feature. 

Coordinates communication with the master station program, APP ClearView, via Ethernet or modem. 

Outputs DNP-3 analog RMS values and event status via RS-232 or Ethernet. 

Outputs PMU information via Ethernet. 
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7.3 The APP Recorder Program Main Window 

When you start the APP Recorder program, the APP Recorder window automatically appears. 

The following figure illustrates the sections of the APP Recorder window. 

Figure 55: APP Recorder Program Main Window 

The Setup area displays the major parameters that are set up or selected from the menu choices.  

The Message window displays information related to program startup, program re-initialization, 

information sent to the APP Recorder Driver, and error messages. In addition, it can display messages sent 

during a chat session with someone at the master station.  

The near Real-time Metering section provides a quick look at RMS values for all the analog channels, 

event status, trigger status, and the sequence of event logs. You can use the tabs in this section to view 

different types of information. 

Analog Tab 

Figure 56: Analog Tab 
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This tab appears only if there are analog channels configured in the Point Assignment Record and if 

continuous recording is turned on. If the Analog Secondary check box is not selected (this is the default 

setting), this tab shows primary values. If the Analog Secondary check box is selected, then the tab shows 

secondary values. The data will update continuously for an interval of about 10 to 15 seconds. 

Export Analog Tab Meter to a CSV file 

You can export the Meter to a CSV file. Right click meter screen and a pop-up will appear.  

Figure 57 Export Analog Meter screen 

Click export and a file will be saved in the /APP Recorder/Data/folder with the filename format of 

YYYYMMDDHHMMSSSSSSSSSS-AnalogMeters.csv. 

Change Phase Reference Channel… 

You can change the Phase reference channel from the Analog TAB by right clicking and selecting Change 

Phase Reference Channel. The Phase Reference window will appear. Enter the channel and click OK. 

 

Triggers Tab 

Figure 58: Triggers Tab 

The Triggers tab appears if there are Analog channels, however, unlike the Analog Channel tab, this tab 

does not require continuous recording to be turned on. The Triggers tab shows the value of the processed 

trigger value in the DSP(s). It is a useful troubleshooting tool. 
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Export Trigger Tab Meter to a CSV file 

You can export the Meter to a CSV file. Right click the meter screen and a pop-up will appear.  

Figure 59 Export Trigger s Tab to a .csv file 

Click export and a file will be saved in the /APP Recorder/Data/folder with the filename format of 

YYYYMMDDHHMMSSSSSSSSSS-TriggerMeters.csv. 

 

Events/SER Tab  

Figure 60: Events/SER Tab 

The Events/SER tab shows the configuration of the event/SER. If you highlight any of the row(s) and then 

right click, a pop-up menu will display the options, Run SER and Stop SER. You can run or stop a 

particular event channel SER without re-initializing the APP Recorder. 

Export Events/SER Tab Meter to a CSV file 

You can export the Meter to a CSV file. Right click meter screen and a pop-up will appear. 

Figure 61 Events/SER Tab export 

Click export and a file will be saved in the /APP Recorder/Data/folder with the filename format of 

YYYYMMDDHHMMSSSSSSSSSS-EvMeters.csv. 
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GOOSE Report TAB 

The GOOSE TAB shows the GOOSE streams configured and the status/State for Single Point and Double 

Point (DPS). 

Figure 62 GOOSE TAB 

You can view a description of the TAG characters from the GOOSE TAB, click the Show GOOSE TAG 

Table button. 

SER Report Tab 

Figure 63: SER Report Tab 

The SER Report tab displays channels that are in a stopped or abnormal state. These will include channels 

reporting via GOOSE Capture. The following table explains the letters that appear on this tab. 
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Table 13: Values on the SER Report Tab 

In this column… This letter… Means this… 

State O There is an open contact. 

C There is a closed contact. 

Normal A The channel is currently in an abnormal state. 

N The channel is currently in a normal state. 

Sync  U There is an unsynchronized time. 

S There is a synchronized time. 

If an SER channel is stopped, the word “Stopped” appears at the beginning of the channel description. The 

letter “M” or “A” also appears with the stop message: 

▪ “M” indicates that the channel has been stopped manually via the Point Assignment Record. 

▪ “A” indicates that the channel stopped automatically.  

The Sequence of Event Report includes the following information for GOOSE messages: 

Date and time of the event 

GOOSE ID = Gx where x is the id 

State - is not used 

Normal - is defined as (A = Abnormal= Closed, N = Normal= Open) 

Sync - is not used 

User-defined GOOSE Entry Description as entered in the GOOSE Points Record.  

Note:  If an SER channel frequently changes its state, you can configure the Point 
Assignment Record to automatically address the issue. On the General Settings 
tab in the Point Assignment Record, you can specify the threshold of time for 
allowable state changes (in other words, the acceptable amount of time between 
state changes). If the SER channel changes its state more frequently than the 
acceptable amount, you can configure it to automatically shut down and then to 
restart itself after the period of time you define.  

Alarms Tab 

Figure 64: Alarms Report Tab 
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The Alarms Report tab displays the present state of all Alarms regardless of Alarm mapping defined in the 

Point Assignment Record/General Settings/Recorder Setup Tab. A state of 0 is not asserted (relay coil de-

energized) and a state of 1 is asserted (relay coil energized).   

The alarm board contains (8) relay outputs. A selection of alarms can be mapped to the relay outputs. More 

than one alarm can be mapped to a relay. 

Each relay uses an on-board jumper that will allow the contact to be either normally open or normally 

closed. The board is labeled for easy jumper placement. 

For more information see Section 4.6.4 Alarm Circuit Board 

Export Alarm Tab Meter to a CSV file 

You can export the Meter to a CSV file. Right click meter screen and a pop-up will appear. 

Figure 65 Alarm TAB Export 

Click export and a file will be saved in the /APP Recorder/Data/folder with the filename format of 

YYYYMMDDHHMMSSSSSSSSSS-AlarmMeters.csv. 

Fault Location Tab 

Figure 66: Fault Location Tab 

This tab shows the fault location if any fault exists. Most of the time it will be empty since faults don’t 

occur often. 

  



Using the APP Recorder 7-9 

PMU Tab 

The PMU Tab shows Frequency, Power and Reactive Power for any lines configured to send PMU data.  

7.4 Setting the Administrator Password 

You can optionally set an administrator password to restrict access to administrative features.  If you set an 

administrator password, then only the people who know the password will be able to perform the following 

functions: 

Changing passwords 

Configuring the APP Recorder software 

Modifying the Point Assignment Record 

Modifying the Line Group Record 

Exiting the APP Recorder software 

➢ To Set an Administrator Password 

1. From the File menu, select Administrator. 

2. From the File menu, click Change Administrator Password.  

A Change Administrator Password box appears. 

3. Enter the desired password and click OK.  

The Change Administrator Password box reappears. 

4. Re-type your new password and click OK. 

The password is now set. 

Note: If the Password box does not appear when you select an administrative feature, then 
you have not set an administrative password. 
 
Also, if a check mark does not appear next to the Administrator menu item, and there is 
an administrative password, then the Change Administrator Password option will not 
appear on the File menu. 

7.5 Printing 

There are several types of information you can print from the APP Recorder: 

Message window contents 

Recent Fault Summary Report 

Recent Fault Summary Report with Graph 

  

Figure 67 PMU TAB 
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7.5.1 Selecting and Configuring the Printer  

Before you print, select, and configure the printer that you want to use. 

➢ To Select and Configure the Printer 

1. From the File menu, select Printer Setup. 

The standard Windows Print Setup dialog box appears. 

2. From the Name list, select the printer that you want to use. 

3. Complete the other fields in this dialog box and then click OK. 

7.5.2 Printing the Contents of the Message Window  

➢ To Print the Contents of the Message Window 

In the APP Recorder window, from the File menu, click Print Message Window. 

The contents of the Message window are immediately sent to the printer you selected in the 

procedure, Selecting and Configuring the Printer. 

7.5.3 Printing the Recent Fault Summary 

You can preview or print a fault summary report for the last recorded fault. If the APP Recorder Program is 

stopped, and restarted, this function will not work until a new fault record is generated: it does not read 

prior fault records. 

 

To Print the Recent Fault Summary 

In the APP Recorder window, from the File menu, click Print Recent Fault Summary. 

The report is sent immediately sent to the printer you selected in the procedure, Selecting and 

Configuring the Printer. 

7.5.4 Printing the Recent Fault Summary with a Graph 

You can preview or print a fault summary report that includes both analog and event graphs. You can 

specify parameters including the Y-scale, print channels, print range, channels per page, and event channel 

formatting. 

To Print the Recent Fault Summary with a Graph 

1. In the APP Recorder window, from the File menu, click Print Recent Fault Summary + 

Graph. 

A window appears in which you can specify report configuration parameters. 

2. Specify the report configuration parameters and then click OK.  

The report is sent immediately sent to the printer you selected in the procedure, Selecting and 

Configuring the Printer. 

7.6 Exiting the APP Recorder 

You can exit the APP Recorder for maintenance or troubleshooting purposes. When you exit the APP 

Recorder, the APP Driver automatically exited as well. 

If you have set an administrator password, then you must enter the password before exiting the APP 

Recorder. See Setting the Administrator Password for more information. 
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*CAUTION*  Stopping the APP Recorder Program takes the APP Recorder 
OFFLINE. No recording will be performed while the APP Recorder 
Program is stopped. 

Note: If the APP Monitor check box is checked in Tools/Windows logon and startup, APP 
Recorder will automatically restart itself in no more than 60 seconds. 

➢ To avoid auto restart, do the following prior to exiting 

1. Go to Windows Task Manager by pressing CNTL-ALT-DEL 

2. Click Start Task Manager 

3. In the Processes Tab, single click (Select)APP Monitor 

4. Click End Process 

➢ To Exit the APP Recorder Program 

1. From the APP Recorder window File menu, click Exit. 

2. Has an administrator password been set?  

a) If yes, then a message box appears. Enter the password and click OK. The program is 

stopped immediately. 

b) If no, then the program is stopped immediately. 

 

➢ To restart APP Recorder with APP Monitor activated  

1. Restart Computer (Windows Restart) 

2. APP Recorder and APP Monitor will start automatically if APP Monitor was selected in the 

Tools/Windows logon & Startup previously. 

7.7 Configuring the APP Recorder 

7.7.1 Factory Settings 

Some minimum configuration parameters must be set up for the APP-601 Recorder to operate. For 

example, it must know where to place the recorded data and where to find point assignment information. 

Before the recorder leaves the factory its “must have parameters” are already entered. You should not have 

to make changes to those settings.  

Note: You should not alter the Recorder ID, Data Path, or the Setup Path without 
thoroughly understanding how the APP Recorder runs. Incorrectly changing these 
values can prevent the APP Recorder from running. 

• The Recorder ID is needed for the recorder to read and save configuration and data 
files such as the Point Assignment Record, Line Group Record, COMTRADE data 
files, and so on. 

• The Data Path has reserved memory in it.  

• The Setup Path has all the configuration information. 
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7.7.2 Types of Configuration Settings 

You can configure the following types of settings for the APP Recorder: 

• Main configuration settings 

• Automatic tasks 

• Allowed IPs 

7.7.3 Configuring the Main Configuration Settings 

Main configuration settings are integral to the basic functioning of the APP Recorder.  

APP Computer Chassis Data Storage Architecture: 

The APP 601 standard configuration, the computer chassis storage setup is C:\ drive with RAID 1 + hot 

spare. Two 1TB SSD are in RAID 1 configuration with the 3rd 1TB SSD acting as a hot spare. The RAID 

drives will contain both the operating system and the Setup and Data folders for the Recorder program.  

Note: If you want to use the C: drive/Flash for storing fault records, please consult APP 
Engineering Inc. before configuring APP 601 Computer. 

The APP 501 Computer Chassis includes a single conventional hard drive for storing the OS and 

configuration files as well as the fault records. Remember you received a complete backup hard drive with 

the original factory settings along with your computer chassis. 

 

➢ To Change Main Configuration Settings 

1. In the APP Recorder window, from the Edit menu, click Recorder Config. 

The Recorder Configuration window appears. By default, the Main tab is selected. 

 

Figure 68: Example of APP 601 Recorder Configuration Window - Main Tab 

2.  (Required) Recorder ID field, specify a unique recorder ID. This allows the master station 

program (APP ClearView) to identify the recorder with which it is communicating. 
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*CAUTION*  Do not use duplicate Recorder IDs.  
Before shipping the Recorders, APP Engineering Inc. will assign 
Recorder IDs and configure each of your Recorders accordingly. 
Recorders will be numbered sequentially. 

3. Company Name field, enter any name you would like. This name will appear at the top of the 

APP Recorder Program main page. At the factory, the name of the company who purchased the 

system is entered. 

4. (Required) Data Path field, click  and enter the location of the physical file where transient 

and extended recording information will be written. By default, the factory creates the path: 

C:\APP Recorder\Data  

You can change this value to any other path you want. However, you should not change the 

path without understanding how the APP Recorder runs. Incorrectly changing the path can 

prevent the APP Recorder from running. 

5. Transient and extended recording information can be written to more than one path. To create a 

second location, next Backup click  and enter the desired path. 

6. Flash: Using Flash has a very limited application. If you would like to use Flash for Data, please 

consult APP Engineering Inc., before setting up the use of Flash. 

7.  (Required) Next to the Setup Path box, click the  to specify the location of files such as the 

Point Assignment Record, calibration factors, Line Group Record, trace files, and diagnostic 

record. By default, the factory creates the path C:\APP Recorder\Setup. You can change this 

value to any other path you want. However, you should not change the path without understanding 

how the APP Recorder runs. Incorrectly changing the path can prevent the APP Recorder from 

running. 

8. In the Max #Faults in FSum: box, specify the number of Fault record IDs included in the Fault 

Summary upload to the master station (i.e. remote APP ClearView), when a Fault Summary file is 

created. The larger the number, the longer it takes to get the summary file. Typically, a reasonable 

number for this “fast” retrievable file is between 50 and 500. 

Note: The APP Recorder Program AND APP Clearview Program should be configured to share 
the same Data folder (i.e. C:\APP Recorder\Data). All Fault records are available to APP 
Clearview with this configuration. 

9. After normal communication has been established between the APP ClearView and the APP 

Recorder programs, the ideal disconnect situation is for someone at the master station or someone 

at the APP Recorder to initiate a disconnect or hang up command. When this is done, both 

programs are aware of the disconnect request and can properly close down communications.  

 

However, it is possible for a communication path to be cut without notice. This results in neither 

program receiving notice of disconnect. Therefore, a hang up timer is needed to ensure that both 

programs receive an automatic command to release the communications link.  

 

The default hang up timer for both the APP Recorder and APP ClearView programs is 10 minutes. 

However, the APP Recorder hang up timer has a delay that makes its effective default time 10 

minutes and 30 seconds. Therefore, in the case of no communications activity, the APP ClearView 

program will be the first to initiate a hang up action. 
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Do you want to make the APP Recorder the first program to initiate a hang up action in the event 

of an unexpected disconnect? 

If yes, then in the Hang up if connection to ClearView has been idle for X minutes 

box, type a value less than 10 minutes. 

If no, skip to the next step. 

10. Have you already set up dial-up networking for the APP Recorder?  

If yes, then select the Dial-up Networking has been set up check box. See Setting Up 

Dial-up Networking for instructions on setting up dial-up networking. 

If no, skip to the next step. 

11. If you want Point Assignment Record and Line Group Record saved with Transient Record, click 

the check box: Save .par and .lgp with Transient Record. 

12.  If you want the Transient Alarm triggered during a Test Run, click the check box: Turn 

Transient Alarm on during Test Run.  

Note: The Transient Alarm has to be mapped in the Point Assignment, General Settings Tab for 
the alarm to be turned on. 

13. From the menu bar, click Save. 

7.7.4 Setting Up Dial-up Networking 

Windows10 

Dial-up Networking using Windows 10, is supported on a case-by-case basis. To set up Dial-up networking 

with Windows 10 or above, please contact APP Engineering support at (317) 536-5300. If Windows 10 is 

running Dial-Up Networking will be set to Off and unable to be turned ON. 

DialNet is for users who want to use Remote Desktop or a similar program to access the recorder using the 

same phone line as the recorder.  

To establish dial-up networking, you must complete the setup procedures on both the APP Recorder 

(server) computer and on the ClearView (client) computer. 

Things to Remember  

The Dial-up network IP Address of the Recorder is (200.200.200.200) 

The Dial-up network IP Address of the ClearView computer is (200.200.200.201) 

Use IP:200.200.200.200 to call the Recorder when using Remote Desktop or UltraVNC or other remote 

access services. 

The dial-up network can only be disconnected by the application that started it. 

The dial-up network will stop the Internet connection and also could stop some local LAN. 

The Internet will resume automatically after the dial-up network connection is disconnected. 

7.7.5 Configuring Automatic Tasks 

The APP Recorder can perform a variety of automatic tasks, which appear on the window that is shown in 

Figure 69. By configuring the automatic tasks, you can take full advantage of the APP Recorder’s ability to 

become an integral part of your substation or plant automation. 

There are several types of automatic tasks you can configure: 
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Automatic tasks that occur when a fault arrives, see Section 7.7.7 including: 

▪ Whether or not the APP Recorder calls the master station, and what type of data it sends about 

the fault 

▪ The format of printed reports 

▪ The email settings for automated notifications 

▪ The FTP settings for automated notifications 

Automatic tasks that occur when a SER Event occurs see Section 7.7.14 

Automatic tasks that occur when alarms occur see Section 7.7.15 

Setting up the Master Phone List and the Passwords for login to the Master Station see Section 7.7.16 

Note:  The factory configures all of the settings for automatic tasks before shipping the APP 
Recorder to you. You can optionally change these settings as needed. 

7.7.6 Accessing the Automatic Tasks Tab 

You configure all of the automatic tasks on the Automatic Tasks tab of the Recorder Configuration 

window. 

➢ To Access the Automatic Tasks Tab of the Recorder Configuration Window 

1. In the APP Recorder window, from the Edit menu, click Configuration. 

The Recorder Configuration window appears. By default, the Main tab is selected.  

2. Click the Automatic Tasks tab. 

The Automatic Tasks screen appears, as shown in the following figure. 

 

Figure 69: Recorder Configuration Window - Automatic Tasks Tab 
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7.7.7 Configuring Automatic Tasks that Occur when a Fault Arrives 

Call Master, you can configure whether or not the APP Recorder calls the master station, and what type of 

data it sends about the fault. 

Note:  In order for the APP Recorder Program to call the master station and transfer 
data, the master station must be running the APP ClearView Program. The 
APP ClearView Program must be set to monitor incoming calls 

➢ To Configure Whether or Not the APP Recorder Calls the Master Station   

1. Open the Automatic Tasks tab of the Recorder Configuration window. 

2. In the Call Master drop down menu, select what you want the APP Recorder to do if a fault 

occurs. The following table describes the available options. 
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Table 14: Configuring Automatic Tasks—Options in the Call Master List 

If a fault triggers the Recorder Select this option Also set the values of 
these fields 

What should it 
upload? 

When? 

A Fault Summary 

File 

Always   Yes– always  

(Send FSum Only) 

 

 

 

Max #Faults in FSum 

box on the Main tab 

 

This determines the 

number of fault files in 

the Fault Summary 

Record. 

A Fault Summary 

File, and associated 

data 

Always   Yes – always  

(Send FSum and 

Data) 

Data means these only  

check boxes 

 

These determine the type 

of data sent. 

 

If all of the boxes are 

unchecked, then all of the 

types of data will be sent. 

A Fault Summary 

File 

Only when 

certain 

conditions occur  

Yes – if logic true  

(Send FSum Only) 

 

 

Max #Faults in FSum 

box on the Main tab 

Logic (OR=1, AND =&) 

box 

 

 

Data means these only  

check boxes 

A Fault Summary 

File and associated 

data 

Only when 

certain 

conditions occur 

Yes – if logic true 

(Send FSum and 

Data) 

Logic (OR=1, AND =&) 

box 

 

Data means these only  

check boxes 

A Fault Summary 

File (always) 

 

and associated data 

(sometimes) 

Always print a 

Fault Summary 

Report 

 

but 

 

Print all analog 

waveforms and 

all event graphs 

only when 

certain 

conditions occur  

Yes – always 

(FSum), if logic 

true (Data) 

Max #Faults in FSum 

box on the Main tab 

 

Logic (OR=1, AND =&) 

box 

 

Data means these only  

check boxes 
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3. In the Max # Attempt box, type the number of times the APP Recorder Program will attempt to 

call the master station, via modem or network, before stopping. The Recorder retries about every 2 

minutes. 

4. Data Means These Only, do you want to limit the type of data sent when a fault occurs?  

▪ If yes, then under Data means these only, select the appropriate check boxes. If you select 

none of the check boxes, then Transient, Disturbance, Extended RMS, and Extended 

Oscillography data are all sent. 

▪ If no, all data will be sent, skip to the next step. 

5. Retrieve any un-retrieved old records during auto Polling, this function is to ensure all 

COMTRADE Records on the Recorder is retrieved into APP Clearview. Check the box if you 

want Clearview to pull any fault records during polling/auto polling existing in the Recorder and 

has not yet been retrieved. 

Note: If the fault summary list (.lst file) is retrieved manually, then the Recorder is auto polled, 
Clearview may not retrieve any un-retrieved fault records until the next polling cycle. 

6. Do an Auto Test Run if no fault occurs in a week will initiate a test run if there has been no 

faults recorded in the past week. This is to provide a way to ensure the recorder is functioning and 

can provide proof for audit purposes. Click the check box to have Auto Test Run turned on. 

7. Logic Box, this box indicates the condition(s) that must be met in order for the Recorder to send 

the data to the master station. Do you want to set conditions for sending data to the Master? 

▪ If yes, then complete the Logic box. For more information, see Defining a Boolean Logic 
Equation on page 7-28. 

▪ If no, then skip to the next step. 

8. From the menu, click Save. 

7.7.8 Configuring Printing 

You can preview/print a report of the APP Recorder configuration by clicking Print and selecting either 

Preview or Print. 

Note:  In order for the APP Recorder to print, there must be a local or network printer connected 
to the recorder. 

➢ To Configure Printing 

1. Open the Automatic Tasks tab of the Recorder Configuration window. 

2. In the Print drop down menu, select the specific printing function that you want APP Recorder to 

perform. The following table describes the available options. 

  



Using the APP Recorder 7-19 

Table 15: Configuring Automatic Tasks—Options in the Print List 

If a fault triggers the Recorder Select this option Also set the values of 
these fields 

What should it 
upload? 

When? 

Nothing  

 

Note:    You can 

still manually 

activate printing. 

n/a No  

 

n/a 

A Fault Summary 

File 

Always   Yes– always (Print 

FSum Only) 

 

n/a 

A Fault Summary 

File, and associated 

data 

Always   Yes – always (Print 

FSum and Data) 

Data means these only  

check boxes 

A Fault Summary 

File 

Only when 

certain 

conditions occur  

Yes – if logic true  

(Print FSum Only) 

 

Logic (OR=1, AND =&) 

box 

A Fault Summary 

File, and associated 

data 

Only when 

certain 

conditions occur  

Yes – if logic true 

(Print FSum and 

Data) 

Logic (OR=1, AND =&) 

box 

Data means these only  

check boxes 

A Fault Summary 

File (always) 

 

and associated data 

(sometimes) 

Always print a 

Fault Summary 

Report 

but 

Print all analog 

waveforms and 

all event graphs 

only when 

certain 

conditions occur  

Yes – always 

(FSum), if logic 

true (Data) 

Logic (OR=1, AND =&) 

box 

 

Data means these only  

check boxes 

3. Do you need to complete the Logic box?  

This box indicates the condition(s) that must met in order for the Recorder to send the data to the 

master station. 

▪ If yes, then complete the Logic box. For more information, see Defining a Boolean Logic 
Equation on page 7-28. 

▪ If no, then skip to the next step. 

4. Do you want to configure the format of printed reports? 

▪ If yes, continue with the procedure, Configuring the Format of Printed Reports. 

▪ If no, from the menu bar, click Save. 
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7.7.9 Configuring the Format of Printed Reports 

➢ To Configure the Format of Printed Reports 

1. Open the Recorder Configuration window and open the Automatic Tasks tab. 

2. Click the Printing Format button.  

The Format All Wave Printing window appears.  

 

Figure 70: Printing Format Window 

3. From the Analog Channel Format list, select the appropriate format: 

▪ YScale Optimized (peak) 

Prints the highest peak value measured to the right-hand side of each oscillogram printed. 

▪ YScale Optimized (unit/cm) 

Prints a volts/cm or amps/cm scale to the right-hand side of each oscillogram printed. 

▪ YScale = Channel Full Scale Optimized (unit/cm) 

Prints a volts/cm or amps/cm scale to the right-hand side of each oscillogram  printed. The 

value is based on the full scale setting in the Point Assignment Record and the number of 

oscillograms printed on the page. 

▪ Yscale = User Select Scale (unit/cm) 

If selected, a user programmable Yscale field appears. The user can enter their desired 

volts/cm or amps/cm scale. Prints a volts/cm or amps/cm scale to the right-hand side of each 

oscillogram printed. The value is based on a user entered Yscale (unit/cm). If the scale is too 

small waveform clipping will occur. 

▪ Yscale Optomized (RMS) 

This selection prints the RMS value to the right side of each oscillogram printed. 

Note: Print fewer channels on a page to increase the resolution on the Yscale. 
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4. From the Channels list, select one of the following choices: 

▪ All 

Prints an oscillogram for each analog channel listed in the Point Assignment Record. 

▪ Selected 

After you select this, click the Select Channels button to select the specific channels to print. 

▪ Group 

Specific preset line groups can be printed. 

5. From the Print Data Range list, select the range of records to print: 

▪ All 

Prints the entire length (X-axis) of all the oscillograms selected for printing. 

▪ Selected 

Each data point in an oscillogram has a number. The starting number is “0”  which is usually 

the prefault portion of the waveform. The ending number depends on how long the fault or 

recording lasted.  To print a partial record, X- axis length, enter the data range. 

6. In the #Channels/Page box, enter the number of oscillograms you want to appear on each page of 

the printout.  

Note: Print fewer oscillograms on a page to increase the resolution on the Yscale. 

7. Limit to 100 Cycles per Page check box causes the report to limit to 100 Cycles per page for 

each channel displayed on a page.  

8. There are two types of triggers, analog triggers and event triggers. You can print these triggers in 

conjunction with oscillograms. Triggers are represented by horizontal lines at the bottom of a 

printed or displayed page.  In the Digital Channel Format list, select how the trigger line should 

appear, whether it is normal or abnormal: 

▪ Sequence Of Events /Triggers (Line on Abnormal) 

This selection only prints the event channels or analog triggers that caused the system to 

trigger and record. The state of other event channels is not printed. If a line is shown, it 

represents the period of time the event was abnormal.  

▪ Sequence Of Events /Triggers (Line on Normal) 

This selection only prints the event channels or analog triggers that caused the system to 

trigger and record. The state of other event channels is not printed. If a line is shown, it 

represents the period of time the event was normal.  

▪ All Events/Triggers (Line on Abnormal) 

This selection prints the analog triggers and event channels that were in an abnormal state 

when the record was created. If a line is shown, it represents the period of time the analog 

trigger or event channel was abnormal. 

▪ All Events/Triggers (Line on Normal) 

This selection prints the analog triggers and event channels that were in an abnormal state 

when the record was created. If a line is shown, it represents the period of time the analog 

trigger or event channel was normal. 

9. Spread digital among graphs, if Spread digital check box is not checked, the Analog channels 

are printed, then the Event Channels, on each page (See Figure 71). With Spread digital check box 

checked the report shows the digital channels along with the Analog lines together (See Figure 

72). 
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Figure 71: Default Report Format 

 

Figure 72: Report with Spread digital among graphs checked 
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10. No Trigger check box causes the report to exclude Analog Trigger faults from the report. An 

Event Trigger will still display if an Event Channel is set up, and an Event Channel caused the 

Trigger or an Event Channel changed state while the record was being created. 

11. In the Panel Size box, enter the percentage of space the event and analog trigger lines will use at 

the bottom of a printed page.  

12. In the Font Size Global Control box, enter the font size to be used for the title of the waveform 

pages and any annotations that may have been added. You cannot change the font on the Fault 

Summary Report. 

13. In the Font Size Title Control box, enter the font size for the title that appears at the top of each 

waveform or oscillogram page.  

14. In the Annotation Text Size box, enter the font size for any annotations that are added to a 

waveform or oscillogram page. 

15. Click OK. 

7.7.10 Configuring Email Settings 

You can configure the APP Recorder to automatically email fault summary information to the master 

station. When the APP Recorder sends an email, it sends a plain text e-mail message containing a summary 

of a fault. The following information is included in the report:  

Recorder ID 

Fault ID number 

Fault date and time 

Fault duration 

Fault location report (if calculable) 

Note: The Recorder must have an SMTP/POP3 email account and connectivity in order for the 
Email feature to work properly.  

➢ To Configure Email Settings  

1. Open the Recorder Configuration window and open the Automatic Tasks tab. See Figure 69. 

2. Select the Email check box. 

Note:  If the Email check box is not selected, the APP Recorder will not automatically send 
emails with fault summary information. 
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3. Click the Email Settings button.  

The Main tab of the Email Settings window appears. 

Figure 73: Auto Email Setup Window 

4. In the From field, enter a valid email address. 

5. In the Recipients list, add or delete recipients’ email addresses. The e-mail message will be sent to 

all of the recipients in this list. If no recipients are listed, click Add and specify a valid email 

address.  

• Use the “Check All” button to select all recipients at once. 

• Use the “Uncheck All” button to unselect all recipients at once. 

6. Contact your network administrator to obtain values for the Outgoing Mail (SMTP), Port#, User 

ID and fields.  

7. Do you want the APP Recorder to automatically email a summary of every fault each time the 

master station automatically retrieves a fault record or whenever a fault record is automatically 

called in? 

▪ If yes, then select the Auto Send Fault Summary if Logic Filter (LF) True check box. On 

the Automatic Tasks tab of the Recorder Configuration window, verify that the Logic box 

contains the appropriate value. For more information on completing the Logic box, see 

Defining a Boolean Logic Equation. 

▪ If no, skip to the next step. 

8. Limit faults automatically sent. Do you want the Auto Send Fault Summary function to limit 

what is sent to the Master Station to any faults less than 1 day old? 

▪ If yes, then click the Don’t Auto Send Fault Summary if older than 1 day check box. 

▪ If no, skip to the next step 

This function works only if Auto Send Fault Summary is also checked. 

9. From the menu bar, click Save. At this point, you have completed configuring e-mail settings. It is 

a good idea to send a test e-mail to ensure that messages will be sent properly. To do this, 

complete the procedure, To Test the Email Function. 
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➢ To Test the Email Function 

1. In the Send Email window, click the Message tab.  

The Message tab appears, as shown in the following figure. From here, you can type an email and 

manually send it to everyone in the Recipient list.  

Figure 74: Manual Emailing Window 

2. In the Subject box, type the subject line for the email.  

3. In the Message box, type the message.  

4. In the Attachments list, select an attachment to include. Use the Add and Delete buttons to select 

or remove additional files.  

Note: Attachments will only be sent if the Secure check box is unchecked on the Main Tab  

5. Click Send.  
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7.7.11 Configuring FTP Settings  

You can configure the APP Recorder to automatically send the most recently generated transient fault 

record to a host directory. 

➢ To Configure FTP Settings  

1. Open the Recorder Configuration window and open the Automatic Tasks tab. 

2. Select the FTP check box. 

Note: You must set this up if you want the APP Recorder to send transient records through 
FTP. 

3. Click the FTP Settings button. 

The FTP Settings dialog box appears, as shown in the following figure. 

 

Figure 75: FTP Account Settings Window 

4. (Required) In the Host field, type the URL for the host computer. 

5. (Required) In the Port field, type the port for the host.  

Note: A common port setting is 21. 

6.  (Required) In the User ID field, type the user ID to log in to the host. 

7. (Required) In the Password field, type the password to log in to the host.  

8. Do you want to use a proxy server? 

▪ If yes, then select the Proxy Server check box. In the Proxy Server box, type the name of the 

proxy server. In the Proxy Port box, type the port number for the proxy server. 

▪ If no, skip to the next step. 
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9. Do you want to create a logic filter to identify when the transient record should be sent to the host 

directory?  

▪ If yes, then select the Auto Upload Fault Files if Logic Filter (LF) True check box. On the 

Automatic Tasks tab of the Recorder Configuration window, verify that the Logic box 

contains the appropriate value. For more information on completing the Logic box, see 

Defining a Boolean Logic Equation. 

▪ If no, skip to the next step. 

10. Max #Upload/hr box, enter the maximum number of fault records to be sent to the host directory 

per hour. Specify a limiter here to stop the host directory from being inundated with data in the 

event that the APP Recorder has an unexpected runaway tripping event.  

Note: You can reset the counter manually via the Reset Upload button. The Reset 
Upload button is for emergency purposes if the maximum upload number has 
been exceeded, but you still want other fault records to be sent. 

11. Max #Retry of each Upload box, enter a limiter that determines how many times the software 

will try to send a new record to the host directory. If the limit is reached due to some connection or 

setting problem, a message will appear in the APP Recorder trace file. 

12. Time Between each Retry : Randomized Between, enter the two times in seconds, between 

which FTP retries should occur. APP Recorder will attempt at random intervals between the range 

specified, to resend data. 

13. Delay 1st Send (by retry time) check box. Check this to delay 1st send by the Retry time 

specified above. 

14. From the menu bar, click Save and then click the Directory tab.  

The Directory tab appears, as shown in the following Figure 76: FTP Remote Directory Setup 

Window 

 

Figure 76: FTP Remote Directory Setup Window 
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15. The Local Dir. field automatically displays the value that was entered in the Data Path field on 

the Main tab of the Recorder Configuration window. This setting tells the FTP program from 

where to retrieve the new fault records that it will place in the host directory. 

Note: You can change the path while testing the FTP function 

16. (Required) In the Remote Dir. field, type the path to the remote directory that is located on the 

host site to which the transient records will be sent (for example, \storage).  

Note: The backward slash may need to be included in the path. 

17. Do you want to test the connection to the remote directory?  

▪ If yes, click Show Remote Dir Content. 

If communication is established you will see the remote directory in the message window. If 

the FTP settings are incorrect, you will see nothing in the message window. In the tray below 

the message window you might see error messages. 

▪ If no, skip to the next step. 

18. From the menu bar, click Save. 

7.7.12 Defining a Boolean Logic Equation 

You can define a Boolean Logic equation to automatically filter, or limit, when the APP Recorder does any 

or all of the following:  

Calls the master system 

Prints the Fault Summary File and fault-related data 

Sends an email notification 

Sends transient fault record via FTP 

Note:  You can define only one logic entry.   

The following table lists the available equation variables and field entries. 

Table 16: Defining a Boolean Logic Filter—Variables and Entries 

Entry Description 

0 False, nothing will pass filter 

1 True, everything passes filter 

Blank (Nothing Entered) True, everything passes filter 

T1, T2, T3….. Represents Trigger Channels  

t1, t2, t3….. Also Represents Trigger Channels 

E1, E2, E3…. Represents Event Channels 

e1, e2, e3…. Also Represents Event Channels 
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7.7.13 Performing a Test Upload  

You can use the Upload tab to test the upload process. This tab allows the transfer of any file from the 

local directory to the remote directory. If the file is successfully transferred, an “Upload Succeed” message 

will appear in the FTP Status pane. If the file is not transferred, an “Upload Fail” message will appear 

instead. 

 

Figure 77: FTP Upload or Testing Window 

➢ To Perform a Test Upload 

1. In the Local File box, type the name of the file you wish to send to the remote file. This file must 

be located in the local directory that is defined on the Directory tab. 

2. Do you want the file name to remain the same when it is placed in the remote directory? 

▪ If yes, then in the Remote File field enter the same file name that you entered in the Local 

File box. 

▪ If no, type a different file name. 

3. Click Upload. 

The test file transfer process begins.  

4. After the transfer is successful, click the Show Remote Dir Content button. The file appears in 

the remote directory that you specified on the Directory tab.   

➢ To Stop the Automatic Retry Attempts 

If the transfer fails and you wish to stop the automatic retries, click Abort.  

➢ To Clear the Buffer of Any Fault Record 

Note:  You can clear the buffer for troubleshooting or testing purposes. 

Click Clear FIFO to clear the buffer of any fault record or test file that the APP Recorder is trying to 

send to the remote directory. 
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7.7.14 Configuring Automatic SER Reports 

If a receipt printer is connected to the parallel port of the computer running the APP Recorder, the APP 

Recorder can automatically print an SER report when a SER (SOE) channel experiences a change of state.  

The printed report includes the date, time, channel description, channel number, and if the channel has 

switched to a normal or abnormal state. 

➢ To Configure Automatic SER Reports 

1. Open the Recorder Configuration window and open the Automatic Tasks tab. 

2. Select the Auto Print SER Reports On Receipt Printer check box.  

3. From the menu bar, click Save. 

7.7.15 Calling the Master Phone List when Alarms Occur 

You can configure the APP Recorder to automatically call the numbers in the master phone list when 

alarms occur. For information on configuring the master phone list, see 7.7.16 Configuring the Master 

Phone List.   

➢ To Configure whether the APP Recorder Calls the Master Phone List when Alarms Occur 

1. Open the Recorder Configuration window and open the Automatic Tasks tab.  

2. Under the When Alarms Occurred, Do section, do one of the following: 

▪ If you want the APP Recorder to call the numbers in the Master Phone list, select the Call 

Master… check box. 

▪ If you want the APP Recorder to not call the numbers, de-select the Call Master… check 

box.   

3. From the menu bar, click Save 

Note: The Fault alarm is not affected by the setting of the Call Master… check box. 

7.7.16 Configuring the Master Phone List 

➢ To configure the master phone list, you can specify: 

▪ The phone numbers, IP Address, or Master IDs of the master stations that the APP Recorder 

Program will automatically call. 

▪ The password APP Recorder should use to log in to the master station. 
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➢ To Configure the Master Phone List 

1. Open the Recorder Configuration window and open the Automatic Tasks tab. 

2. Click the Master Phone List button. 

3. The Master Phone & Network List window appears, as shown in the following figure.  

Figure 78: Master Phone & Network List Window 

4. Do you want to add a new IP address or phone number?  

▪ If yes, then do one of the following: 

▪ If the APP Recorder is connected to a dial modem, then from the list, select Phone#. 

Then in the corresponding box, type the phone number. You can use any standard 

Windows format.  Click the Add button. 

▪ If the APP Recorder is connected to an IP address, then from the list select IP Addr. 

Then in the corresponding box, type the IP address. You can use any standard Windows 

format. Click the Add button. For information on configuring DialNet, see 7.7.4 Setting 

Up Dial-up Networking. 

▪ If no, skip to the next step. 

5. By default, the first entry that you make is selected, as indicated by the X in the Use column. The 

entry with the “X” is the number that APP ClearView will call when it connects to or calls the 

APP Recorder. You can activate multiple phone numbers and/or IP addresses. 

 

 Do you want to activate or de-activate a phone number or IP address? 

▪ If yes, then in the Use column, click the box next to the entry. An X appears when the entry is 

activated; it disappears when the entry is deactivated. 

▪ If no, skip to the next step. 

6. Do you want to delete a number? 

▪ If yes, then right-click the number and then click Delete.  

▪ If no, skip to the next step. 

7. Do you want to reorder entries? 

▪ If yes, then under the Drag column, click the gray box that corresponds to the entry you want 

to move and then move it to its new position.  

▪ If no, skip to the next step. 

8. Click Save.  

  



Using the APP Recorder 7-32 

➢ To Configure the Recorder Password 

1. Open the Recorder Configuration window and open the Automatic Tasks tab.  

2. Click the Recorder Password button. 

The Recorder Password window appears. 

3. Type the new APP Recorder password. 

Note: The password is case-sensitive. 

4. Click the OK button. 

7.7.17 Ping Master Every 5 minutes 

Ping Master every 5 minutes will continually test the connection between the DFR and the Master 

Computer. The Master has to be set up in the Master Phone list, Call Master has to be set to “Yes”. If a 

failure occurs, it will cause a Master Comm Error. You must map that alarm in the Point Assignment 

Record, General Settings, Recorder Setup tab to have a hard alarm displayed. 

7.7.18 Do TestRun Periodically 

Do TestRun Periodically allows you to set up test runs on a schedule defined by a date range and interval 

in minutes. The test run will occur precisely at the top of the minute and is accurate to the sample point. 

To cause a periodic test run, enter the Start Date and Time, the End Date and Time and the number of 

minutes between Test Runs. Once the end date and time has passed no more scheduled Test Runs will 

occur. 

7.7.19 Configuring Allowed IPs 

The APP Recorder includes a security feature that will limit remote connections to the APP Recorder. Only 

specified IP addresses will be permitted remote access to the APP Recorder.  

Note:  If you specify no IP addresses, then all IP addresses will be allowed access to the APP 
Recorder. 
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➢ To Configure Allowed IPs 

1. Open the Recorder Configuration window and open the Allowed IPs tab.  

The Allowed IPs tab appears, as shown in the following figure. 

Figure 79: Allowable IPs Entry Window (Security Feature) 

2. In the box, type the IP addresses.  Press the Enter key between each IP address. 

3. To delete an IP address, right-click the IP address and click Delete.  

Note: You can also use the Undo, Cut, Copy, and Paste options from the pop-up 
menu. 

4. From the menu bar, click Save. 

7.7.20 Printing Recorder Configuration 

You can print the configuration information by clicking Print at the top of the screen then selecting Print 

Preview or Print. Print Preview allows you to review the report, save, change the printer preferences, and 

print. 

7.8 Editing the Point Assignment Record 

The Point Assignment Record is a user-defined record that is used by the APP Recorder to control system 

operation, perform calculations, and perform analysis. A Point Assignment Record contains information 

concerning the recorder hardware, analog channels, analog triggers, events, sampling rates, and different 

types of recording. The Point Assignment Record is saved in the setup folder and is structured Rxxx.par 

where xxx is the recorder number. 

If your company provides point assignment information, APP factory personnel will enter that information 

into the APP Recorder before shipping it to you. You can edit a Point Assignment Record via the APP 

Recorder Software or the APP ClearView Software. The Point Assignment Record file can be downloaded 

from the master station (APP ClearView) to the APP Recorder or vice versa.  

In the APP Recorder, you can access the Point Assignment Record from the Edit menu of the APP 

Recorder window. 

Note:  The Point Assignment Record is a key file for the Recorder operation. For complete 
details on how to create and edit the Point Assignment Record, see the APP ClearView 
Operating Manual. 
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Note:  If an administrator password is defined, only the administrator has privileges to save a 
newly created Point Assignment Record or save changes to an edited Point Assignment 
Record. 

7.9 APP Translator  

7.9.1 Overview 

The following instructions will guide you through setting up of APP Recorder software to enable using 

APP-618 Translator for configuring the IEDs and subscription definitions for Sampled Values (SV) and/or 

GOOSE Capture.  

The translator option will not be available on the Recorder Edit Point Assignment Record menu unless 

GOOSE has been enabled or an APP-618 chassis has been defined in the Point Assignment Record. The 

following describes how GOOSE and SV are enabled. 

Note: For more information regarding the setup of GOOSE Capture and SV in APP Recorder, 
see APP-601 Recorder Operating Manual and APP Clearview Instruction Manual. 

7.9.2 Activating Sampled Values in APP Recorder 

This process is to configure the Point Assignment Record for 1 or more APP-618 Controllers to receive 

Sampled Values (SV) streams and enable APP-618 Translator. The APP-618 Translator will configure the 

Point Assignment Record for the APP-618 Controllers by importing the relevant IED subscription 

information from the SCD file. The following instructions will guide you through the steps to define the 

number of APP-618 Controllers, the number of Analog boards (3 channels per board) and number of 

streams to configure. 

In the APP Recorder main screen  

1. Click Edit, hover over Point Assignment Record then click Edit 

2. Click the Chassis Config tab 

3. Enter the number of total Data and 618 Chassis in the #Chassis field and click the OK button and 

the chassis will be listed. 

4. Change Slot-7 of each APP-618 chassis from DSP to “GPU” by clicking DSP and over typing 

with GPU (See Figure 2) 

5. Add the number of analog boards to the chassis based on how many analog channels are required 

(3 channels per Analog Board).   

The example below (Figure 2) shows 1 618 chassis configured for 6 boards/18 analog channels. Only place 

the number of boards for the required number of channels.  

Ext-1PPS – Do not place an X for the APP-618 Controller chassis. It does not use Ext-1PPS field as the 

618 will receive its clock from a PTP source on the Process Bus or DSP network. 

Figure 80 APP-618 Sampled Values Chassis Config 
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Next, double click on “GPU” in the Slot-7 field of the APP-618 chassis to open the GPU Cfg window 

shown below (see Figure 3).  

Fill in the #SV field, top left, with the number of different SV streams (maximum of 2) the chassis is to 

subscribe to and click OK.   

 

The streams will automatically be added and numbered based on the #SV entry. The C# field is preset to 

Chassis#Stream# (C#S#). The number of SV Streams and SV Analog channels will be populated on the 

Analog Configuration TAB.  

Detailed SV information such as SVID, MAC Address can be left blank, as 618 Translator will 

automatically configure these fields.  

SV data is expected in the format of 61850-9-2LE datasets of 8 Analog channels, 3-phase with neutrals: Ia, 

Ib, Ic, In, Va, Vb, Vc, Vn. A single 618 Controller Chassis can subscribe up to 2 streams. Since an Analog 

card supports 3 Analog channels, a chassis must be set as having at least 3 Analog cards for 1 stream and 6 

boards for a 2nd stream (9 or 18 Analog channels). Any additional analog channels on a 618 Controller 

Chassis will be configured as Spares.  

NOTE: Each APP-618 Chassis is limited to 2 streams (#SV). The PAR will allow you to set 
the number of streams to more than 2 but the Translator will send an error 
message and not run if there are more than 2 when you run the Translator.. 

A system subscribing to 3 streams must have at least 2 - 618 Controller Chassis, with 6 cards on one 

chassis and 3 on the other. 

Only the analog channel configuration for 618 Controller Chassis will be modified by 618 Translator. 

General settings, 601 Data Chassis channels, event channels, etc., will remain the same. Triggers and 

Alarms may be affected. 

7.9.3 Accessing APP-618 Translator 

Now that you have enabled GOOSE Messaging and/or SV in the Point Assignment Record, you can access 

the APP-618 Translator.  

Figure 81 Sampled Values PAR Settings 
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The 618 Translator is opened from the APP Recorder Edit/Point Assignment Record menu. Click 618 

Translator. 

 

The following window will appear.  

Figure 83 618 Translator Window 

 

Translating the SDC file is in 4 stages: 

1) Select SCD file  

2) Select Translate for 

3) Select IED names and Start 

4) Confirm output 

 

Figure 82 Start 618 Translator 
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7.9.4 SCD File Selection 

Click the “Select SCD” button or under the File Menu, Click Select SCD to open File Explorer and 

navigate to the desired SCD file. It is not necessary for the SCD to be in the same directory as 618 

Translator. 

After selecting a valid SCD file, 618 Translator will scan the file and generate a list of IEDs. 

It is not required to have APP 601 DFR or APP 618 Controller Chassis configured in the SCD file, as 618 

Translator will scan all selected IEDs for any subscription information. Users can then filter their desired 

information (SV streams and/or Goose Points) as described in later sections. 

If APP-601 Data Chassis and APP-618 Controller Chassis are configured in the SCD file, they may be 

represented as multiple discrete IEDs in the SCD file.  

Select the IEDs applicable to the APP 601 DFR being configured by clicking the check box. 

 

Figure 84 618 Translator Select IED names window 

7.10 Use as SEL Goose Subscriber 

If you use an SEL device the SCD file will include Private Fields. Under the Options menu select Use as 

SEL Goose Subscriber to translate private fields along with the standard fields in the SCD file. When 

selected a checkmark will appear to indicate it is active. 

 

Figure 85 Use as SEL GOOSE Subscription option 

 

7.10.1 Translate For Selection 

You can translate for GOOSE Only, Sampled Values only, or GOOSE and SV together.  

Click the selection in the Translate For drop down list.  
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7.10.2 Starting APP-618 Translator 

Once you have selected the IEDs and Translate For, Click the “Start” button at the bottom of the window. 

APP-618 Translator will run and confirm whether an operation was successful or unsuccessful in the log 

window. If unsuccessful, no change is applied to the existing configuration files.  

Note: 618 Translator creates backups of the original PAR and GPAR files before modifying. 

After clicking “Start”, 618 Translator will analyze the SCD file for subscription and dataset information.  

If successful, a warning message appears before 618 Translator saves the final configuration. The message 

reminds the user that parts of the configuration must be manually reviewed and configured after translation 

from the SCD. 

 

Figure 87 Reminder of next steps message 

Figure 86 Translate For Menu 
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 The 618 Translator will summarize the details of the SCD and process status, ultimately reporting the 

translation is successful. 

  

Figure 88 618 Translator log window - successful translation message 



Using the APP Recorder 7-40 

7.10.3 Reading Translator Log 

If there are errors, 618 Translator will log an error message and will not modify the existing PAR or GPAR 

files. The error message will describe what error is encountered during the process. An example might be 

there are not enough Analog Channels defined in the PAR for the number of streams in the devices 

selected. These messages will help define where changes in the PAR may be required before trying again.   

Figure 89 618 Translator log window – PAR Warning 

In this case Translator will display the Streams and ignore the streams that do not have Analog Channels. 

You will see a message asking if you want to arrange the streams and asign to the Analog Channels 

available. 

 

If you click Yes, the next window will display the streams. You cand Drag and Drop the streams to the 

Chassis/Streams available.  Otherwise, if there are enough Analog Channels, you will see the following 

window with all streams assigned and you can then rearrange streams on the Chassis as needed. 
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Note: If you leave the 1st channels of a 618 Controller unassigned to a stream, 618 
Translator will automatically move the Streams assigned to that 618 controller up 
and assign it to the first channels in order for Recorder to run properly. 

When done arranging, Click OK and the following message will appear. 

 

Click OK to continue with updates to the PAR and you will see a status message in the message log 

window, if you click NO, the Translator will be aborted and no changes to the PAR will be saved and will 

also be noted in the message log. 

7.10.4 Reinitialize 

Finally, when a translation is successful, 618 Translator will automatically cause APP Recorder and 

GOOSECap to reload the new configuration. 

7.10.5 Confirming the Point Assignment Record (PAR) 

The updated Point Assignment Record file will have its analog channel configuration rewritten. All 

channels belonging to 618 Controller (GPU) chassis will be reconfigured to contain SV channels. Each SV 

Channel will be given a phase identification according to 61850-9-2LE specification and default analog 

channel description based on the smvID, name, and DataSet desc from the SCD. Extra channels on each 

chassis will be set as SPARE.  

Virtual channels must be manually defined.  

Figure 90 Translator - Arranging SV Streams before saving to PAR 
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Trigger channel and alarm configuration is not modified by 618 Translator. The user must manually 

create and verify these after translating an SCD. 

Figure 91 Default Analog Channel Descriptions 

7.10.6 Virtual Channels 

You can configure Virtual channels on a 618 Controller Chassis similar to how Virtual Channels are 

configured on the APP 601 Data Chassis. Virtual Channels must be on the same chassis as the SV analog 

channels they refer to and must come after the SV analog channels.  

For more information on configuring Virtual Channels please see the APP Clearview Instruction Manual. 

If more virtual channels are desired, it is permitted to add Virtual Analog cards to the PAR to give more 

slots for potential virtual channels, up to the normal limit of 10 total analog cards per chassis. 

NOTE: if the channel assignments are changed or SV streams added to previously assigned existing 

channels on a 618 Chassis, the original assignment will be lost/replaced. 

7.10.7 Confirming GOOSE Points (GPAR) 

618 Translator will create a GOOSE Point Assignment Record (GPAR) with the appropriate number of 

devices and points in each dataset based on what IEDs were selected when running the Translator. Points 

will be given default descriptions based on the daName, prefix, lnClass, and doName attributes from the 

SCD. Any previous data in the file will be lost. However, a backup of the gpar was created prior to saving 

the new gpar. 

To view the gpar, click the GOOSE program to open the GOOSE window. 
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Click Edit and then Edit GOOSE Points. The following window will appear. 

Review each device by clicking on each Device TAB at the bottom of the Edit gpar window.  

See Section 0  

 

Edit GOOSE Points for more information on configuring GOOSE Points. 

Figure 92 Edit GOOSE Capture main screen 

Figure 93 Edit GOOSE Point window 
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7.10.8 Translator Trace File 

You can view a Translator Trace file by using File Explorer to navigate to the C:\APP Recorder Setup 

folder and opening TTrace.wri 

7.11 Editing the Line Group Record 

The Line Group Record is a user-defined record. Here channels that form a line group are linked together. 

This permits the APP Recorder to perform distance to fault calculations, various power calculations, and 

provides a quick convenient means for viewing oscillograms for different line groups. The Line Group 

Record is saved in the setup folder and is structured RxxxLines.inf where xxx is the recorder number. 

If your company provides line group information, factory personnel will enter that information into the 

APP Recorder before shipping it to you. In addition, you can create and edit a Line Group Record via the 

APP Recorder or the APP ClearView. The line group file can be downloaded from the master station (APP 

ClearView) to the APP Recorder or vice versa.  

In the APP Recorder, you can access the Line Group Record from the Edit menu of the APP Recorder 

window. For complete details on how to create and edit the Line Group Record, see the APP ClearView 

Operating Manual. 

Note:  If an administrator password is defined only the administrator has privileges to save a 
newly created Line Group Record or save changes to an edited Line Group Record. 

7.12 Connecting to ClearView 

You can manually initiate a phone call connection between the APP Recorder and the master station. The 

APP Recorder will call the phone numbers or IP addresses that are entered in the Master Phone List.  

The APP Recorder only calls those numbers/IP addresses that have a checkmark beside them. If more than 

one number has a checkmark, the recorder will call them in sequential order. 

Upon a successful connection to a master station, the APP Recorder uploads the information that you 

designated on the Automatic Tasks tab (summary file only, summary file and data, etc.).  

After uploading the appropriate information, the APP Recorder automatically disconnects from the master 

station.  

7.12.1 Connecting to ClearView 

➢ To Connect to ClearView 

In the APP Recorder window, from the Connect menu, click Connect to ClearView. 

Note: The APP ClearView master station program will not receive a call unless it is set to 
“monitor incoming calls.” 
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7.12.2 Disconnecting from ClearView 

You can manually break the connection between the recorder and master station. 

➢ To Disconnect from ClearView 

In the APP Recorder window, from the Connect menu, click Disconnect from ClearView. 

7.12.3 Viewing the Connection Status Window 

While the APP Recorder is connected to the master station, you can view real-time messages related to the 

communications and data transfer progress between the computers in the Connection Status window. This 

window is useful in determining if a successful connection has been established between the master station 

and APP Recorder. 

➢ To View the Connection Status Window  

In the APP Recorder window, from the Connect menu, click Show Status Screen. 

The Connection Status screen appears. You can also press (F2) anytime to show Connection Status Screen. 

 

Figure 94: Connection Status Screen 

To close the window, click the X button in the upper right-hand corner. 

➢ To view the Trace File 

From the Connection Status Window, you can view the CTrace file by clicking on the  button. The 

CTrace file will open. 

Note:  You can leave this window open while you access other functionality in the APP 
Recorder 

7.12.4 Choosing a Modem 

You can view the currently installed modems and choose which modem the APP Recorder should use. 

With Windows 10 The Modem is not available and is disabled. 

Note:  After choosing your modem, you should not need to configure it; the process is 
automated for you. The instructions for accessing the Modem Connection Preferences 
window are included in this section in case you need to verify or adjust settings during 
troubleshooting. 
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➢ To Choose the Modem  

1. In the APP Recorder window, from the Connect menu, point to Modem and then click Choose 

Modem.  The Choose Modem dialog box appears. 

Figure 95: Choose Modem Window 

2. Click the modem to use. 

3. Click the OK button. 

➢ To View the Modem Connection Preferences Window 

In the APP Recorder window, from the Connect menu, point to Modem and then click Configure 

Modem. 

The Modem Connection Preferences window appears.     

7.12.5 Setting the Network Port Number 

The default network port number of 1024 is automatically configured for the APP Recorder. You can 

change the port number, if necessary. 

➢ To Set the Network Port Number 

1. In the APP Recorder window, from the Connect menu, click Set Network Port#. 

The Network Port# dialog box appears. 

2. Enter the network port number and click OK. 

7.12.6 Turning On or Off Dial-up Networking  

If you have configured dial-up networking, you can manually turn it on or off as necessary. Windows 10 

does not have Dial-Up Networking available. If Windows 10 is running Dial-Up Networking will be set to 

Off and unable to be turned ON. 

See Setting Up Dial-up Networking for instructions on setting up dial-up networking 

➢ To Turn On or Off Dial-up Networking 

In the APP Recorder window, from the Connect menu, click Dial-up Networking. 

▪ If the menu option says, Off, then clicking this option immediately turns on dial-up 

networking. 

▪ If the menu option says, On, then clicking this option immediately turns off dial-up 

networking. 
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7.13 Maintaining the APP Recorder 

You can perform the following maintenance tasks for the APP Recorder: 

▪ View the trace files 

▪ Run a diagnostic test 

▪ View all SER abnormal or stopped channels 

▪ Perform a test run 

▪ View the list of “ON” alarms 

▪ Reset the Fault ID 

▪ Reinitialize the APP Recorder 

▪ Restart APP Recorder 

▪ Reboot the APP Recorder 

▪ Reserve the Memory and Defrag the data drive 

7.13.1 Viewing Trace Files 

You can use trace files to help during troubleshooting. There is a separate trace file for the APP Recorder 

and the APP Driver.  

Trace files include:  

• Tracexxx.wri      Driver Trace File 

• CTracexxx.wri     Connection Trace File 

• RTracexxx.wri     Recorder Trace File 

• ATracexxx.yyy    All Trace File 

Note: xxx is recorder number and yyy is a sequence number 

Each trace file lists the major processes carried out by its respective program, either the APP Recorder or 

the APP Driver. When a trace file grows to approximately 500 Kbytes, it will automatically be closed and 

given an extension an incremented extension (for example, .001, .002, and so on.) A new trace file will be 

created.  

There is also an All Trace (ATrace) file available. The ATrace is intended for use with software to parse 

the ATrace log for specific trace information. The ATrace is not simply a consolidation of the Recorder and 

Driver trace files. The ATrace includes additional trace information from: Recorder, Driver, PMU, DNP3, 

Modbus, IRIG-B and is intended for diagnostics and correlation of log entries.  

The Recorder, Driver trace and ATrace files are stored in the C:\APP Recorder\Setup directory. 

➢ To View the Trace File for the APP Recorder 

In the APP Recorder window, from the Maintenance menu, point to Trace Files and click Show 

Trace File. 

The trace file for the APP Recorder appears. 

➢ To View the Trace File for the APP Driver 

In the APP Recorder window, from the Maintenance menu, point to Trace Files and click Show 

Driver Trace File. 

The trace file for the APP Driver appears. 
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➢ To View the All Trace (ATrace) File 

In the APP Recorder window, from the Maintenance menu, point to Trace Files and click Show All Trace 

File. 

The trace file for the APP Driver appears. 

7.13.2 Running a Diagnostic Test and Viewing Results 

Each APP Recorder does an automatic diagnostic test every 5 minutes. In addition, you can initiate a 

manual diagnostic test against the APP Recorder and view the results. 

Note: You can also run a diagnostic test from within the APP Driver window and from the 
master station. 

➢ To Run a Diagnostic Test and View Results 

1. In the APP Recorder window, from the Maintenance menu, point to Diagnostic and click one of 

the following: 

▪ Click Show Result to view the results of the last diagnostic test that was completed. 

▪ Click Redo Diagnostic to perform a new diagnostic test and view its results. Show Result. 

The Recorder Diagnostic Results window appears.  

Figure 96: Recorder Diagnostic Results Window  

To see the details of an entry, double-click its name in the list. To see the latest diagnostic results, from the 

menu bar, click Refresh.  

Figure 97 Diagnostics Results Detail 
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2. To see which alarms are currently ON, from the menu bar, click Alarms. 

The Alarms dialog box displays the alarms. 

3. To close the Recorder Diagnostic Results window, click the X in the upper right-hand corner. 

7.13.3 Viewing All SER Abnormal or Stopped Channels 

Note: The Point Assignment Record contains a setting, under the General Settings tab that 
allows you to automatically shut down an SER channel if it changes state too many times 
in a fixed period. The SER channel will automatically restart after a user-defined 
shutdown period. 

➢ To View All SER Abnormal or Stopped Channels 

1. In the APP Recorder window, from the Maintenance menu, click Show All SER Abnormal Or 

Stopped Channels. 

The following window appears and displays SER channels that are in a stopped or abnormal state:  

 

Figure 98: Stopped/Abnormal SER Channels Window 

▪ In the State column, an O represents an open contact, and a C represents a closed contact. 

▪ In the Normal column, an A indicates the channel is currently in an abnormal state and an N 

indicates the channel is currently in a normal state.  

▪ In the Sync column, a U indicates an unsynchronized time and an S represents a synchronized 

time. 

▪ If an SER channel is stopped, the word Stop will appear at the beginning of the channel 

description, along with either an M or an A: 

▪ M indicates that the channel has been stopped manually via the Point Assignment 

Record.  

▪ A indicates that the channel stopped automatically.  

7.13.4 Performing a Test Run 

You can perform a test run to test if the APP Recorder is really recording and to check all the channel data.  

When you perform a test run, the APP Recorder trips, creating a transient COMTRADE record. The 

COMTRADE records contain a snapshot of all the analog channel signals, and the state of all DFR 

channels, plus the present status of the event inputs.  

In addition, if the extended recording feature is enabled in the Point Assignment Record (General Settings 

tab: Sampling tab), an extended RMS COMTRADE record and an extended oscillography COMTRADE 

record will also be created. You can view the transient, extended RMS, and extended oscillograph records 

with the APP ClearView program, which is loaded on the APP Recorder computer, or with any 

COMTRADE viewer.  

If the Transient Alarm is turned on, during a Test Run the Cross Trigger Alarm will turn on as well as if 

there is an IP Cross Trigger set up it will turn on. 
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The record length will be prefault + post fault. The trigger alarm will not energize during a test run. 

However, the trigger front panel LED will illuminate.  

If the auto-call feature is enabled (Recorder Configuration window: Automatic Tasks tab), the APP 

Recorder will call the master station(s) and upload the records. 

➢ To Perform a Test Run 

In the APP Recorder window, from the Maintenance menu, click Test Run. 

The system immediately responds. The fault will appear on the screen. You can also start a test run by 

pressing F12 anytime except when offline like when the Oscope is being displayed. 

➢ Test Run at Start of Minute 

In the APP Recorder window, from the Maintenance menu, click Test Run at Start of Minute. 

The system will await the start of the next minute and do a test run. The fault will appear on the screen. 

7.13.5 Viewing the ON Alarms 

You can view a list of the alarms that are currently turned on. 

➢ To View the ON Alarms 

In the APP Recorder window, from the Maintenance menu, click Show Alarm ON List. 

The Alarms Currently On window appears.  

 

Figure 99: Alarms Currently ON Window 

7.13.6 Resetting Fault ID 

As each fault record is created the Fault Identification number, or FID, is incremented by one. If the 

extended recording feature is enabled in the Point Assignment Record (General Settings tab: Sampling 

tab), a single trigger will create two new FID numbers, one FID for the transient record and one FID for the 

extended records.  

At any time, you can reset Fault Identification number to 1. You may want to do this to clean up any old 

records. 

Note: An old record with the same FID as the newly created record will not be overwritten due to 
date and time difference.  

*CAUTION*  Resetting the FID causes the APP Recorder Program to re-initialize 
and the APP Recorder to go offline for a few moments. 
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➢ To Reset the FID 

1. In the APP Recorder window, from the Maintenance menu, click Reset FID. 

2. Enter the password  

3. Click ok  

7.13.7 Re-initializing the APP Recorder Program 

You can re-initialize the APP Recorder program to help with troubleshooting. 

Note: Re-initializing only restarts the APP Recorder software. Rebooting turns off the entire 
APP Recorder machine. 

*CAUTION*  The re-initialize command will take the APP Recorder offline for a few 
moments. 

➢ To Re-Initialize the APP Recorder Program 

1. In the APP Recorder window, from the Maintenance menu, click Reinitialize. You can also 

press (F8) at any time except when offline like when displaying oscope. 

7.13.8 Restart Recorder 

Restart Recorder will immediately EXIT APP Recorder program and then re-start it. 

1. In the APP Recorder window, from the Maintenance Menu, select Restart APPRecorder. 

2. Recorder will be exited and go Offline.  

3. App Monitor will restart APP Recorder within 60 seconds 

*CAUTION*  The re-initialize command will take the APP Recorder offline for a few 
moments. 

7.13.9 Rebooting the APP Recorder Program 

You can re-boot the APP Recorder program to help with troubleshooting. 

When you reboot, power is momentarily cut to the APP Recorder. The computer and all circuit boards will 

see a hard power shutdown. Power is cut via a normally closed relay on the data chassis power supply 

circuit board. After 9-10 seconds power will return, and the system will restart. It takes approximately 

1minute and 30 seconds for the system to return to an online state.  

Note: Rebooting turns off the entire APP Recorder machine. Re-initializing only restarts the 
APP Recorder software. 

*CAUTION*  The APP Recorder will be offline during the restart period. 

➢ To Re-Boot the APP Recorder Program 

In the APP Recorder window, from the Maintenance menu, click Reboot. A confirmation window will 

appear, and you will have to click Yes to Reboot. You can also reboot by pressing F9 anytime except when 

offline (e.g. when displaying oscope). The confirmation window will not appear with F9  
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7.13.10 Reserving Memory and Defragging the Data Drive 

Occasionally, you may need to reserve memory and/or defragment the data hard drive remotely. Reserving 

memory or defragmenting the hard drive will take up considerable CPU time (hours) and once started, you 

will be unable to stop these processes remotely.  

Note: If the system is using a solid state drives, defragmentation does not need to be done. 

*CAUTION*  Perform these functions only if there is little or no likelihood of a fault 
for 2 to 24 hours.  

➢ To Reserve Memory 

1. Make sure Sampling tab is set as desired. 

2. Go to Chassis tab. Create a temporary Chassis Configuration that contains the number of analog 

channels you want to reserve memory for plus add 10% more channels than actual channels 

present. 

*CAUTION*  We recommend keeping 30% or more hard drive space available for 
other computer operations  

3. In the APP Recorder window, from the Maintenance menu, click Reserve Memory. 

A Warning message appears. 

4. Click Yes. 

5. To check if the reserve memory process is finished, look at the APP Recorder trace file. In this 

file, the message, “Begin Reserve Memory” appears when the reserve memory process starts. The 

message, “End Reserve Memory” appears when the process finishes.  For information, see 

Viewing Trace Files. 

6. Reserve memory is done to allocate designated space on the computer hard drive for continuous 

recording. Reserving memory helps eliminate disk fragmentation over time. A disk defrag should 

be done after reserving memory. 

➢ To Perform a Defrag Analysis, Defrag the Data Drive, and View the Results 

1. In the APP Recorder window, from the Maintenance menu, click Run Defrag Analysis on 

Data Drive.  

2. After viewing the results, do you want to defrag the data drive? 

▪ If yes, continue with step 3. 

▪ If no, you are finished with this procedure. 

3. From the Maintenance menu, click Defragment Data Drive…. 

A confirmation window appears. 

4. Click the Yes button. 

5. Wait a minute or two. 

6. From the Maintenance menu, click Show Defragment Status. 
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7.14 Continuous Recording  

You can enable or disable continuous recording in the Point Assignment Record. Two types of continuous 

recording can be enabled: 

A combination of continuous RMS, Frequency, and Phase. You enable or disable these three choices 

together. They have a 999-day maximum circular buffer, 30 days is default. You can view these types of 

continuous recording in near real-time in the APP Recorder window. 

Note: Phase angle is shown relative to a selected channel.  

Continuous oscillography recording. This has a 999-day maximum circular buffer, however, 15 days is 

more practical and depends on the number of analog channels and hard drive size. 

Figure 100: Continuous Recording Menu 

7.14.1 Viewing the Continuous Recording Status Window 

You can verify that the APP Recorder is actively calculating quantities and saving data by viewing the 

status window. The APP Recorder stores the continuous oscillography data and calculated RMS, 

Frequency, and Phase quantities in the following folders: 

▪ C:\APP Recorder\Data\OsclgrDatq 

▪ C:\APP Recorder\Data\RmsData 

▪ C:\APP Recorder\Data\FreqData 

▪ C:\APP Recorder\Data\PhaseData 

Trend files are created in the RmsData and FreqData Folders as well. COMTRADE files are created for 

the Trend files automatically every 10 minutes. 
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➢ To View the Continuous Recording Status Window 

In the APP Recorder window, from the Continuous Recording menu, click Show Status Window.  

The following window appears. 

 

Figure 101: Continuous Recording Status Window 

7.14.2 Saving Oscillograph Data 

You can save a time slice of data to a file. You can open and view the file with the APP ClearView 

program.  

1. In the APP Recorder window, from the Continuous Recording menu, point to 

Oscillograph and then click “Save Oscillograph Data…”. The following window appears. 

 Figure 102: Time Slice Entry Window 

2. In the Begin: and End: fields, enter time slice values. 

3. Click the Select Channels button to select the channels you want.  If you do not select 

specific channels, then all analog channels will be retrieved. 
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4. MAX File Size, Enter the file size in Megabytes for the file size you wish to allow. Typically, 

you want to make the file size large enough to capture full record resolution. The continuous 

oscillography is normally recorded at 16 samples per cycle. So, increase the file size until the 

“#samples/cycle = 16” (see bottom of the window in Figure 102: Time Slice Entry Window). 

The same is true for the other continuous recording types. If the file size entered results in a 

number of samples/cycles less than full resolution, then data samples will be reduced equally 

throughout the record length. This may result in an unusual looking wave form. 

 

5. Repeat for #Hour, will repeat the interval by adding 1 hour to the Start and End then repeat 

the process for the number of hours entered.  

Enter the number of hours to repeat the interval. 

 

6. click OK. 

7.14.3 Saving Frequency Data 

You can save a time slice of data to a file. You can open and view the file with the APP ClearView 

program. 

Continuous frequency is calculated using a sliding window. A single frequency data point is calculated 

using 5000 data samples (total cycles/time). At a recording rate of 600Hz it will take 8 seconds to obtain 

the first data point. Thereafter, a point is calculated every X cycles (X is the user entered cycles/point value, 

see Point Assignment Record) but still using 5000 data points. 

➢ To Save Frequency Data 

1. In the APP Recorder window, from the Continuous Recording menu, point to Frequency and 

then click Save Freq. Data.  

2. Complete the entry fields 

Figure 103: Save Freq Data File 

3. Trend Check Box, checking the Trend box will create a Frequency Comtrade file for all 

channels or specified channels, including a Maximum, Minimum, and Average Voltage value for 

each interval over the period indicated. 

 

Do you want to capture frequency data over a period of time, contingent on the number of days set 

in the PAR General Settings tab, Continuous Recording Freq + RMS + Phase, # of Days, and 

maintain a manageable file size? 

• If yes, click the Trend check box and enter an interval in minutes typically 1 minute is used.  

At the bottom of the window, you can see the expected file size and the effect of interval 

minutes selected. 

• If no, then skip to the next step 
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Note: Trend and Repeat for #Hour cannot be used at the same time. If you check the Trend box, 
the Repeat for #Hour will be unavailable on the screen. 

4. MAX File Size, Enter the file size in Megabytes for the file size you wish to allow. Typically, you 

want to make the file size large enough to capture full record resolution. The continuous 

oscillography in normally recorded at 16 samples per cycle. So, increase the file size until the 

“#samples/cycle = 16” (see bottom of the window in Figure 103: Save Freq Data File)The same is 

true for the other continuous recording types. If the file size entered results in a number of 

samples/cycle less than full resolution, then data samples will be reduced equally throughout the 

record length. This may result in an unusual looking wave form. 

5. Repeat for #Hour, will repeat the interval by adding 1 hour to the Start and End then repeat the 

process for the number of hours entered. To use Repeat for #Hour do not check the Trend box 

 

Enter the number of hours to repeat the interval.  

6. Click OK. 

7.14.4 Saving RMS Data 

You can save a time slice of RMS data to a file. You can open and view the file with the APP ClearView 

program. 

➢ To Save RMS Data 

1. In the APP Recorder window, from the Continuous Recording menu, point to RMS and then 

click Save RMS Data 

2. In the Begin: and End: fields, enter time slice values. 

3. Click the Select Channels button to select the channels you want.  If you do not select specific 

channels, then all analog channels will be retrieved. 

4. Trend Check Box, checking the Trend box will create an RMS Comtrade file for all channels or 

specified channels, including a Maximum, Minimum, and Average Voltage value for each 

Interval over the period indicated. 

 

Do you want to capture frequency data over a period of time, contingent on the number of days set 

in the PAR General Settings Tab, Continuous Recording Freq + RMS + Phase, # of Days, and 

maintain a manageable file size? 

• If yes, click the Trend check box and enter an interval in minutes typically 1 minute is used.  

At the bottom of the window, you can see the expected file size and the effect of interval 

minutes selected. 

Figure 104: Create Comtrade RMS Data File 
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• If no, then skip to the next step 

Note: Trend and Repeat for #Hour cannot be used at the same time. If you check the 
Trend box, the Repeat for #Hour will be unavailable on the screen. 

5. MAX File Size, Enter the file size in Megabytes for the file size you wish to allow. Typically, you 

want to make the file size large enough to capture full record resolution. The continuous 

oscillography in normally recorded at 16 samples per cycle. So increase the file size until the 

“#samples/cycle = 16” (see bottom of the window in (Figure 102: Time Slice Entry Window). The 

same is true for the other continuous recording types. If the file size entered results in a number of 

samples/cycle less than full resolution, then data samples will be reduced equally throughout the 

record length. This may result in an unusual looking wave form. 

6. Repeat for #Hour, will repeat the interval by adding 1 hour to the Start and End then repeat the 

process for the number of hours entered. To use Repeat for #Hour do not check the Trend box 

 

Enter the number of hours to repeat the interval.  

7. Click the OK button 

7.14.5 Saving Phase Data 

You can save a time slice of data to a file. You can open and view the file with the APP ClearView 

program. You can also change the relative phase angle that is shown APP Recorder main window 

(continuous metering window). 

➢ To Save Phase Data 

1. In the APP Recorder window, from the Continuous Recording menu, point to Phase and then 

click Save Phase Data.  

2. In the Begin: and End: fields, enter time slice values. 

3. Click the Select Channels button to select the channels you want.  If you do not select specific 

channels, then all analog channels will be retrieved. 

  

Figure 105: Create Comtrade Phase Data File 
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4. MAX File Size, Enter the file size in Megabytes for the file size you wish to allow. Typically, you 

want to make the file size large enough to capture full record resolution. The continuous 

oscillography in normally recorded at 16 samples per cycle. So increase the file size until the 

“#samples/cycle = 16” (see bottom of the window in (Figure 105: Create Comtrade Phase Data 

File). The same is true for the other continuous recording types. If the file size entered results in a 

number of samples/cycle less than full resolution, then data samples will be reduced equally 

throughout the record length. This may result in an unusual looking wave form. 

5. Repeat for #Hour, will repeat the interval by adding 1 hour to the Start and End then repeat the 

process for the number of hours entered.  

 

Enter the number of hours to repeat the interval.  

6. Click the OK button. 

7.14.6 Save Phase Data - Change Reference Channel 

You can change the reference channel for Phase data. 

1. In the APP Recorder window, from the Continuous Recording menu, point to Phase and then click 

change Reference Channel. 

2. Enter the Analog Channel number to make the reference. 

3. Click OK 

7.14.7 Saving RMS-Plus Phase Data 

You can save a time slice of data that contains both continuous RMS values and continuous Phase values to 

a file. You can open and view the file with the APP ClearView program. The data is displayed in channel 

sequential order. 

*IMPORTANT*  If you created a line group, then you can view power and impedance graphs for this 

data time slice. 

  

Figure 106: Change Phase Reference Channel 
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➢ To Save RMS-Plus Phase Data 

1. In the APP Recorder window, from the Continuous Recording menu, point to RMS Plus Phase 

and then click Save RMS Plus Phase Data.  

Figure 107: Create Comtrade RMS and Phase Data File 

2. In the Begin: and End: fields, enter time slice values. 

3. Click the Select Channels button to select the channels you want.  If you do not select specific 

channels, then all analog channels will be retrieved. 

4. MAX File Size, Enter the file size in Megabytes for the file size you wish to allow. Typically, you 

want to make the file size large enough to capture full record resolution. The continuous 

oscillography in normally recorded at 16 samples per cycle. So, increase the file size until the 

“#samples/cycle = 16” (see bottom of the window in (Figure 107: Create Comtrade RMS and 

Phase Data File). The same is true for the other continuous recording types. If the file size entered 

results in a number of samples/cycle less than full resolution, then data samples will be reduced 

equally throughout the record length. This may result in an unusual looking wave form. 

5. Repeat for #Hour, will repeat the interval by adding 1 hour to the Start and End then repeat the 

process for the number of hours entered.  

 

Enter the number of hours to repeat the interval.  

6. Click the OK button. 
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7.15 Using Other Tools  

The Tools menu contains additional tools for the APP Recorder. 

Figure 108: Tools Menu Window 

7.15.1 Startup and Running the APP Monitor 

APP Recorder can be set up to automatically start when the computer restarts and using APP Monitor to 

automatically start if APP Recorder is shutdown. When APP Monitor is running, APP Recorder will restart 

within 60 seconds of being closed. This is important to ensure no manual intervention is required to 

maintain APP Recorder operation.  

See Section 5.3 Startup and Running the APP Monitor  

7.15.2 Network Path Logon 

This feature is used to automatically log the DFR onto a network drive at APP Recorder Startup or is 

reinitialized. Fill in the fields shown to achieve connectivity to the desired network drive. To see if 

connection has been established, go to Windows Directory, and see if the desired drive is shown and/or 

accessible. This feature is in lieu of writing your own batch file that launches when the DFR computer 

starts. 

  

Figure 109: Network Path Logon 
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7.15.3 Configuring a DNP3/Modbus Outstation 

➢ Configuring DNP-3 or Modbus Protocol 

You can configure a DNP3 or Modbus outstation for the APP-601 Recorder. The APP-601 Recorder 

provides the following information through DNP-3 and Modbus: 

1. Analog Channel RMS 

2. Analog Channel Frequency 

3. Analog Channel Phase 

4. Fault Location 

5. Trigger Channels 

6. PMU Line (Hz) 

7. PMU Line (kW) 

8. PMU Line (kVar) 

NOTE: The analog channel frequency and phase are obtained by asking for an extended range 
of the analog information. The information needed for DNP-3/Modbus master to translate 
the data after received is located in the file RxxDnp3.txt in setup folder of the recorder. 
This file is generated by the APP-601 Recorder automatically. 

DNP-3/Modbus Prerequisites 

You can configure a DNP3 or Modbus outstation only if the DNP-3/Modbus check box in the Point 

Assignment Record/General Settings has been selected. Additionally, to generate data to output via DNP-

3/Modbus, the extended recording and continuous recording features must be enabled. You can enable 

these on the General Settings tab: Recorder Setup tab in the Point Assignment Setup window. 

➢ Configuring DNP-3 

1. In the APP Recorder window, from the Tools menu, click DNP3/Modbus Config. 

The following window appears. 

Figure 110: DNP-3/Modbus Configuration Window (DNP-3) 
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2. In the Protocol field, select the protocol DNP-3. 

3. In the This Station ID box, type the Recorder ID which was set up in the Recorder Configuration 

window. For information on setting the Recorder ID, see Section 7.7.3 Configuring the Main 

Configuration Settings.  

4. From the COM list, select the desired communication port. 

5. Are you using an RS232 port or a TCP/IP network protocol?  

▪ If you are using a RS232 port, select RS232, then from the Baud Rate list select a baud rate 

that will work with your RTU. For RS232 Pinout See Table 19 RS232 Pinout - DNP3, 

Modbus. 

▪ If you are using a TCP/IP, select Network, then enter the port number. 

5. Sending analog floating points on Class 0: Check this box if you want to send values converted 

to Floating Point instead of HEX values to the RTU. Otherwise, for the RTU to receive HEX leave 

unchecked. 

6. Sending Alarm Bit on Class 0: Check this box if you want to send an alarm bit on class 0 to the 

RTU to indicate if the DFR has an alarm. 

7. From the menu bar, click Save. 

The APP-601 Recorder accepts the DNP-3 objects and variations shown in the following table. 

 

Table 17: DNP-3 Objects and Variations 

Object Variation Description Request 
Function 
Codes 
(dec) 

Request 
Qual 
Codes 
(Hex) 

Response 
Function 

Codes 
(dec) 

Response 
Qual 
Codes 
(Hex) 

1 1 Binary Input 1 06 129  

2 2 Binary Input 

Change with 

Time 

1 06 129 28 

30 4 16-Bit 

Analog Input 

without Flag 

1 06, 01, 28 129 01, 28 

60 1 Class 0 Data 1 06 129 01 

100 1 Short 

Floating 

Point 

1 06, 01, 28 129 01, 28 

  



Using the APP Recorder 7-63 

➢ Configuring Modbus 

1. In the APP Recorder window, from the Tools menu, click DNP3/Modbus Config. 

The following window appears. 

 

Figure 111: DNP-3/Modbus Configuration Window (Modbus) 

2. In the Protocol field, select the protocol Modbus 

3. In the This Station ID box, type the Recorder ID, which was set up in the Recorder Configuration 

window. For information on setting the Recorder ID, see Section 7.7.3 Configuring the Main 

Configuration Settings.  

4. From the COM list, select the desired communication port. 

5. Are you using an RS232 port or a TCP/IP network protocol?  

• If you are using a RS232 port, select RS232, then from the Baud Rate list select a baud rate 

that will work with your RTU. For RS232 Pinout See Table 19 RS232 Pinout - DNP3, 

Modbus 

• If you are using a TCP/IP, select Network, then enter the port number. The standard port is 

502 for Modbus. 

6. From the menu bar, click Save. 

APP-601 Recorder accepts the Modbus Function Codes as shown in Table-13. 

 Table 18: Modbus Function Codes 

Function 
Code 

Modbus Function 
Name 

Recorder Function 

2 Read Discrete Input Binary Input 

4 Read Input Registers 16-Bit Analog Input 

 

RS232 Com1 and Com2 Pinouts 

Pin outs for Com1 and Com2 are below. We only use RXD and TXD which are pins 3 and 5 for both Com1 

and Com2. 
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Table 19 RS232 Pinout - DNP3, Modbus 

7.15.4 To Configure a DNP3/Modbus Outstation Point Mapping TAB 

➢ Click Point Mapping Tab  

The Point Mapping Tab allows you to limit the records sent to the RTU. You can limit the channels for 

RMS, Frequency and Phase, as well as limit the Lines provided for Fault Location. 

If the Point Mapping table is empty, only analog channels RMS, and no frequency, phase or fault 

location will be sent, and the order for analog channels will be analog channel 1, 2, 3 and so on. If the 

table is not empty, then only the ones on the table will be sent and according to the order on the table. 

For fault location, the unit is in miles and is multiplied by 10 for 16-bit analog input. For example, a fault 
location of 24.6 miles will be represented by 246. The fault location can be configured to be reset to 0 in 
number of minutes or never reset until next valid fault location has arrived.  

Figure 112: Point Mapping 
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 Right click in the open screen to get mapping menu 

• Select one of the five options for adding Channels or lines to the mapping. 

• Analog Channels for RMS 

• Analog Channels for Frequency 

• Analog Channels for Phase 

• Lines for Fault Location 

• Trigger Channel 

• PMU Line (Hz) 

• PMU Line (kW) 

• PMU Line k(Var) 

Note: When adding Trigger Channels, a trigger must be configured in the Point 
Assignment Record. 

Each record will be labeled with a number and type: R=RMS, F=Frequency, P=Phase, L=Line, 

T=Trigger. 

1. Order the list by selecting one or more and click Move Up or Move Down. 

2. Remove from the list by selecting one or more and click Delete. 

3. You can save a Text File of the list by clicking Save Point Map as Text then browsing to the 

folder you want and type a name and click OK. 

➢ To View the DNP3/Modbus Communication Status  

You can view the DNP3 communication status while the APP Recorder is running.   

1. In the APP Recorder window, from the Tools menu, click DNP3. The DNP-3/Modbus 

Configuration Window appears as shown in Figure 110. 

2. From the menu bar, click Show Status. The window appears, as shown in the following figure.  

Figure 113: DNP-3/Modbus Status Window 

7.15.5 Emailing a Fault Summary Record  

You can email a Fault Summary record at any time to those email addresses that you configured to receive 

it. For information on setting up these email addresses, see Configuring Email Settings on page 7-23. 

Note: The Fault Summary record is sent to all of the configured email addresses. 
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➢ To Email a Fault Summary record  

In the APP Recorder window, from the Tools menu, click Email FSum. 

The Fault Summary record is immediately sent. 

7.15.6 Showing the Email Settings Window 

Email configuration settings, including the list of recipients who receive Fault Summary Reports, are 

centrally managed in the Email Settings window. You can access this window when you configure the APP 

Recorder (Edit menu, Configuration menu option). A more direct route is to access the Email Settings 

window directly from the Tools menu.  

➢ To Show the Email Settings Window 

In the APP Recorder window, from the Tools menu, click Show Email Window. 

The Email Settings window appears. For information on these settings, see Configuring Email 

Settings on page 7-23. 

7.15.7 FTP a Fault File  

A fault file contains an individual fault record. 

If a Fault file is stalled in the FTP buffer, you can manually send it via FTP to the host directory. The APP 

Recorder uses the FTP settings that you configured. For information on the FTP configuration settings, see 

Configuring FTP Settings on page 7-26. 

➢ To FTP a Fault File  

In the APP Recorder window, from the Tools menu, click FTP Fault File. 

The file is immediately sent. 

7.15.8 Show FTP Window 

FTP configuration settings are centrally managed in the FTP Settings window. You can access this window 

when you configure the APP Recorder (Edit menu, Configuration menu option). A more direct route is to 

access the FTP Settings window directly from the Tools menu. 

➢ To Show the FTP Settings Window 

In the APP Recorder window, from the Tools menu, click Show FTP Window. 

The FTP Settings window appears. For information on the FTP configuration settings, see Configuring 

FTP Settings on page 7-26. 

7.15.9 Configuring a DSP/TW Board’s Ethernet and IP Address Settings 

Before an APP-601 Recorder leaves the factory, each of its DSP/IRIG boards is programmed with an 

Ethernet Address, IP Address, Subnet Mask, and Default Gateway. In a centralized or turn-key system, it is 

highly unlikely the Ethernet or IP Addresses will ever need to be changed. However, if the factory ships an-

add on Data chassis for a distributed architecture system and does not know the location of the installation, 

you will need to program the appropriate DSP Ethernet Address and IP Address upon receipt. 

You can configure the DSP board using one of 2 connection approaches. By RS232 or by Ethernet cable 

using UDP. See below the instructions for each connection approach. Advanced users only should attempt 

using the Ethernet/UDP connection approach. 
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Examples of Ethernet and IP Addresses   

The Ethernet and IP addresses should increase by an increment of 1 for each successively installed Data 

chassis. For example: 

            Computer Control Chassis (Typical) 

IP Address:       192.168.203.220 

            Subnet Mask:     255.255.255.0 

            1st Data Chassis (Typical) 

            Ethernet Address   = 2-35-69-86-203-1             

   IP Address     = 192.168.203.1 

            Subnet Mask    = 255.255.255.0 

            Default Gateway  = 192.168.203.220 

            2nd Data Chassis (Typical) 

            Ethernet Address   = 2-35-69-86-203-2             

   IP Address     = 192.168.203.2 

            Subnet Mask    = 255.255.255.0 

            Default Gateway  = 192.168.203.220 

            3rd Data Chassis (Typical) 

            Ethernet Address   = 2-35-69-86-203-3             

IP Address     = 192.168.203.3 

            Subnet Mask    = 255.255.255.0 

            Default Gateway  = 192.168.203.220 

            The same pattern would be followed for additional Data chassis. 

*Caution*  Duplicating an IP Address on two Data Chassis could cause the DSP 
Board to need repair if left in conflicting state too long. 

*WARNING*  See Installation Section on page 3-1, for proper installation and 
chassis power up instructions. Ensure that any newly installed 
chassis are earth grounded before powering up. 

Note: IP and Ethernet address  can be different depending on customer requirements 

➢ To Configure a DSP Board’s Ethernet and IP Address Settings Using RS232  

1. Disconnect any Ethernet cable plugged into the DSP RJ45 connector.  

2. Connect an APP-provided programming cable from the computer control chassis RS232 port 

(which is usually COM1) to the 6-pin Mini-Din on the DSP circuit board. 

Note: If the programming cable will not reach from the DFR computer to the desired DSP 
board, you can also make the change from APP ClearView, which can run on your 
laptop.  
In this case, start the APP ClearView program, connect the programming cable between 
your laptop (COM 1) and the DSP board, click on Tools, and then click on DSP Board’s 
Ethernet Settings. A physical connection should be established, and you will be able to 
make the necessary settings changes. If a connection is not established, verify that your 
laptop and the setting on the DSP Board’s Ethernet Settings are set to the same Com 
Port (usually COM 1). 
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3. Verify that the Data chassis is powered on. 

4. In the APP Recorder window, from the Tools menu, click DSP/TW Board’s Ethernet Settings. 

The following window appears. The default connection screen is RS232. If you click the UDP 

check box, the screen changes to the UDP screen described below. 

Figure 114: DSP Board Setup Window – RS232 

5. DSP Board check boxes; Auto Negotiate (Auto Neg), 100 Mbit, and Full Duplex. These are to 

configure physical connectivity parameters to the APP Recorder or to a communications device 

(switch). Auto Neg is the default setting and is used when connected directly to the APP Recorder 

computer or to an APP Engineering supplied switch. Customer specified programmable switches 

not set to Auto Negotiate may need to check the 100Mbit and Full Duplex options to successfully 

communicate with the switch. 

6. Make the necessary updates to the address fields.  See Examples of Ethernet and IP Addresses 

above for more information. 

7. Click Update. 

➢ To Configure a DSP Board’s Ethernet and IP Address Settings using Ethernet/UDP  

*Caution*  Advanced users only should attempt using the Ethernet/UDP connection 

approach. 
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1. Connect Ethernet cable plugged into the DSP RJ45 connector to the Ethernet port of the computer 

you will use to configure DSP. You can also use the Recorder Computer. 

2. Ensure your computer Firewall software is off/disabled. 

3. Verify that the Data chassis is powered on. 

4. In the APP Recorder window, from the Tools menu, click DSP/TW Board’s Ethernet Settings. 

Click the UDP check box, the screen changes to the UDP screen shown below. 

5. Enter the IP address of the DSP board. The multicast address will appear as default. If the 

computer has multicast enabled, you may be able to use that address. Otherwise, enter the IP 

address of the DSP board. This can be found in the Point Assignment Record, Chassis TAB. 

6. Ports, The PC and DSP Port number defaults will appear. You should use the default assignments. 

7. Click the OK button to the right and the MAC, IP, Subnet, and Default Gateway addresses should 

appear. 

8. DSP Board check boxes; Auto Negotiate (Auto Neg), 100 Mbit, and Full Duplex. These are to 

configure physical connectivity parameters to the APP Recorder or to a communications device 

(switch). Auto Neg is the default setting and is used when connected directly to the APP Recorder 

computer or to an APP Engineering supplied switch. Customer specified programmable switches 

not set to Auto Negotiate may need to check the 100Mbit and Full Duplex options to successfully 

communicate with the switch. 

9. Make the necessary updates to the address fields.  See Examples of Ethernet and IP Addresses on 

page 7-66 for more information. 

10. Click Update. 

 

*CAUTION*  If you change an IP Address, be sure to enter the new DSP IP Address 
in the Point Assignment Record. See Figure 32: Point Assignment 
Window’s Chassis Configuration 

Figure 115: DSP Board Setup Window - UDP 
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7.15.10  File Compare 

File Compare enables viewing two text files to find differences. A primary use could be to find the 

differences in versions of a Point Assignment Record (PAR) 

Click file Compare in the Tools Menu 

Figure 116 File Compare window 

Select two files by clicking the explorer button to the right of each file field and navigate to the files you 

would like to compare.  

Once both files are listed, click Compare button. Once the compare is complete, the differences will 

appear in Red.  

If you click the Animate box, the compare process will show the changes as comparison progresses down 

the files. 

The Status line at the bottom displays compares status and difference in character count. 
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Figure 117 File Compare Results 

7.16 Configuring a Phasor Measurement Unit (PMU)  

The APP-601 Recorder PMU feature supports the IEEE Standard C37.118-2005, which describes the 

functional requirements for PMUs and basic data measurement and verification requirements. For 

additional information on the benefits of using PMUs, go to www.naspi.org 

Before you can configure a PMU, you must configure the following information in the Point Assignment 

Record: 

▪ Select the PMU check box 

▪ Specify the analog channels  

➢ To Configure the Point Assignment Record for PMU Data 

1. In the APP Recorder window, from the Edit menu, point to Point Assignment Record and then 

click Edit Record. 

The Point Assignment Record window appears. 

2. Click the General Settings tab. 

3. Click the Recorder Setup tab. 

4. Select the PMU check box.  

5. From the menu bar, click Save. 

A message window appears confirming the save operation. 

6. Click the OK button. 

7. Click the Analog Channels tab. For more information on how to set up analog channels, see the 

APP ClearView Instruction Manual. 

  

http://www.naspi.org/
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➢ To Configure a PMU 

1. From the File menu, click Show Driver then click PMU. The PMU window appears, as shown in 

the following figure.  

Figure 118: PMU Window 

2. Data may be streamed via Ethernet or RS232 

3. In the Data Rate box, type the desired data rate. 60 per second is the maximum setting.  If you are 

streaming many lines and select 60 frames per second, ensure enough network bandwidth is 

allocated. 

4. In the ID box enter an ID number that matches the ID number set in the data concentrator (many 

times it is 1.) 

5. If streaming by Ethernet, select the desired protocol. 

a) UDP will stream commands, configuration, and data via UDP 

b) UDP_T will stream commands, and configuration via TCP and data via UDP 

c) TCP will stream commands, configuration, and data via TCP 

d) UDP_U will stream commands via TCP and configuration, data via UDP 

In the IP box, type the IP address to where the information will be sent. Default port number for 

TCP is 4712 and the default port number for UDP is 4713.  Check with your IT or PMU data 

concentrator administrator to ensure these are the desired ports. 

IP2, if you have a second IP address you want data streamed to in parallel with the primary IP, 

Check the box and enter the IP address for IP2. 
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Allow Any IP, If you want any IP to be able to connect to the recorder click the check box. This 

will override the IP and IP2 fields. 

# IP Connected shows the number of connections made. 

6. If you stream information to a data concentrator that needs to connect via RS232 then check mark 

RS232 box and make the appropriate settings.  For the recorder, go to the Windows device 

manager (Ports) to determine which com port is active. The port can change depending on the 

computer type and features purchased. 

7. Lines Field You can manage the line(s) included using the Add, Delete, Edit buttons to add 

remove or change Lines. 

8. Stn (PMU) Field allows you to include a custom station label. Type the Station name associated 

with the Line if desired. 

9. Append Phase at end of Desc, checking the box causes the format of the Line and Phase 

information being streamed to be reversed and places the Phase at the end instead of the beginning 

which is the default. 

10. VPP to VPN (VPP/sq root(3), Phase – 30deg), checking the box causes line voltages to be 

converted to VPN (Amplitude/ sqrt(3) and phase – 30 Degrees). 

11. Va-Vab, Vb=Vac, Vc=Vn check box should be checked when the connection to the analog 

channel is Phase to Phase instead of Phase to Ground in order to send the correct values. 

12. Under What to Send, select the appropriate channels for Va, Vb, Vc, Ia, Ib, and Ic. To do this, 

click the corresponding pull-down menu and select the desired channel.  

13. Use the +A boxes if you would like to add them to the stream. Enter the number of the Current 

Channel you would like to add. 

Note:  The analog channels that appear here are configured in the  
Point Assignment Record. 

14. The  button opens the list of channels and allows you to select any or all and inserts 

them. Select the channels in the correct sequence they should appear. 

*CAUTION*  When Using Quick Pick to select channels You need to click the check Boxes in 
the correct order. Not doing so could result in lost data. 

Note: Before you select the channels, be sure that the Point Assignment Record is complete. 

15. Specify the sending format by clicking the drop down menu and selecting one of the following:  

▪ If only the positive sequence voltage and positive sequence current should be streamed, select 

the sending format set (V1, I1). 

▪ If the phasor for each channel should be sent with the calculated positive sequence voltage 

and positive sequence current, select the sending format (Va, Vb, Vc, Ia, Ib, Ic, V1, I1).  

▪ If the phasor for each channel should be sent select (Va, Vb, Vc, Ia, Ib, Ic) 

▪ If the phasor for each channel should be sent with the calculated positive sequence voltage 

and positive sequence current, the negative sequence voltage and negative sequence current, 

and the zero sequence voltage and zero sequence current select the sending format (Va, Vb, 

Vc, Ia, Ib, Ic, V1, I1, V2, I2, V0, I0).  

▪ If the phasor for all channels in the DFR should be sent, select the sending format All Analog 

Channels. 
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▪ If no phase group should be sent select No Phase. 

 These values can be sent for several lines. The limit on the number of lines that can be sent is 

dependent on the total analog channel count, sampling rates, and system computer selection.  

 

Figure 119: PMU - Sending Format 

16. Plus Analog check box allows you to add analog channels to the PMU to include the state of each 

analog channel. When you click the Plus Analog check box, a list of the analog channels appears 

for you to select the channels to include. 

Select the channels and click OK 

17. Plus Events check box allows you to add event channels to the PMU to include the state of each 

event channel. When you click the Plus Event check box a list of events appears for you to choose 

which events to include. 

Select the channels and click OK 
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18. Plus Triggers check box allows you to add trigger channels to the PMU to include the state of 

each analog channel. When you click the Plus Triggers check box, a list of the trigger channels 

appears for you to select the channels to include. 

Select the Channels and click OK 

19. Send UTC time, if you want to send the time stamp to the PMU in Coordinated Universal Time 

(UTC), click the check box for Send UTC Time. This will not affect the local time stored on the 

DFR.  

20. The DATA section provides the ability to dynamically view the channels’ current values by 

selecting the channel in the drop down. 

 

Are the Va, Vb, and Vc inputs true 3-phase?  

▪ If yes, then select the Use Va to measure frequency check box. 

▪ If no, skip to the next step.  

21. Click Update. 

The settings are now saved in the APP Recorder\Setup folder under RnnPmu.inf where Rnn is the 

recorder ID. There are RnnPmu backup files created as well.  

22. Click Close.  

Note:  Clicking Close does not automatically save the settings.  
Remember to click Update. 

23. Click Graphs menu to see graph options.  

The Graph option will display the channels selected in Vector diagrams or an RMS sine wave. 

Selecting Vectors will bring up the Phasor Diagram screen and options as described in the Clearview 

Instruction Manual. Please see Section 13.20 for more information. 

Figure 120: PMU Graphs Options 
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Selecting Line RMS will display a graph of the Voltage and current channels selected in the PMU 

configuration 

7.17 Viewing the Help and About Information 

You can view the online help for the APP Recorder. The About information includes the driver version and 

factory contact information. 

➢ To View the Help  

In the APP Recorder window, from the Help menu, click Recorder Help. 

➢ To View the About Information  

In the APP Recorder window, from the Help menu, click About. 

➢ To set up GPU FTP 

GPU-FTP is for testing FTP to GPU computer and uploading cfg.gpu. Clicking GPU-FTP opens the 

FTP settings window.  For more on FTP settings see 7.7.11Configuring FTP Settings 

 

Figure 121: PMU Line RMS Graph 
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8. Using the APP Driver 
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8.1 Introduction to the APP Driver 

The APP Recorder Driver is the program that manages the physical APP Recorder hardware. You can 

access the APP Driver from within the APP Recorder program.  

In the APP Driver, you can view communications between the following items: 

The APP Recorder and the APP Driver  

The APP Driver and all the system DSP circuit boards  

The computer control chassis and all the data chassis 

8.2 Viewing the APP Recorder Driver Window 

➢ To View the APP Recorder Driver Window 

 From the APP Recorder window, open the File menu, and click Show Driver. 

The APP Recorder Driver window appears.  

Figure 122: The APP Recorder Driver Window 

The Information area contains the following fields: 

Time Mark 

This field displays the absolute times of the 1PPS signal for all the DSP boards. The times are updated 

every 30 seconds. If multiple times are displayed, meaning that there are two or more DSP boards, they 

should be the same. The format is HH:MM:SS (Point of Day time diff from clock) any time difference will 

typically be corrected within a minute after a restart or reinitialize.by the driver sending a time correction to 

the DSP. 

#Packet (Ex) 

If extended recording is enabled, then you can see packet transfers (or data flow) from the DSP circuit 

boards to the computer hard drive.  

#Recovery (Ex) 

If the extended recording feature is enabled in the Point Assignment Record (General Settings tab: 

Sampling tab), then this area will display a running total of the number of times packets had to be re-sent 

from the DSP board to the computer hard drive. 
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(>65C, C) 

The temperatures of the DSP boards are displayed here. In a normal situation, the display may look 

something like (0, 45C). The zero indicates that the DSP temperature is below 65C and it is now 45C. If the 

temperature on the board is over 65C, the zero will become one. Because the indicator (0 or 1) is sensed 

differently than the reading, you can trust that the temperature reading is correct. 

 

TW-TimeMark 

This field displays the absolute times of the Unmodulated IRIG-B signal for the Traveling Wave 

boards. The times are updated every 30 seconds.  

The bottom tray displays the next fault identification number (FID), the fault date and time, and the sync 

status of the fault time. 

8.3 Reinitializing the APP Driver 

You may need to reinitialize the APP Driver to perform troubleshooting or maintenance. Reinitialize will 

also reset the DSP. Use this if the driver shows DSP not responding for 2 min. 

*CAUTION* During this process the APP Recorder will momentarily go offline.   

➢ To Reinitialize the APP Driver 

From the APP Recorder Driver menu bar, click Reinitialize. 

The APP Driver is reset and restarted.  

8.4 Exiting the APP Driver   

Exit the APP Driver window whenever you do not need to view it. 

➢ To Exit the APP Driver Window 

In the APP Driver window, click the X in the upper right-hand corner of the window. 

Note: The APP Driver is still running in the background 

8.5 Doing a Diagnosis 

A diagnosis provides a general overview of the health of the Driver. 

➢ To Do a Diagnosis  

In the APP Driver window, from the menu bar, click Do Diagnosis. 

The results will appear in the upper black area in the information area. 

8.6 Performing a Test Run from the APP Driver 

You can do a test run from within the APP Recorder or the APP Driver. For more information, see 

Performing a Test Run in Section 6. Also, from the APP Driver you can do a Test run of the Traveling 

Wave Channels. 

➢ To Do a Test Run from the APP Driver 

In the APP Driver window, from the menu bar, click Test Run, then select Test Run or Test run at 

Start of Minute from the menu. 

The results will appear in the upper black area in the information area. 
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➢ To Do a Traveling Wave Channel Test Run from the APP Driver 

In the APP Driver window, from the menu bar, click Test Run, then select Test Run All TW 

Channels from the menu. 

The results will appear in the upper black area in the information area. 

8.7 PMU 

If PMU was selected in the Point Assignment Record General Tab, then the PMU option will appear on the 

APP Recorder Driver screen. Clicking PMU will bring up the PMU Configuration Screen.  

For more information on configuring PMU see Section 7.16 Configuring a Phasor Measurement Unit 

(PMU). 

8.8 Viewing the Help and About Information 

You can view the online help for the APP Driver. The information in the About window includes the driver 

version and factory contact information. 

Note:  If the help files do not answer your question(s), please do not hesitate to contact APP 
Engineering, Inc. at (317) 536-5300. 

➢ To View the Help  

In the APP Driver window, from the Help menu, click Help. 

➢ To View the About Information  

In the APP Driver window, from the Help menu, click About. 
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9. Using the OScope  
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9.1 Introduction to the OScope 

The OScope window is very useful when setting up the APP Recorder for the first time. It allows you to 

view real-time analog signals, analog trigger status, event status, and to perform analog channel calibration. 

9.2 Viewing the OScope (Oscilloscope) Window 

*CAUTION*  When you open the OScope window, the APP Recorder automatically 
goes offline. Also, remember to exit the OScope function when you 
are finished using it. It will not automatically shut down and the APP 
Recorder will remain offline for as long as the OScope window is 
open. 

➢ To View the OScope Window 

1. Do one of the following: 

▪ From the APP Recorder window, from the File menu, click Show OScope. A confirmation 

window will appear to be sure you want to enter Oscope and stop recording. Click OK to 

continue to OScope. 

▪ From the APP Driver window, from the menu bar, click OScope. 

The APP OScope window appears.  

Figure 123: OScope Window, Analog Tab 

9.2.1 Analog Tab 

You can view DC or AC analog signals in the Analog tab (see Figure 123: OScope Window, Analog Tab).  

The X-axis is defined by signal frequency and the desired number of cycles to be displayed. Enter the 

number of cycles in the Show #Cycles field. 

The Y-axis is determined by the Channel Full Scale setting in the Point Assignment Record, and the Y-

scale setting in the upper right-hand corner of the OScope window. For more information on these settings, 

see Yscale Controls below. 
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9.2.2 Events Tab 

The Events tab shows the status of the event channels. An “O” indicates an open contact, and an “X” 

indicates a closed contact. If the box is green the channel is in a normal state. If the box is red the channel is 

in an abnormal state.  

Figure 124: Oscope Window, Event Status Tab 

9.2.3 Triggers Tab 

The Triggers tab indicates which analog channels are in a trip condition: 

Green indicates a normal condition. 

Red indicates a trip condition.  

The analog channels that appear here are defined in the Point Assignment Record.  

 

Figure 125: OScope Window, Analog Trigger Status Tab 
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9.2.4 Yscale Controls 

In the YScale box, you can select from three options for the Y Scale. The following table describes these 

options. 

Table 20: OScope Window—Y Scale Options 

Option Description 

Full Scale If Full Scale is selected, the displayed Y-axis maximum and minimum 

will be approximately 70% greater than the channel full scale listed in the 

Point Assignment Record.  

Abs. Full Scale 

 

Abs. Full Scale is short for “absolute full scale”. This value is dependent 

on the channel full scale setting, but it reflects the absolute full scale as 

defined by the hardware divider and hardware gain circuitry values.  

The displayed Y-axis maximum and minimum will be approximately 70% 

greater than the channel full scale listed in the Point Assignment Record. 

Hardware divider values are limited to 31 choices that range from 0.309 to 

954.214 and only apply to voltage inputs. 

Hardware gain circuitry values are limited to 16 choices that range from 

77.277 to 1024.667 and apply to voltage and current inputs.  

Therefore, when you select a full scale value, the software automatically 

calculates an absolute full scale value based on the finite hardware 

choices. The absolute full scale is the amplitude at which the input signal 

will clip. 

Optimize If you select Optimize, the Y-axis will automatically adjust to display the 

input signal(s) as large as possible. 

9.2.5 Meter Controls 

In the Meter Controls group, you can indicate whether you want to display the RMS meter value and DC 

Offset value in primary or secondary values. The CT and PT multiplying values can be seen in the Point 

Assignment Record. 

9.2.6 Analog Channel Controls 

In the Show Analog Channels group, you can select which chassis and channel number to display. You 

can view more than one input signal at a time. If you want to show multiple channels, click the starting 

analog channel, then how many sequential channels you would like to view and the number of cycles to 

display. You can view up to 14 sequential channels at one time. Channels can only be viewed in sequence. 

9.2.7 Run Controls 

The Run Controls area in the right hand column contains Run, One Shot, and Stop buttons: 

Click Run to put the OScope in free run and see continuous updates in the display area and in the meter 

boxes.  

Click One Shot to perform a one-time update to the display area and meter boxes. 

Click the Stop button to freeze the display and meter boxes.  
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9.2.8 Bottom Tray 

The bottom tray shows the chassis number being viewed, the run/stop status of the OScope, the fault timer, 

and the sync status of the fault timer. If the sync status is followed by “unknown”, the recorder cannot 

detect any IRIG-B input. See Section 11.1 Time Quality for time quality details.  

9.3 Reinitializing the OScope Window 

Reinitialize the APP OScope window to restart the OScope and update the Display Window. 

➢ To Reinitialize the OScope Window 

In the APP OScope window, from the File menu, click Reinitialize.  

9.4 Exiting the OScope Window   

When you exit the OScope window, the APP Recorder returns to its normal, online status.  

➢ To Exit the OScope Window 

In the APP OScope window, from the File menu, click Exit.  

9.5 Editing the Point Assignment Record 

You can edit the Point Assignment Record from within the OScope window. 

In the APP OScope window, from the Edit menu, click Edit Point Assignment Record. 

The Point Assignment Record window appears. For complete details on how to create and edit the 

Point Assignment Record, see the APP ClearView Operating Manual.  

9.6 Viewing Driver Status 

You can view detailed information about the status of a channel, including key messages sent between the 

system DSP boards and the system computer. 

➢ To View the Driver Status 

In the APP OScope window, from the Status menu, click Show Driver Status. 

The DSP Board Communication Status window appears. 

 Figure 126: DSP Board Communication Status Window 
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The following table describes the fields that appear in this window. 

Table 21: DSP Board Communication Status Window—Fields 

Field Description 

Time Mark The absolute times of the 1PPS signal for all the DSP boards, are 

displayed here. The times are updated approximately every 30 

seconds. If multiple times are displayed, meaning that there are two or 

more DSP boards, they should be the same. The format is 

HH:MM:SS(Point of Day time diff from clock) any time difference 

will typically be corrected within a minute after a restart or 

reinitialize.by the driver sending a time correction to the DSP.  

#Packet (Extended) If the extended recording feature is enabled in the Point Assignment 

Record (General Settings tab: Sampling tab), packet transfers or data 

flow, from the DSP circuit boards to the computer hard drive, can be 

seen here. 

#Recovery (Extended) If the extended recording feature is enabled, this area will keep a 

running total of the number of times packets have had to be re-sent 

from the DSP board to the computer hard drive. 

(>65C,C) The temperatures of the DSP boards are displayed here. In a normal 

situation, the display may look something like (0, 45C). The zero 

indicates that the DSP temperature is below 65C and it is now 45C. If 

the temperature on the board is over 65C, the zero will become one. 

Because the indicator (0 or 1) is sensed differently than the reading, 

you can trust that the temperature reading is correct. 

TW-TimeMark The absolute times of the unmodulated IRIG-B signal for the 

Traveling Wave boards. The times are updated approximately every 

30 seconds. If multiple times are displayed, meaning that there are two 

or more TW boards, they should be the same 
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9.7 Viewing Stopped/Abnormal SER Channels 

In the APP OScope window, from the Status menu, click Show Stopped/Abnormal SER Channels. 

The Stopped/Abnormal SER Channels window appears. 

 

Figure 127: Stopped/Abnormal SER Channels Screen 

 

On the SER Report tab, channels that are in a stopped or abnormal state appear. The following 

table explains the letters that appear on this window. 

Table 22: SER Report Tab—Letter Values 

In this column… This letter… Means this… 

State O There is an open contact. 

C There is a closed contact. 

Normal A The channel is currently in an abnormal 

state. 

N The channel is currently in a normal state. 

Sync  U There is an unsynchronized time. 

S There is a synchronized time. 

If an SER channel is stopped, the word “Stopped” will appear at the beginning of the channel 

description. The letter “M” or “A” will also appear with the stop message: 

▪ “M” indicates that the channel has been stopped manually via the Point Assignment Record. 

▪ “A” indicates that the channel stopped automatically.  

Note: If an SER channel frequently changes its state, you can configure the Point 
Assignment Record to automatically address the issue. On the General Settings 
tab in the Point Assignment Record, you can specify the threshold of time for 
allowable state changes (in other words, the acceptable amount of time between 
state changes). If the SER channel changes its state more frequently than the 
acceptable amount, you can configure it to automatically shut down and then to 
restart itself after the period of time that you define.  

9.8 Advanced Menu  

9.8.1 Calibrating and Un-Calibrating All Offsets 

You can calibrate the DC offset on every analog channel with a single click or it can be done on a per 

channel basis. If the scope function is running, it will automatically stop when you calibrate or un-calibrate 

all offsets. Typically, the DC offset calibration is done with NO signals applied to the analog channels. 
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This can be done before energizing the lines, while test switches are opened, test blocks pulled, or sliding 

links are opened to disconnect field signals. 

Note: Before performing offset calibration or a slope calibration let the system run for 
approximately 60 minutes. This will give the electronics time to achieve 
temperature stability.   

Note: When calibrating, be sure no signal is present by ensuring all Test Switches or 
Sliding Links are open. 

The time it takes to do an “all offset calibrate” is dependent on the number of channels but is usually less 

than 20 seconds. The factory performs an offset calibration, with no signals attached, before a recorder is 

shipped to you. After the system is installed and field wires are connected, you should perform 

another offset calibration to eliminate the externally induced DC offset or the effects of DC offset 

when someone changes an analog channel full scale. 

➢ To Calibrate Channel All Offsets 

In the APP OScope window, from the menu bar, click Advanced, then Calibrate All Offsets. 

After calibrating all offsets, we recommend reviewing each channel offset by stepping through the 

channels in the Show Analog Channels section. 

Note: After calibrating, click Run to restart the OScope function.  

➢ To Un-Calibrate All Offsets 

To reverse the calibration procedure and delete software correction factors, you can un-calibrate all 

offsets. 

In the APP OScope window, from the menu bar, click Advanced, then Un-Calibrate All Offsets. 

Note: After calibrating, click Run to restart the OScope function.  

9.8.2 Setting all Analog Channel Inputs to Zero 

On the standard Analog board (not PQ Boards), you can set all analog channel inputs to zero in order to 

stop each analog channel input from reaching the analog board signal acquisition circuitry. You can do this 

to calibrate internal offsets or to perform troubleshooting. 

➢ To Set All Analog Channel Inputs to Zero 

In the APP OScope window from the menu bar, click Advanced then Set All Analog Channel 

Inputs to Zero. 

Note: When using PQ Boards, Zeroing Analog channels will not work. You need to remove signal 
from the PQ boards to set all channels to zero. 
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9.8.3 Reference Analog Channel # for Phase 

You can change the reference channel used when calibrating phase for post processing. The default is 

channel 1.  

➢ To Reference Analog Channel # for Phase 

In the APP OScope window from the menu bar, click Advanced then click Reference all Channel # 

for Phase. A window will appear, enter the Analog Channel number to reference. You will see the 

reference number change in the Calibrate Phase box. 

9.8.4 Turning On All Alarms and LEDs 

If you need to test the front panel LED’s and alarm outputs, you can turn them all on simultaneously. When 

you do this, all of the relay coils will energize and the front panel LED’s should illuminate.  

➢ To Turn On All Alarms and LEDs 

1. In the APP Driver OScope window from the menu bar, click Advanced, then Turn On All 

Alarms and LEDs. 

2. To reset all the alarms and LEDs, from the File menu, click Reinitialize.  

➢ To Turn on a specific Alarm by its number 

1. In the APP OScope window, from the menu bar, click Advanced, then Turn On All Alarms 

and LEDs, then turn on Alarm #. 

2. Enter the number of the desired alarm and click OK.  

Note: You can use 0 for all off and 8 for all on. 

3. To reset all the alarms and LEDs, from the File menu, click Reinitialize.  

9.8.5 Sequence of Analog Channel # 

You can set Analog channel(s) to display along with the Selected Channel. 

1. In the APP OScope window, from the menu bar, click Advanced, then Sequence of Analog 

Channel #. 

2. Enter the number of the desired analog channel(s) comma separated and click OK.  

9.8.6 Rebooting the Driver 

You can reboot the Driver by momentarily cutting the power to the computer and all circuit boards. All 

instruments will experience a hard power shutdown. Power is cut via a normally closed relay on the Data 

chassis power supply circuit board. After 5-10 seconds, power will automatically return and the system will 

restart. It takes approximately 1 minute and 30 seconds for the system to return to an online state.  

➢ To Reboot the Driver 

In the APP OScope window from the menu bar, click Advanced, then Reboot. 
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9.9 Calibrating and Un-Calibrating One Channel at a time 

9.9.1 Calibrating the DC Offset One Channel at a Time 

You can calibrate out the DC offset one channel at a time. If the scope is running, it will automatically stop 

and you will need to click Run to restart the scope function.  

We recommend calibrating the DC offset with NO signals applied.  Before calibrating, notice the DC 

offset value. This Value should reduce after the offset calibration.  Calibrating each channel takes about 6 

seconds. 

You can also calibrate all the channels simultaneously (see the beginning of this section). 

9.9.2 Calibrating and Un-Calibrating Offsets One Channel at a time 

If the full scale value for an analog channel is changed, recheck the offset and determine if another offset 

calibration is required. 

*CAUTION*  It is recommended to recalibrate the DC Offset if the full scale value 
changes. For a voltage channel, A DC offset of 0.01 to 0.04 should be 
achievable. For a current Channel, a DC offset of 0.00 to 0.03 should 
be achievable. 

The offset calibration process creates a file named RxxExCal.ini in path location C:\APP Recorder\Setup. 

The “xx” in the file name is the unique recorder ID number. This is an ASCII file and can be viewed by 

doubling clicking it. An example file entry is, A1=0,0.999965. A1 is the analog channel number, 0 is the 

offset calibration factor for the DC offset, and 0.999965 is the external calibration factor. 

➢ To Calibrate the DC Offset One Channel at a Time   

1. In the Show Analog Channels group in the Analog Channel# box, use the up and down arrows to 

enter the analog channel number to be calibrated. Holding the up or down arrow will scroll quickly, 

and then click the corresponding OK button. 

Figure 128: Show Analog Channels Group 

2. Under Calibrate Offset, click the Calibrate button.  

The text, “Offset Calibrated” appears under the button when complete. 

Figure 129: Calibrate/Un-Calibrate Offset 

Note: After calibrating, click Run to restart the OScope function.  

➢ To Un-Calibrate the DC Offset One Channel at a Time   

1. In the Show Analog Channels group, in the Analog Channel # box, enter the analog channel 

number to be un-calibrated and then click the corresponding OK button. 

2. Under Calibrate Offset, click the Un-Calibrate button.  

The text, “Offset Calibrated” disappears under the button and no text remains. 
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9.10 Calibrating Slope (Performing an External Calibration) 

The APP Recorder will have accurate un-calibrated analog channels as described in the specifications 

section. Therefore, you may not see much improvement in channel accuracy by performing an external 

calibration.  The calibration process takes only a few seconds. 

Note: Ensure that your calibration source or measuring meter is calibrated and has as a 
precision accuracy. 

*WARNING*  Calibration should only be performed by trained, qualified technical 
personnel. Never calibrate a system alone. Ensure that another 
person is present who knows emergency procedures and is capable 
of rendering first aid. 

*WARNING* Carefully disconnect station analog input signals from the recorder 
before applying a known signal from your calibrated, high-precision, 
certified source. Use caution if you are connecting an external 
metering device. Be sure to use the proper connecting leads and 
equipment. 

Note: The following procedure assumes that your known analog signal is connected to a 
recorder analog input. 

➢ To Calibrate Slope (Perform an External Calibration) 

1. In the APP Recorder window from the File menu, click Show OScope. 

The APP OScope window appears. 

2. In the Show Analog Channels group in the Analog Channel # box, enter the analog channel 

number to be calibrated and then click the corresponding OK button. 

3. In the External Calibration Slope group, in the At Secondary box, enter your known accurate 

secondary input calibration voltage or current value.  

Figure 130: External Calibration (Slope) Group 

4. Click the Calibrate button. A warning message may appear saying, “Entered value (xxx.xx) is >10% 

different to the measured value (xxx.xx). Do want to continue?”  

5. Click Yes to proceed or No to abort the calibration process. 

6. Repeat steps 3-5 to calibrate additional channels. 

The calibration process creates an ASCII file named RxxExCal.ini in path location  

C:\APP Recorder\Setup. The “xx” in the file name is the unique recorder ID number. For example, in the 

file name A1=0,0.999965, A1 is the analog channel number, 0 is the internal calibration factor for the DC 

offset, and 0.999965 is the external calibration factor. 

You can view the file by doubling-clicking it. 

The external calibration factor can be reset to 1 by clicking on the “Un-Calibrate” button. 

Note: You must click the Stop button before doing a calibration. 
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9.11 Calibrate Phase (For Post-Processing Only) 

Calibrate phase is used to remove phase shift between the analog channel shown and the reference 

channel selected. For example when using a CT. 

➢ To Calibrate Phase (For Post-Processing) 

1. In the APP Recorder window from the File menu, click Show OScope. 

The APP OScope window appears. 

2. In the Show Analog Channels group in the Analog Channel # box, enter the analog channel 

number to be calibrated and then click the corresponding OK button. 

3. Be sure the Ref channel you want is selected. If not use the Ref Button or the Advanced menu to 

select Reference Channel # for Phase. 

4. Type in the degrees of shift desired in the entry field. 

5. Click Calibrate 

6. Click Un-calibrate to go back to the actual value. 

The show check box provides viewing of two or more channels selected that have been 
calibrated. With Show un-checked the scope will show the actual view. When Show is 
checked the scope will show the calibrated view. 
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10. APP Recorder Helper 
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10.1 Introduction to Recorder Helper 

The APP Recorder Helper program manages Power Quality and Flicker continuous recording file aging 

and deletion and reports, and APP Recorder computer process memory use. When files reach their retention 

end, they are deleted at 5 AM daily based on settings in the PAR. Recorder Helper logs computer memory 

use every ten minutes for the 6 highest memory using processes running. Helper also provides the 

capability to take a snapshot of memory use anytime. Recorder Helper appears in version 3.3.3 or after and 

runs automatically anytime APP Recorder is running. 

Files managed: 

PQ Data: 

• 3Sec-daily 

• 10min-daily 

• 2hr-weekly 

• All Harmonics Files 

Flicker Data: 

• Pst-daily 

• Plt-weekly 

See Configuring Point Assignment Record/Configuring General Settings for more on PQ and Flicker 

files created and retention rules. 

10.2 Using APP Recorder Helper 

You access Recorder Helper from within the APP Recorder program. Click on the File Menu, then select 

Show Helper option. The following window will appear. 

Recorder Helper will log messages to the HTrace file in the APP Recorder\Setup folder and displays the 

log messages in the main window as shown above. You will see a blinking asterisk in the lower left corner 

that indicates Helper is running and not hung up.  

Figure 131 APP Recorder Helper Window 
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10.2.1 File Menu 

You can reset the Recorder Helper program by reinitializing Recorder Helper. and Close Recorder Helper. 

➢ Reinitialize: 

Click on the File Menu and select Reinitialize 

This will effectively restart Recorder Helper  

➢ Closing Recorder Helper 

You can close the Recorder Helper from showing on the screen or in the program tray. However, Recorder 

Helper will continue to run in the background and continue to do its functions. 

To close, click on the File Menu and select Close. 

10.2.2 Edit Menu 

➢ Clear Log  

You can clear the message log displayed on the Helper main screen by either clicking the Clear Log button 

on the lower right of the window or by clicking Edit then selecting Clear Log. The messages remain in the 

HTrace file mentioned above. 

➢ Snapshot Memory 

While Recorder Helper takes a Memory Snapshot of the six process using the most memory, you can also 

take a snapshot at any time and the results will be recorded in the MemoryTrace01.wri file in the 

APPRecorder\Setup\MemoryTrace folder. 

To take a snapshot, click the Edit menu and select Snapshot Memory. A message will appear in the log 

“Memory Snapshot Saved”. 
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11. Other Information 
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11.1 Time Quality 

A 4-bit time quality indicator is used by several manufacturers of satellite controlled clocks. It is an 

indicator of time accuracy or synchronization to UTC and is based on a clock’s internal parameters. Per the 

IEEE 1344 standard, the code recommended is by order of magnitude relative to 1(ns). The 1ns basic 

reference is adequate to accommodate present industry requirements now and into the foreseeable future. 

With present GPS technology at 100ns accuracy level, a 0000 code indicating locked will change to 0011 

or a 0100 unlock code. The following table contains the IEEE 1344 quality indicator codes. 

*IMPORTANT*  APP-601 clock accuracy/alignment with the 1PPS is 0.6 µsec with an 
un-modulated IRIG-B input. The accuracy with a modulated IRIG-B 
input is 1msec. 

If the satellite-controlled clock does not output a time quality code, APP-601 keys off the clocks synch/un-

sync signal. If the clock is synchronized, then the fault record tag will show locked.  If the clock is un-

synchronized, then the fault record tag will show unlocked.  

If there is no signal connected to the APP-601 IRIG input, or no PTP clock connected to the DSP network, 

then the fault record tag will display “No Signal”. 

Table 23: IEEE 1344 Time Quality Values 

Binary Description  

1111 F fault –unknown – clock fail 

1011 B 10s 

1010 A 1s 

1001 9 100ms 

1000 8 10ms 

0111 7 1ms 

0110 6 100µs 

0101 5 10µs 

0100 4 1µs 

0011 3 100ns 

0010 2 10ns 

0001 1 1ns 

0000 0 Normal Operation Clock Locked 
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Table 24: Time Quality and APP-601 Action 

Value From GPS 
Clock 

Binary APP-601 Fault 
Record Tag 

APP-601 Loss 
Sync LED 

Status 

APP-601 Loss Sync 
Relay Status (coil) 

Fault 1111 Fault ON Energized 

10s 1011 10s ON Energized 

1s 1010 1s ON Energized 

100ms 1001 100ms ON Energized 

10ms 1000 10ms ON Energized 

1ms 0111 1ms OFF Not energized 

100µs 0110 100µs OFF Not energized 

10µs 0101 10µs OFF Not energized 

1µs 0100 1µs OFF Not energized 

100ns 0011 100ns OFF Not energized 

10ns 0010 10ns OFF Not energized 

1ns 0001 1ns OFF Not energized 

Normal Operation 

Clock Locked 

0000 Locked OFF Not energized 

11.2 Recommended Maintenance and Calibration 

APP Engineering recommends a combination performance-based and time-based maintenance. 

11.2.1 Performance-based Maintenance  

APP recommends that you complete performance-based maintenance by utilizing the Auto-Polling feature 

in ClearView. The auto-polling process retrieves the latest diagnostic or status file for each APP Recorder, 

(see Clearview Manual for more on setting up Auto-Polling). The following procedure explains how to 

complete the minimum recommended performance-based maintenance procedure. 

➢ To Complete the Minimum Recommended Performance-based Maintenance Procedure 

1. In the APP ClearView program running on your master station computer, set the APP ClearView 

Configuration to auto-poll all the APP Recorders once per day. This retrieves a Fault Summary 

Report and the SER dates.   

2. After auto-polling, review the Auto-Transfer Notification Report to ensure that the last received 

date is correct and that each APP Recorder is online. 

3. The auto-polling process retrieves the latest diagnostic or status file for each APP Recorder. The 

Alarm box in the upper right-hand corner of the APP ClearView window displays alarms for 

APP Recorder. Alarms appear as a red background with the text Alarms On. If an APP Recorder 

has an alarm, double-click the Alarm box to see which APP Recorder is in alarm. 

4. During normal use of the APP ClearView analysis software, review the analog and digital data to 

ensure that there is an acceptable measurement of the power system input values. 
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11.2.2 Time-based Maintenance  

The following table describes the minimum recommended time-based maintenance procedures. 

Table 25: Time-based Maintenance Procedures 

Chassis Type Comments 

APP-501 Computer 

Control Chassis 

Once every year, ensure that the fan mounted to chassis rear panel is 

functioning properly. Once every two years, run Windows disk defragmenter 

“Analyze” and follow Windows Recommendations. You can run the defrag 

analysis and defragmenter from the master station computer running APP 

ClearView (Maintenance).   

Note: If the system is using a solid-state drive, defragmentation does not 

need to be done. 

APP-601 Computer 

Control Chassis 

Once every two years, run Windows disk defragmenter “Analyze” and 

follow Windows Recommendations. You can run defrag analysis and 

defragmenter from the master station computer running APP ClearView 

(Maintenance). 

Note: If the system is using a solid state drive, defragmentation does not 

need to be done. 

APP-601 Data Chassis Calibrate analog channels once every 5 years. See calibrating DC offset and 

calibrating Slope  

11.3 Recommended Setup for MW Channels  
(Using 4ma-20ma Transducer) 

To Complete the Recommended Setup for MW Channels 

1. Calculate the CT/PT value.  

For example, suppose the resistor used with the transducer is 143 ohms and the transducer full 

scale is 550MW @ 20ma. In this case, the calculation would be as follows: 

4ma (143 ohms) = 0.572V, which needs to equal 0MW 

20ma (143 ohms) = 2.860V, which needs to equal 550MW 

2.860V – 0.572V = 2.288V 

550MW/2.288V = 240.3846 which is the CT/PT that needs to be used in order to display proper 

primary values. 

2. In the Point Assignment Record for this analog channel, enter w(Mwatt) for the Channel Type. 

Then enter 240.384 for the CT/PT value, and enter 5 for the Full Scale value (on the secondary 

1MW-1V). Click Save in the Point Assignment window. 

3. In the APP Recorder, open the OScope (File menu, Show OScope). View the analog channel that 

is being set up for MW. 

4. With no signals attached to this MW channel, un-calibrate the offset and the slope. 

5. Apply a 0.572VDC signal (representing 4ma, 0MW) and calibrate the offset. 

6. Apply a 2.86VDC signal. You should read a primary value of 550MW for this MW channel. 
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11.4 Recommended Setup for MVAR Channels  
(Using 4ma-12ma-20ma Transducer) 

➢  To Complete the Recommended Setup for MVAR Channels 

1. Calculate the CT/PT value.  

For example, suppose the resistor used with the transducer is 143 ohms and the transducer full 

scale is - 400MVAR @ 4ma and +400MVAR @ 20ma. In this case, the calculation would be as 

follows: 

4ma (143 ohms) = 0.572V, which needs to equal -400MVAR 

12ma (143 ohms) = 1.716V, which needs to equal 0 MVAR 

20ma (143 ohms) = 2.860V, which needs to equal +400MVAR 

2.860V – 1.716V = 1.144V as does 1.716V-0.572V=1.144V 

400MVAR/1.144V = 349.650 which is the CT/PT that needs to be used in order to display 

proper primary values.    

2. In the Point Assignment Record for this analog channel, enter q(MVar) for the Channel Type, 

enter 349.650 for the CT/PT value, and enter 5 for the Full Scale value (on the secondary 

1V=1MVAR.) Click Save on the Point Assignment window. 

3. In the APP Recorder, open the OScope (File menu, Show OScope). View the analog channel that 

has been set up for MVAR. 

4. With no signals attached to this MVAR channel un-calibrate the offset and the slope. 

5. Apply a 1.716VDC signal (representing 12ma, 0MW) and calibrate the offset. 

6. Apply a 0.572VDC signal and you should read a primary value of -400MVAR in the offset meter 

box. The RMS meter box will read 400MVAR (no negative on RMS). 

7. Apply a 2.86VDC signal. You should read a primary value of +400MVAR in the offset meter box. 

The RMS meter box will read 400MVAR.  

11.5 Recommended Setup for a Current Channel using a 4ma-
20ma Transducer (e.g. measuring generator field current) 

To Complete the Recommended Setup 

1. Calculate the needed shunt value.  

For example, suppose the resistor used with the transducer is 270 ohms (measure with an accurate 

meter) and the transducer full scale is 2000A @ 20ma.  In this case, the calculation would be as 

follows: 

4ma (270 ohms) = 1.08V, which needs to equal 0 Amps 

20ma (270 ohms) = 5.40V, which needs to equal 2000 Amps 

5.40V – 1.08V = 4.32V 

thus 4.32V/2000A = 2.16 milliohms which is the shunt value that needs to be used in order to 

display proper values.   

2. In the Point Assignment Record for this analog channel, enter C(Adc) for the Channel Type. Enter 

1 for the CT/PT value, enter 2000 for the Full Scale value (ABS will automatically = 5000), and 

enter 2.16 milliohms for the external shunt value.  Click Save in the Point Assignment window. 



Other Information 11-6 

3. In the APP Recorder program, open OScope (File menu, Show OScope). View the analog channel 

that is being set up with this transducer. 

4. With no signal attached to this transducer channel, un-calibrate the offset and the slope. 

5. Apply a 1.08VDC signal (representing 4ma = 0 Amps) and calibrate the DC offset. 

6. Apply a 5.40VDC signal. You should read a value of 2000A for this transducer current channel. 

11.6 Recommended Setup for a Current Channel using a 0ma-
1ma Transducer 

To Complete the Recommended Setup 

1. Calculate the needed shunt value.  

For example, suppose the resistor used with the transducer is 270 ohms (measure with an accurate 

meter) and the transducer full scale is 2000A @ 20ma.  In this case, the calculation would be as 

follows: 

0ma (270 ohms) = 0V, which needs to equal 0 Amps 

1ma (270 ohms) = .27V, which needs to equal 2000 Amps 

.27V – 0V = .27V 

thus .27V/2000A = .135 milliohms which is the shunt value that needs to be used in order to 

display proper values.   

2. In the Point Assignment Record for this analog channel, enter C(Adc) for the Channel Type. Enter 

1 for the CT/PT value, enter 2000 for the Full Scale value (ABS will automatically = 5000), and 

enter .135 milliohms for the external shunt value.  Click Save in the Point Assignment window. 

3. In the APP Recorder program, open OScope (File menu, Show OScope). View the analog channel 

that is being set up with this transducer. 

4. With no signal attached to this transducer channel, un-calibrate the offset and the slope. 

5. With no signal applied 0 channel. 

6. Apply a .27VDC signal. You should read a value of 2000A for this transducer current channel. 


